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PLANTEAMIENTO DEL PROBLEMA 

 

Se desea investigar la automatización de un vehículo eléctrico de forma 

que tanto el motor como los frenos puedan ser controlados mediante un 

ordenador, pudiendo elegir la velocidad a la que se desplaza el vehículo. 

En este caso se dispone de un pequeño vehículo eléctrico experimental. 

 

DESCRIPCIÓN DEL PROYECTO 

 

Se estudia el vehículo y se crea un modelo en Simulink para poder simular su 

funcionamiento, usando este modelo se prueban en simulaciones diferentes formas de 

control previamente estudiadas. Estas formas de control  consisten en el uso de PIDs 

o de diferentes realimentaciones de estados, se comparan los resultados obtenidos 

para decidir que opción es la mejor. 

Este sistema de control creará una señal que dependiendo de su valor actuará 

acelerando el vehículo o frenándolo, esta señal será enviada a la controladora del 

motor o a una electrobomba que accionara los frenos. 

También se estudian los componentes de los que dispone el vehículo y los que deben 

ser instalados para su automatización. 
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CONCLUSIONES 

Nos decidimos por implementar un control mediante realimentación de estados, debido 

a los mejores resultados que obtiene en las simulaciones.  

El sistema de aceleración únicamente necesita de una tarjeta de adquisición de datos 

que genere la señal que llegará a la controladora del motor eléctrico, mientras que el 

sistema de frenado necesita una electrobomba y una válvula para modificar el sistema 

hidráulico. 
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1 INTRODUCCIÓN 

1.1 FINALIDAD DEL PROYECTO 

El objetivo de este proyecto es conseguir una automatización de bajo 

nivel de un vehículo urbano, en este caso el vehículo con el que se 

trabajara será un coche eléctrico biplaza del que se hablara más adelante. 

La finalidad es que el conductor del vehículo no tenga que usar ni el freno 

ni el acelerador para la conducción, ya que mediante un computador se 

establecerá la velocidad deseada. El conductor solo tendría que manejar 

el volante (el sistema de la dirección debiera ser otro proyecto posterior) 

y en caso de emergencia podría utilizar el acelerador o el freno (por 

seguridad).  

El control se llevara a cabo mediante un algoritmo introducido en un 

ordenador que se tendrá a bordo conectado a una tarjeta de adquisición 

de datos que se encargara de enviar y recibir las señales necesarias para 

el funcionamiento del sistema de control. El algoritmo se implementará en 

un idioma de programación que estará configurado para funcionar con la 

tarjeta de adquisición y usará el sistema de control que se estudiara y 

probará en este proyecto.  

Por tanto el control por ordenador es un complemento a la conducción 

manual, y no una sustitución ya que por motivos de seguridad no se debe 

eliminar la posibilidad de que el conductor pueda frenar o acelerar si fuera 

necesario. 

Este tipo de proyectos son pasos previos a la automatización total de los 

vehículos, que posiblemente se conseguirá en un futuro no muy lejano, 

esta automatización total significaría la “extinción” de los conductores, 

que no serán necesario en el transporte por carretera, el principal 

inconveniente de esto es la seguridad, dado que muchas personas no 

están dispuestas a dejar su vida en manos de la tecnología. 
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Este proyecto es un paso previo a otros posibles proyectos que aumenten 

el nivel de control del vehículo, implementando por ejemplo el control de 

la dirección, o el uso de cámaras para visión artificial reconociendo el 

entorno y posibilitando la automatización total de un vehículo en la 

universidad de Cantabria, siguiendo la línea de investigación que se está 

llevando en esta universidad. 

1.2 ESTADO DEL ARTE 

En el pasado se llevaron a cabo varios proyectos en todo el mundo 

intentando conseguir vehículos que se desplacen sin conductor, a 

continuación se habla de algunos de estos proyectos. 

La presentación más antigua de un vehículo autónomo que se conoce fue 

hecha por Normal Bel Geddes en la feria de muestras “Futurama” en la 

Exposición Universal de 1939, que consistía en un vehículo eléctrico que 

era controlado por un circuito eléctrico embebido en el pavimento de la 

carretera. 

En 1980 una furgoneta guiada por visión de Mercedes-Benz, diseñada por 

la Universidad de Múnich alcanzó los 100 km/h en calles sin tráfico. La 

Comisión Europea se mostró interesada en el proyecto y realizó una 

inversión de 800 millones de € para un proyecto que buscaba desarrollar 

un vehículo autónomo. 

En 1980 DARPA construyó el primer vehículo que funcionaba mediante un 

radar láser y visión computarizada. En 1987, los laboratorios HRL 

demostraron que se podía construir un vehículo que diseñaba su propia 

ruta una vez que se salía del mapa. El vehículo consiguió moverse más de 

600 metros a través de terreno complejo con pendientes, vegetación y 

grandes rocas. 

En 1994, dos vehículos robots gemelos VaMP y Vita-2 condujeron solos 

más de mil kilómetros en una autopista de París con 3 carriles en días 

habituales con tráficos intensos a velocidades de hasta 130 km/h. Los 

vehículos funcionaron de forma autónoma con pequeñas intervenciones 
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humanas. Demostraron que la conducción en carriles libres, en convoy y 

los cambios de carril a derecha e izquierda podían realizarse de forma 

autónoma. 

En 1995, el equipo de Dickmanns modificó un Mercedes Clase S para que 

hiciera un viaje entre Múnich y Copenhague y vuelta, usando una visión 

computarizada y un ordenador para reaccionar en tiempo real. El vehículo 

consiguió alcanzar velocidades superiores a 175 km/h en las “Autobahn” 

alemanas, con un tiempo medio entre intervenciones humanas de 9 km, 

lo que supuso un 95% de conducción autónoma. De nuevo el vehículo 

condujo en tráfico, consiguiendo ejecutar con éxito maniobras para 

adelantar a otros vehículos [10]. 

En la universidad de Cantabria aún no se ha realizado ningún proyecto 

que lleve a cabo la implementación de un sistema así en un coche, si se 

han realizado estudios previos a este paso. 

En España, unos ingenieros de la universidad de Alicante, han 

desarrollado un paquete que se puede instalar en cualquier vehículo de 

conducción manual para convertirlo en un vehículo que pueda funcionar 

sin conductor, está diseñado en principio para el transporte de cargas en 

el sector industrial, funcionando en recintos cerrados. Este proyecto tiene 

la ventaja de tener un bajo coste comparado con otros vehículos con el 

sistema ya integrado. 

Además, el programa “Autopía” del CSIC y con ayuda de la universidad 

politécnica de Madrid, ha desarrollado un coche autónomo utilizando un 

Citroën C3, el cual ha conseguido conducir sin intervención humana a lo 

largo de unos 100 km, siendo escoltado por un coche guía, el recorrido 

llevado a cabo transcurría tanto por vía urbana como por autovía, el 

coche alcanzó los 109 km/h en un tramo de la autovía [12]. 
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Fig 1.1– Platero, el vehículo autónomo español. 

En la figura 1.1 se puede ver una fotografía del primer vehículo autónomo 

creado en España, que se le bautizó como “Platero”. 

El proyecto más avanzado es el llevado a cabo por “Google”, llamado 

“Google driverless car”, que usando un Toyota Prius han conseguido la 

automatización total, respetando todas las normas de tráfico y de 

seguridad, se pueden ver videos en los que se prueba el funcionamiento 

de este vehículos por las calles, llevando a personas que no pueden 

conducir, y que este vehículo les permite desplazarse sin depender de 

nadie más. 

En la figura 1.2 se muestra una imagen del modelo de vehículo sin 

conductor de Google. 
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Fig 1.2– Vehículo sin conductor de Google. 

Los vehículos autónomos perciben el entorno mediante técnicas complejas 

como láser, radar, lidar, GPS y visión computerizada. Los sistemas 

avanzados de control interpretan la información para identificar la ruta 

apropiada, así como los obstáculos y la señalización relevante. Los 

vehículos autónomos generalmente son capaces de crear sus propios 

mapas si se ven en entornos en los que no existe cartografía disponible y 

crear sus propias rutas. 

En la figura 1.3 se puede ver como es el entorno que crea el vehículo de 

Google, se aprecian el resto de vehículos presentes en la vía, el recorrido 

que planea hacer para llegar a su destino, y otros elementos como pasos 

de cebra o peatones. 
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Fig 1.3– Reconocimiento de entorno de Google. 

En el Estados Unidos, en los estados de Florida y Nevada, la ley ya 

permite la circulación de estos vehículos sin conductor, y en el caso de 

Nevada, en 2012 ya se entregó la primera licencia para el vehículo de 

Google. 

Según algunas estimaciones, como la de la empresa Nissan, en el año 

2020 estos automóviles ya estarán disponibles en el mercado doméstico. 

Y para 2040, según el Instituto de Ingenieros Eléctricos y Electrónicos 

(IEEE), el 75% de los coches serán autónomos, en especial todos los 

dedicados a transportes de mercancías por carretera, ya que esto sería 

especialmente rentable para las empresas que se dedican a esto. 

En el mundo del cine, hay películas ambientadas en un futuro no muy 

lejano, donde la tecnología es ampliamente superior a la disponible 

actualmente, se ha podido ver vehículos de este tipo. Un buen ejemplo es 

la película “Yo, robot”, realizada en 2004 y ambientada en 2035, en un 

mundo donde el tráfico está compuesto por coches autónomos, y la 

conducción manual esta vista como peligrosa y una locura, debido a las 

altas velocidades a las que se desplazan estos coches. 
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Fig 1.4– Vehículo de la película “Yo, robot”. 

La figura 1.4 muestra el vehículo utilizado en la película “Yo, robot”. 

1.3 VEHÍCULOS ELÉCTRICOS 

Los vehículos eléctricos son aquellos que su fuente de energía es la 

electricidad, y son impulsados mediante uno o varios motores eléctricos 

que lleva la potencia en forma de movimiento a las ruedas o hélices. 

En la actualidad los vehículos eléctricos están dando el salto a la calle, ya 

se puede ver zonas de recarga para automóviles de este tipo y 

concesionarios donde se venden, pero la gente se sigue preguntando si 

son de verdad rentables o hay que esperar unos años más a que la 

tecnología avance un poco más. 

En casos especiales como prototipos o pruebas experimentales, se han 

construido vehículos que en lugar de utilizar la recarga de las baterías 

mediante una conexión a la red eléctrica como única fuente de energía, 

como es lo habitual, obtienen energía a partir de paneles solares 

instalados en la carrocería. Los resultados de estos experimentos no 

fueron lo suficientemente buenos como para desarrollar estos vehículos 

para llevarlos a las calles. 
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Fig 1.5– Vehículo que utiliza paneles solares. 

En la figura 1.5 se ve un modelo de vehículo eléctrico que utiliza paneles 

solares para recargar las baterías. 

El principal inconveniente de los coches eléctricos son las baterías, ya que 

la autonomía de estas no nos permiten hacer largos viajes sin largas 

paradas,  una buena batería tiene una autonomía para recorrer más de 

400 Km, pero esto implica un alto precio y un tiempo de carga completa 

de más de 9 horas. Por esto los coches eléctricos están diseñados más 

para un uso urbano, siendo la mayoría biplazas de pequeño tamaño. 

En la actualidad se estás investigando nuevas formas de almacenar 

energía para usarlas como fuentes de energía en vehículos eléctricos, 

algunas de las más esperanzadoras son los supercondensadores de 

grafeno, o las baterías liquidas. En el caso de los supercondensadores de 

grafeno se tiene gran esperanza debido a que con ellos se tiene una 

mayor densidad energética, tiempos muchísimo menores de carga, y 

mayor durabilidad, esto aumentaría la autonomía de los vehículos en un 

factor de aproximadamente 2,5. 

En la tabla 1.1 se muestra la autonomía y el gasto de energía de los 

principales vehículos eléctricos. 
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Modelo kWh Autonomía 

(km) 

kWh / 100 km 

Mega e-City 9 100 9 

Reva L-ion 11 120 9,17 

Think City 25 200 12,5 

Mitsubishi i-

Miev 

16 130 12,31 

Citröen C-

Zero 

16 130 12,31 

Renault 

Fluence ZE 

24 175 13,71 

Nissan Leaf 24 160 15 

Tesla 

Roadster 42 

42 257 16,34 

Tesla 

Roadster 70 

70 483 14,49 

Tabla 1.1–Características de los principales vehículos eléctricos. 

Otros problemas importantes actualmente son el alto precio inicial de 

estos vehículos, a veces cerca del triple del valor de un coche 

convencional de similar gama, que hace que lo que se ahorra con el 

combustible se pierda en un gran desembolso inicial.  

Otro inconveniente es la dificultad para encontrar un sitio en el que 

cargarlo, que aunque cada día hay más, es posible que no encuentres uno 

disponible cuando lo necesites por la escasez de ellos. 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 16 
 

 

Fig 1.6– Renault Twizy. 

En la figura 1.6 se muestra la fotografía de un Renault Twizy, un pequeño 

vehículo eléctrico de uso urbano. 

Sin embargo, los vehículos eléctricos tienen importantes ventajas, el 

usuario notará un ahorro importante debido a que el precio del 

combustible utilizado para un vehículo convencional es mucho mayor que 

el precio para recargar la batería de los vehículos eléctricos. Además la 

vida de estos vehículos es mayor que la de los coches de gasolina, 

pudiendo recorrer muchos más kilómetros. 

Otra ventaja de los vehículos eléctricos es que permiten la recuperación 

de energía, por ejemplo cuando el coche está bajando una cuesta 

(energía potencial) o cuando el coche frena (energía cinética), esto hace 

que el vehículo eléctrico utilice mejor la energía y aumente la autonomía. 

El más beneficiado del uso de los vehículos eléctricos es el medio 

ambiente, y por tanto todo el planeta, ya que la contaminación creada es 

muchísimo menor (aunque también existe, ya que los elementos que 

componen las baterías son tóxicos), se reduce el uso de petróleo en el 

mundo, lo cual es importante porque el petróleo es una fuente limitada de 

energía. Y además se reduce la contaminación acústica producida por los 

ruidosos motores de combustión, ya que los motores eléctricos son 

emiten menos ruido [11]. 
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1.3.1 Vehículos híbridos 

Otro tipo de vehículos que utilizan la energía eléctrica como fuente 

importante de su movimiento son los híbridos, que siguen utilizando 

motores de combustión, y son un paso intermedio muy interesante entre 

los vehículos convencionales y los eléctricos.  

Sus ventajas en ahorro de combustible son mayores cuando su uso se 

restringe al ámbito urbano, funcionando a bajas velocidades. Esto se debe 

a que el motor eléctrico entra en funcionamiento cuando el vehículo va 

más lento, como por ejemplo cuando se para en un semáforo y se tiene 

que acelerar desde parado.  

En la figura 1.6 tenemos un dibujo de las partes importantes en un coche 

híbrido, como son las baterias o los motores tanto de combustion como el 

eléctrico. 

 

Fig 1.7– Diagrama de componentes de un vehículo híbrido. 

El principal modelo de vehículo híbrido es el Toyota Prius, que ha logrado 

grandes datos de ventas en todo el mundo, siendo el vehículo hibrido más 

vendido. Además de momento nadie ha superado la eficiencia del sistema 
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de Toyota. Es un coche con el tamaño justo para ser el único de una 

familia. Tiene una imagen ecológica reconocida y funciona muy bien 

ahorrando en ciudad, ofreciendo una conducción relajada y sencilla, y en 

carretera a una velocidad mantenida tampoco consume mucho. 

 

Fig 1.8– Toyota Prius. 

En la figura 1.8 podemos ver una fotografía del Toyota Prius. 

1.4 VEHÍCULO EXPERIMENTAL 

El vehículo del que se dispone es un pequeño coche eléctrico biplaza, del 

tamaño de un carrito de golf, y que se denomina cuadriciclo. No se trata 

de un vehículo comercial, sino de un vehículo experimental que se utiliza 

para investigaciones o proyectos. 

El fabricante del vehículo es la compañía catalana “Teycars”, el modelo es 

el ALSO2 fabricado en 2008. 

Este coche no llega a alcanzar los 50 Km/h por lo tanto es para uso 

exclusivo en vías de baja velocidad como en las ciudades, la autonomía 

de la que dispone es de unos 90 km, siendo inviable realizar viajes largos. 
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En la figura 1.9 se puede ver el vehículo circulando por el exterior de la 

escuela. 

 

Fig 1.9 – Fotografía del vehículo utilizado. 

En la tabla 1.2 se pueden leer algunos datos adicionales que han sido 

obtenidos de una placa de características de la que dispone el coche, o 

que han sido medidos directamente en el vehículo. 
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Peso Vacío 600 Kg 

Peso Máximo 950 Kg 

Largo x Alto x Ancho 2740 x 1490 x 1950 mm 

Altura al suelo 180 mm 

Ancho de ejes (Delantero/Trasero) 1280 / 1260 mm 

Distancia entre ejes 1900 mm 

Motor 4.3 KW, 48 V 

Batería 210 AH, 6V 

Frenos Delanteros Disco 

Frenos Traseros Tambor 

Distancia de frenado ≤ 4 m 

Tiempo de carga de la batería 8-10 Horas 

Autonomía 80-90 Km 

Velocidad Máxima 45-50 Km/h 

Neumáticos Kebler 165/70R13 

Tabla 1.2 – Características del vehículo. 
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2 MODELADO DE LA DINÁMICA LONGITUDINAL 
DEL VEHÍCULO ELÉCTRICO 

El modelo del vehículo servirá para la simulación por ordenador del 

comportamiento del vehículo ante las diferentes entradas y 

perturbaciones del sistema, en este caso el modelo será un modelo 

longitudinal, despreciando así las fuerzas y movimientos laterales del 

vehículo debido a que apenas afectan para el cálculo de la velocidad y 

movimiento longitudinal, a las velocidad a las que nuestro vehículo se va 

a desplazar, que serán velocidades menores que 50 km/h. 

Además se simplificará utilizando un modelo de dos ruedas, gracias a que 

en el movimiento longitudinal no habrá diferencia entre ambas ruedas de 

un mismo eje, por lo que eliminaremos la distinción entre rueda derecha 

e izquierda. 

Este apartado está basado en su mayoría en [1], a excepción del 

apartado que trata el tren de potencia del vehículo, dado que este 

trabajo, a diferencia de la referencia, trata un vehículo con motor eléctrico 

y no un motor de combustión. 

En la figura 2.1 se muestra el modelo del vehículo con los principales 

parámetros que vamos a utilizar. 

 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 22 
 

 

Fig 2.1- Esquema de fuerzas del vehículo. 

El vehículo de la figura está circulando en una carretera recta, con 

pendiente θ, en la dirección del eje X, a una velocidad V. 

Los parámetros mostrados en la figura son los siguientes: 

 m: Masa de todo el vehículo. 

 g: Aceleración de la gravedad. 

 V: Velocidad a la que se desplaza el vehículo en la dirección X. 

 L: Distancia entre ejes. 

 B: Distancia entre el eje delantero y el centro de gravedad del 

vehículo. 

 C: Distancia entre el eje delantero y el centro de gravedad del 

vehículo. 

 H: Altura del centro de gravedad. 

 θ: Pendiente de la carretera. 

 ωf y ωr: Velocidad angular de las ruedas delanteras y traseras 

respectivamente. 

 Rf y Rr: Radio de las ruedas delanteras y traseras respectivamente. 

 Jf y Jr: Momentos de inercia del eje delantero y trasero 

respectivamente. 
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 µf y µr: Coeficientes de rozamiento de los neumáticos delantero y 

trasero respectivamente. 

 

Para realizar el modelo se ha utilizado el programa MATLAB-SIMULINK, 

con el cual se ha creado un diagrama de bloques, en el cual las entradas 

son los porcentajes de accionamiento de los pedales de aceleración y 

freno, y las salidas son la velocidad y la posición en cada momento. Las 

perturbaciones  como la velocidad del viento o la pendiente de la 

carretera también esta incluidas, aunque se anularan para la simulación.  

Se puede apreciar en la figura que el sistema tiene múltiples 

realimentaciones y lo complican, además de que algunos bloques no son 

lineales. 

 

Fig 2.2– Esquema de bloques del modelo. 

En la figura 2.2 se muestra el modelo completo utilizado en Simulink para 

las pruebas que se realizaran. 

A continuación se definen los diferentes “bloques” o partes que se han 

separado para crear el modelo. 
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2.1 CUERPO DEL VEHÍCULO 

Este bloque contiene el equilibrio de fuerzas longitudinales que provocan 

el movimiento del vehículo, la ecuación que lo define está basada en la 

segunda ley de Newton, obteniendo así la aceleración del vehículo. 

Además también se calculan las fuerzas verticales que soportan cada eje 

(Fzf y Fzr). 

La velocidad del viento y la pendiente de la carretera son parámetros de 

entrada de este bloque, al igual que las fuerzas de rozamiento de los 

neumáticos con la carretera que básicamente son las principales 

responsables del movimiento del vehículo.  También será necesaria la 

velocidad del vehículo, ya que para calcular la velocidad relativa entre el 

aire y el vehículo se necesitan ambas velocidades. 

La ecuación para el cálculo de la aceleración es la siguiente, y se basa en 

la segunda ley de Newton: 

             ሺ ሻ                                                      ሺ   ሻ 
Siendo Fx la suma de las fuerzas de contacto de los neumáticos 

multiplicada por 2 para contar ambas ruedas por eje, además será 

negativa debido a que el deslizamiento también lo será, como veremos 

posteriormente. Fv es la fuerza resistente del viento y Fr la fuerza 

resistente de rodadura, definidas a continuación:      (       ൯                                                              ሺ   ሻ 
              ሺ    ሻ                                                        ሺ   ሻ                                                                            ሺ   ሻ  

Siendo Av el área frontal del vehículo, ρ la densidad del aire, Cd el 

coeficiente de fricción con el viento, y Cr el coeficiente de rodadura. 
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Una vez obtenida la aceleración se integra para obtener la velocidad V del 

vehículo, y si se desea obtener la distancia recorrida se utiliza otro 

integrador. 

Para calcular las fuerzas verticales en cada eje usamos las siguientes 

formulas: 

        (      ሺ ሻ        ሺ ሻ)                                      ሺ   ሻ 
        (      ሺ ሻ        ሺ ሻ)                                      ሺ   ሻ 

 

Fig 2.3 – Bloque “Cuerpo del vehículo”. 

La figura 2.3 muestra el sistema de bloques utilizado para modelar la 

parte del cuerpo del vehículo. 

2.2 NEUMÁTICOS 

El rozamiento de los neumáticos con el suelo es el causante de las fuerzas 

que hacen moverse longitudinalmente al vehículo, estas fuerzas dependen 

de la fuerza vertical que soportan las ruedas, y del coeficiente de 

rozamiento del neumático con la carretera. 

Este coeficiente de rozamiento no es constante, varía en función del 

deslizamiento de los neumáticos con el asfalto, y de las condiciones del 

asfalto (Seco, húmedo, nevado o con hielo). 

 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 26 
 

El deslizamiento viene definido por la ecuación 2.7: 

                                                                                     ሺ   ሻ 
Donde V es la velocidad del cuerpo del vehículo, ωi es la velocidad angular 

de la rueda de la que se calcula el deslizamiento y Ri su radio. 

Para calcular el coeficiente de rozamiento se utilizara la ecuación de 

Pacejka, obtenida experimentalmente para diferentes condiciones del 

asfalto, para ello utiliza unos coeficientes distintos según las condiciones, 

debido a que la fricción depende mucho de las condiciones del asfalto.         (      ቀ       (         ሺ    ሻ൯ቁ)                             ሺ   ሻ 
Donde los coeficientes B, C, D y E son: 

Superficie B C D E 

Asfalto Seco 10 1.9 1 0.97 

Asfalto 

Húmedo 

12 2.3 0.82 1 

Nieve 5 2 0.3 1 

Hielo 4 2 0.1 1 

 

Tabla 2.1 – Coeficientes de Pacejka. 

En la tabla 2.1 se encuentras los coeficientes utilizados en la ecuación de 

Pacejka dependiendo de cuales sean las condiciones del asfalto. 
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Fig 2.4– Curvas del modelo de Pacejka. 

En la figura 2.4 se puede ver una gráfica de la cual se puede obtener el 

coeficiente de rozamiento con el asfalto, conociendo cual es el 

deslizamiento, y las condiciones climatológicas. 

Para este modelo se supondrá que el asfalto está seco, y por lo tanto se 

utilizara la primera fila de coeficientes. 

Una vez obtenido el coeficiente de rozamiento se calcula las fuerzas Fx:                                                                                ሺ   ሻ 
Estas ecuaciones son válidas de igual forma para los neumáticos 

delanteros como para los traseros. 
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Fig 2.5 – Bloque “Neumáticos”. 

En la figura 2.5 se puede ver el sistema de bloques de Simulink que 

describe el modelo de los neumáticos, donde se encuentra incluida la 

ecuación de Pacejka. 

2.3 RUEDAS 

Este subsistema consta de 4 entradas y 1 salida, las entradas son los 

momentos torsores que afectan al movimiento de las ruedas, estos son: 

τe, par que proviene del motor, el que provoca el movimiento del 

vehículo;  τb, par de frenado;  τr, par de reacción debido a las fuerzas Fx 

de cada rueda, y su valor se obtiene de:                                                                                  ሺ    ሻ 
Y τv, que es el par de fricción viscosa, que es debido a pérdidas en los 

elementos mecánicos del vehículo, y cuya expresión es:                                                                                   ሺ    ሻ 
Donde Cf es el coeficiente de fricción viscosa. 

La salida del subsistema es la velocidad angular de cada eje, para ello se 

utiliza la segunda ley de newton para movimiento angular, obteniendo así 

la aceleración angular, e integrándola se conseguirá la velocidad angular. 

                                                                             ሺ    ሻ 
Al ser un vehículo de tracción delantera, el par debido al motor solo 

tendrá efecto en el eje delantero, siendo nulo la entrada τe para el eje 

trasero. 
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Fig 2.6– Bloque “Ruedas”. 

En la figura 2.6 se pueden ver los bloques que conforman el modelo de 

las ruedas. 

2.4 MOTOR ELÉCTRICO 

El modelo que se ha hecho del motor con el que funciona el coche es un 

modelo de un motor eléctrico con excitación independiente,  el cual es el 

típico modelo matemático de un motor eléctrico en el que se supone la 

excitación de campo constante. 

Las entradas de este bloque son la tensión suministrada al motor y la 

velocidad actual de las ruedas delanteras. La única salida del bloque es el 

par mecánico suministrado al eje delantero. 

En este bloque también se tiene en cuenta la existencia de un diferencial 

que hace que la velocidad y el par en el eje del motor y en el eje de las 

ruedas sean distintos, sin embargo se presupone que la potencia a ambas 

partes del diferencial es la misma y no hay ninguna perdida en él. 

Las ecuaciones que definen el funcionamiento del motor son las 

siguientes: 

                                                                  ሺ    ሻ                                                                             ሺ    ሻ 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 30 
 

Donde “  ” es el par mecánico en el eje de las ruedas; “Kt” es la 

constante de par electromagnético; “N” es la relación en el diferencial; “E” 

es la tensión aplicada en bornes del motor;  “  ” es la velocidad angular 

de las ruedas delanteras, “Kb” es la constante de fuerza contra 

electromotriz;  “Re” es la resistencia eléctrica en el circuito del motor y 

“Le” la inductancia.  

 

Fig 2.7 – Bloque “Tren de Potencia”. 

En la figura 2.7 se muestran los bloques utilizados para modelar todo el 

tren de potencia. 

2.5 FRENOS 
El sistema de frenos solo tiene dos señales de entrada, una 

evidentemente es la señal de frenado que se genera cuando el conductor 

pisa el pedal del freno, esta señal será entre 0 y 1, y la otra es la 

velocidad angular de las ruedas. La única señal de salida será el par de 

frenado generado. 

Debido a que el sistemas de freno es un sistema hidráulico y por lo tanto 

no es instantáneo, se modelará con un retraso temporal τbs, y las pinzas 

de freno tendrán un valor Kc, con estos parámetros se puede obtener la 

presión creada en los frenos, pb.                           ̇                                                ሺ    ሻ     
Donde ub es la señal de entrada que se mencionó anteriormente, y 1,5 es 

una constante que se debe a que la presión máxima es de 150 bares. 
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Esta ecuación diferencial puede ser expresada como función de 

transferencia de la siguiente forma: 

   ሺ ሻ   ሺ ሻ                                                                             ሺ    ሻ 
Esta presión en los frenos se transforma en un par de frenado que hace 

que el vehículo reduzca su aceleración, este paso de presión – par 

depende de varios parámetros, como pueden ser la velocidad o la 

temperatura, pero en este caso solo se tendrá en cuenta la velocidad.                (      )                                                   ሺ    ሻ 
Kb es una constante que hace la conversión entre presión y par, ω es la 

velocidad angular de la rueda. Se puede observar que el par es 

proporcional a la presión y a la velocidad angular (siempre que esta no 

supere el valor de α). 

Debido a que el reparto de frenada no es igual para los frenos delanteros 

que para los traseros, normalmente el coeficiente Kb será mayor en los 

frenos delanteros. 

 
Fig 2.8 – Bloque “Frenos”. 

En la figura 2.8 se ven los bloques utilizados para el modelado de los 

frenos. 
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2.6 PARÁMETROS DEL VEHÍCULO 

Para realizar posteriormente las simulaciones habrá que establecer los 

valores de las constantes o parámetros de las ecuaciones establecidas en 

los apartados anteriores, que serán necesarios para después realizar la 

simulación con Matlab. 

Algunos de esos parámetros es imposible determinarlos con exactitud, por 

lo tanto se harán estimaciones para tener unos datos lo más próximos a 

la realidad que sea posible, para ello se ha buscado parámetros de otros 

vehículos de similar tamaño o funcionamiento. 

Seguramente a la hora de realizar pruebas con el vehículo los resultados 

no sean igual a los simulados debido a las diferencias que puede haber en 

los parámetros reales y los que nosotros estimamos aquí. 

En la tabla 2.2 se encuentran los parámetros que se utilizaran en el 

apartado “4 - ANÁLISIS DE CONTROLADORES MEDIANTE SIMULACIÓN”. 
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Parámetro Valor 

m 600 kg 

L 1,9 m 

B 0,95 m 

C 0,95 m 

H 0,5 m 

θ 0 rad 

Rf, Rr 0,2 m 

Jf,  Jr 0,5 Kg / m2 

ρ 1,23 kg / m3 

Av 1,5 m2 

Cd 0,29 

Vv 0 km/h 

Cr 0,01 

Cff, Cfr 0,1 Nm/rad-1 

Re 10 Ω 

Le 1 H 

Kb 0.3 Vs 

Kt 40 Nm/A 

N 1 

Kc 1 

Kbf 10 Nm/bar 

Kbr 5 Nm/bar 

τ 0,2 s 

α 0,01 

Tabla 2.2 – Parámetros del vehículo. 

Además, los coeficientes de la ecuación de Pacejka, serán los 

correspondientes a una conducción sobre asfalto seco que aparecen en la 

tabla 2.1. 
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3 TÉCNICAS DE CONTROL 

3.1 IDENTIFICACIÓN DE SISTEMAS 

La identificación de sistemas es la teoría y el arte de construir modelos 

matemáticos de sistemas dinámicos basándonos en las entradas y salidas 

observadas. 

El objetivo es conseguir una función de transferencia o unas ecuaciones 

de estados que modelen, con cierta precisión, el sistema identificado. El 

modelo obtenido puede ser del orden que se desee, siendo así más o 

menos preciso, dependiendo de para que se necesite la identificación.  

La obtención de un modelo matemático puede enfocarse de dos formas, 

utilizando métodos teóricos, o usando métodos experimentales.  

La primera de estas opciones se basa en conocer los principios físicos, 

químicos o de cualquier otra ciencia, para así predecir el comportamiento 

del sistema, por ejemplo en motores eléctricos, circuitos, elementos 

mecánicos, reacciones químicas, etc. Esta forma se suele denominar 

modelado de sistemas, y este método a menudo resulta imposible de 

realizar, por el desconocimiento del sistema o por su complejidad. 

Cuando no sea posible realizar un modelado, se recurre a la segunda 

opción, la experimental, denominada identificación de sistemas, que es la 

que utilizaremos para crear un modelo matemático del vehículo. 
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Fig 3.1 – Esquema de identificación de sistemas. 

La figura 3.1 muestra un esquema de la función de una identificación de 

un sistema, con los datos de las entradas y las salidas, se obtiene un 

modelo. 

Construir modelos para sistemas desconocidos es un objetivo importante 

de la ingeniería de control. Estos modelos necesitan simular el 

comportamiento real en los casos en que el conocimiento previo del 

sistema es limitado. 

El proceso de identificación sigue los siguientes pasos: 

 Obtención de datos de entrada y salida, para ello se somete al 

sistema a una excitación cualquiera y se recogen los datos 

necesarios. 

 Tratamiento de los datos obtenidos, debido a que puede haber 

perturbaciones como por ejemplo ruido en ellos, y para mayor 

precisión habrá que corregirlos en lo posible, utilizando métodos de 

filtrado. 

 Elección del tipo de modelo deseado, esto incluye si el modelo será 

continuo o discreto, periodo de muestreo si fuera necesario, o el 

orden del modelo. 

 Obtención de los parámetros del sistema, consiguiendo así el 

modelo identificado. 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 36 
 

 Comprobación del modelo, para ello se puede someterle a la una 

excitación común con el sistema real, posteriormente se obtienen y 

comparar ambos resultados, comprobando si son lo suficientemente 

similares. 

En caso de que el modelo no sea satisfactorio, habrá que volver a realizar 

la identificación, pero variando el tipo de modelo a construir, o ampliando 

el rango de valores de entrada usados en la excitación de toma de datos. 

El problema de la identificación se complica bastante cuando se trata con 

un sistema no lineal, y la mayoría de los procesos reales son no lineales, 

aunque se pueden linealizar en torno a un punto de operación, en esa 

zona el modelo de la identificación funcionará correctamente, pero si el 

sistema pasa a funcionar en un punto de operación alejado, el modelo se 

comportara erróneamente. 

Existen dos grandes categorías de modelos utilizadas en la identificación, 

modelos paramétricos y modelos no-paramétricos. Los primeros son 

aquellos en los que el modelo matemático utilizado para describir el 

funcionamiento del sistema está completamente caracterizado por un 

conjunto finito de coeficientes (parámetros), en este grupo se encuentran 

las funciones de transferencia y los modelos de estado. 

Los no-paramétricos en cambio son aquellos métodos de caracterización 

de un sistema en los que para describir el funcionamiento del mismo se 

usa una o varias curvas de respuesta.  

Entre estos métodos están por ejemplo Bode, Nyquist y Nichols, que son 

métodos de respuesta frecuenciales. 

En el caso de este proyecto se realizara una identificación mediante un 

método de mínimos cuadrados, utilizando un modelo de segundo orden 

discreto. 

En esta identificación no se tomaran en cuenta las perturbaciones (ya que 

en la simulación no las habrá), varios métodos de identificación por 
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mínimos cuadrados sí que las tienen en cuenta, como por ejemplo los 

modelos ARX o ARMAX [6]. 

El modelo deseado de segundo orden discreto tiene la siguiente ecuación 

en diferencias, donde “y” es el valor de salida, y “u” el de entrada.                                                                       ሺ   ሻ 
Después de obtener todos los datos necesarios, se procederá a ordenarlos 

de forma que se repartan en 2 matrices que se definirán a continuación, 

en este caso se ha omitido el paso de filtrado de señales debido a que al 

haberse obtenido los datos de una simulación sin ruido, no hará falta ese 

filtrado. 

La primera de ellas será un vector columna con “m” filas, siendo los 

valores la velocidad del coche obtenidos en cada periodo de muestreo. La 

segunda será una matriz de 3 columnas y “m” filas, siendo las dos 

primeras columnas los valores de la señal de salida pero con uno y dos 

retrasos respectivamente, y la última columna será los valores de la señal 

de entrada. 

  ( ሺ   ሻ൯  ൮       )                                                          ሺ   ሻ 
  ሺ ሺ     ሻ  ሺ     ሻ  ሺ     ሻሻ  ൮                            )         ሺ   ሻ 

Una vez ordenados se obtendrán los coeficientes que después formaran 

parte de la función de transferencia y de las ecuaciones del espacio de 

estados, para ello se resolverá el siguiente sistema:                                                                               ሺ   ሻ 
൮       )  ൮                            )ቌ ሺ ሻ ሺ ሻ ሺ ሻቍ                                           ሺ   ሻ 
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Siendo X un vector columna de 3 filas, que contiene los tres coeficientes 

necesarios para un sistema de segundo orden, y que se obtendrá 

resolviendo el sistema de ecuaciones de la ecuación 3.4. 

Como nosotros vamos a trabajar en tiempo discreto, necesitaremos una 

función de transferencias discreta, la función de transferencia de sistema 

discreto será: 

  ሺ ሻ   ሺ ሻ       ሺ ሻ     ሺ ሻ                                                   ሺ   ሻ 
Y el modelo expresado como espacio de estados en variables de fase 

sería:   [    ሺ ሻ  ሺ ሻ]                                                             ሺ   ሻ   [  ]                                                                      ሺ   ሻ   [  ሺ ሻ]                                                               ሺ   ሻ   [ ]                                                                   ሺ    ሻ 
En Matlab se pueden utilizar algunos comandos para realizar una 

identificación, gracias a una “toolbox” de identificación disponible en 

algunas versiones. 

El resultado es muy similar y no se ofrece la opción de obtener el espacio 

de estados en variables de fase, cosa que es muy útil para nuestro 

objetivo, por lo tanto se usara el método anterior para modelos de 

segundo orden. 

Las funciones o comandos que se utilizarían en Matlab serían “iddata” 

para ordenar los datos, y “ssest” para crear el modelo con los parámetros 

deseados, el problema de este método es que matlab solo te permite 

obtener el espacio de estados en unas variables que el programa ha 

establecido. 
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3.2  CONTROL PID 

Un PID es un mecanismo de control por realimentación que calcula la 

desviación o error entre un valor medido y el valor que se quiere obtener, 

para aplicar una acción correctora que ajuste el proceso.  

PID son las siglas de “Proporcional, Integral y Derivativo”, ya que son las 

3 acciones que realiza. Básicamente, un PID es un controlador de hasta 

segundo orden. 

La acción proporcional da una señal proporcional al error actual, y es la 

parte más importante. La acción integral genera una corrección 

proporcional a la integral del error y aumenta el tipo del sistema, esto nos 

asegura que aplicando un esfuerzo de control suficiente, el error de 

seguimiento se reduce a cero. Y la acción derivativa determina la reacción 

del tiempo en el que el error se produce, y es proporcional a la derivada 

del error, esto supone que el PID se anticipa a la señal futura, tratando de 

contrarrestarla antes de que se produzca. El resultado total es la suma de 

estas tres acciones. 

 

Fig 3.2– Diagrama de bloques de un PID. 

En la figura 3.2 se muestra un PID separado por las 3 acciones que tiene, 

y como el resultado de las 3 acciones es sumado después. 

Además un PID puede funcionar eliminando algunas de las acciones, 

como por ejemplo es habitual no utilizar la acción derivativa debido a que 

puede dar problemas en determinadas ocasiones, por lo tanto el 
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controlador pasa a denominarse un PI, también pueden encontrarse algún 

PD, P o I. 

Combinando estas diferentes acciones el controlador adquiere las 

ventajas y desventajas de cada una, y dependiendo del sistema a 

controlar será necesario un tipo de controlador u otro. 

El regulador más simple de todos es el de acción proporcional o regulador 

P, cuya señal de control o salida es proporcional a la entrada o señal de 

error, y tiene una constante ajustable denominada ganancia del 

regulador. 

 

Fig 3.3 – Regulador de tipo P. 

En la figura 3.3 se muestra como es un bloque de un regulador tipo P. 

En el regulador de acción integral o regulador I, la señal de control es 

proporcional a la integral de la señal de error o entrada, y también tiene 

una ganancia ajustable. 

 

Fig 3.4 – Regulador de tipo I. 

En la figura 3.4 se puede ver el bloque de un regulador de tipo I. 

En un regulador proporcional-diferencial o regulador PD, la señal de 

control es proporcional a la entrada y a la derivada de la entrada, tiene 
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dos parámetros, una ganancia de acción proporcional, y una constante de 

tiempo de la acción diferencial. 

 

Fig 3.5 – Regulador de tipo PD. 

En la figura 3.5 tenemos un regulador de tipo PD, y se puede ver como la 

acción total es la suma de ambas acciones. 

Otro de los reguladores más importantes el proporcional integral o 

regulador PI, combina los efectos del regulador P y del regulador I, con la 

acción proporcional se consigue un efecto rápido pero no lo 

suficientemente preciso, y con la acción integral es al contrario, se tiene 

precisión pero es una acción de control lenta, las ventajas de ambos 

reguladores son combinadas en el PI. Este regulador tiene una ganancia 

de acción proporcional, y una constante de tiempo de la acción integral. 

 

Fig 3.6 – Regulador de tipo PI. 

En la figura 3.6 se muestran los bloques de un regulador PI [8]. 
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En las siguientes figuras se puede ver cuáles son las reacciones de las 

diferentes acciones a una señal de error determinada. 

 

Fig 3.7 – Acciones del PID ante un error constante. 

En la figura 3.7 se tiene la respuesta de un PID cuando se aplica a la 

entrada una señal de valor constante, en ese caso la respuesta 

proporcional será también constante y su valor dependerá de Kp, la 

respuesta integral será una rampa de una determinada pendiente en 

función de Ti y Kp, y la respuesta derivativa será nula, ya que la pendiente 

del error es 0. La respuesta total será la suma de todas las acciones, es 

decir, una rampa. 
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Fig 3.8 – Acciones del PID ante un error rampa. 

En la figura 3.8 se muestra la respuesta de un PID ante una señal de 

error que aumenta con pendiente constante, en este caso la forma de las 

diferentes acciones cambian con respecto la respuesta a un error 

constante. La respuesta proporcional será otra rampa con distinta 

pendiente a la del error, y dependerá de Kp, la respuesta integral ahora 

será una parábola, y la respuesta derivativa será constante. La respuesta 

de todo el PID será pues la suma de las tres respuestas, que tendrá una 

forma similar a una parábola. 

De esta forma se puede entender como son las respuestas de las 

diferentes acciones ante un error, que normalmente se verá afectado por 

la señal del PID de modo que no será tan lineal como los de los ejemplos 

anteriores. 

Normalmente un PID tiene suficiente flexibilidad como para alcanzar 

resultados satisfactorios en la mayoría de los sistemas en los que se 

implementan. 
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Es por todas estas características que los controladores del tipo PID son 

con mucha diferencia los que se utilizan con más frecuencia en la 

industria de control de procesos, donde más del 95% de los lazos de 

control están realizados con controladores PID o sus simplificaciones. 

Físicamente un PID continuo está compuesto por diferentes componentes 

electrónicos como resistencias, condensadores o amplificadores 

operacionales, dispuestos de tal manera que realizan las diferentes 

acciones del controlador (proporcional, integral y derivativa). 

 

Fig 3.9 – Componentes de un controlador PID continuo. 

En la figura 3.9 se muestra el circuito electrónico utilizado para crear un 

controlador PID continuo, se aprecia que utilizan varios componentes 

electrónicos básicos. 

La función de transferencia de un PID tiene la siguiente forma: 

 ሺ ሻ     (            )                                                     ሺ    ሻ 
Que define la siguiente ley de control: 

 ሺ ሻ     [ ሺ ሻ     ∫  ሺ ሻ         ሺ ሻ   
 ]                                       ሺ    ሻ 

Los parámetros Kp, Ti y Td son los que determinan como es la acción del 

PID, y será necesario ajustarles para conseguir un funcionamiento 

correcto del controlador. 
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La función de transferencia de la ecuación 3.11 no es físicamente 

realizable, por lo tanto a ese PID se lo denomina regulador PID teórico. 

Para que el PID sea físicamente realizable habrá que añadir a la acción 

derivativa un polo, con una influencia limitada, este nuevo regulador 

tendrá la forma: 

 ሺ ሻ                    ሺ      ሻ  ሺ      ሻ                                             ሺ    ሻ 
La función de transferencia puede tener varias formas de ser 

representada, con diferentes valores para los parámetros Kp, Ti y Td, 

representando el mismo regulador o planta, por tanto la función de 

transferencia utilizada posteriormente en el PID seguramente no tenga 

ninguna de las formas descritas anteriormente, aunque su funcionamiento 

sea el mismo [8]. 

En la actualidad es posible crear reguladores mucho más complejos que 

hace unos años, gracias a la posibilidad de realizar un algoritmo de 

control mediante un computador, estos algoritmos permiten crear 

reguladores más complejos que los controladores físicos como los PID. 

3.2.1 Diseño de controladores PID 

Existen varias formas para diseñar un PID, como por ejemplo el método 

de respuesta en frecuencia o el método de respuesta al escalón. Uno de 

los más utilizados y sencillos consiste en a partir de los polos deseados 

del sistema, y mediante el lugar de las raíces, se calculan donde debieran 

estar los polos del PID.  

Para determinar cuáles son los polos que se desean, o la respuesta que se 

quiere obtener, se pueden especificar ciertos parámetros de la respuesta, 

normalmente en el dominio del tiempo. 

Es habitual utilizar parámetros de la respuesta al escalón, como el tiempo 

de pico, tiempo de establecimiento, o el máximo sobreimpulso, estos 

parámetros se pueden relacionar con la posición de los polos mediante 

ecuaciones. 
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Fig 3.10 – Parámetros para el diseño de un PID. 

En la figura 3.10 se muestra la respuesta de un sistema de segundo 

orden con sobreimpulso, y en ella se marcan algunos de los parámetros 

utilizados en el diseño de reguladores PID. 

Las especificaciones respecto a la respuesta en el dominio temporal de un 

sistema se suelen definir con respecto a la respuesta temporal ante una 

entrada escalón en un sistema de segundo orden, para ello se toma como 

sistema de referencia un sistema con función de transferencia teórica: 

 ሺ ሻ                                                                     ሺ    ሻ 
Cuyos polos están situados:                 √                                                ሺ    ሻ 
Donde ξ es la tasa de amortiguamiento, y ωn es la frecuencia natural no 

amortiguada del sistema. Un sistema subamortiguado (0 < ξ ≤ 1) tiene 

una respuesta al escalón como la mostrada en la figura 3.3. 

También es necesario definir la frecuencia amortiguada como:       √                                                            ሺ    ሻ 
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Conociendo 2 de las características de la respuesta podemos calcular la 

tasa de  amortiguamiento y la frecuencia natural, para ello se utilizan las 

siguientes ecuaciones [6]:                                                                         ሺ    ሻ 
        √                                                                    ሺ    ሻ 

                                                                           ሺ    ሻ 
En el método de asignación de polos se parte de la función de 

transferencia de la planta o el proceso y de la función de transferencia del 

regulador elegido (aun sin los parámetros establecidos). Con estos datos 

se calcula la función de transferencia de lazo cerrado del sistema que será 

de la forma: 

 ሺ ሻ    ሺ ሻ   ሺ ሻ    ሺ ሻ   ሺ ሻ                                                     ሺ    ሻ 
Donde Gp(s) es la función de transferencia de la planta, y C(s) la del 

controlador PID. 

Por lo tanto se sabe que la ecuación característica del sistema será:     ሺ ሻ   ሺ ሻ                                                         ሺ    ሻ 
Conociendo los polos deseados del sistema en lazo cerrado que se 

calcularon anteriormente, se pueden calcular los parámetros del PID. 

Otra opción válida para el diseño de PIDs en sistemas estables en lazo 

abierto es el método de Ziegler-Nichols, que es el más importante de los 

métodos empíricos. 

El método de Ziegler-Nichols consiste en utilizar un control proporcional 

con una ganancia Kp, esta ganancia empezara siendo pequeña pero irá 

aumentando hasta que la señal de salida del controlador empiece a 

oscilar, en ese punto la ganancia Kp será Kc, la ganancia crítica, además 
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se medirá el periodo de oscilación Tc, con estos dos valores se 

determinarán los parámetros del regulador mediante la tabla 3.1: 

 Kp Ti Td 

P 0,50·Kc   

PI 0,45·Kc Tc/1,2  

PID 0,60·Kc Tc/2 Tc/8 

Tabla 3.1 – Valores de los parámetros por Ziegler-Nichols. 

Este método tiene varias formas de realizarse pero muy similares a esta 

que se ha explicado. 

También es posible el diseño de reguladores mediante respuesta en 

frecuencia, utilizando parámetros de diseño como pueden ser el margen 

de fase, el error de posición o velocidad, o el ancho de banda. Estos 

métodos de respuesta en frecuencia utilizan los diagramas de Bode y 

suelen realizarse de forma gráfica, aunque también pueden realizarse 

mediante programas informáticos. 
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Fig 3.11 – Ejemplo Diagrama de Bode. 

La figura 3.1 muestra como es un diagrama de bode. 

Debido a la inexactitud que tienen los estos métodos gráficos es preferible 

utilizar otros métodos analíticos como el de la asignación de polos. 

Con Matlab también se puede diseñar PID de forma sencilla, gracias a una 

toolbox que permite el diseño gráfico con la respuesta, esto permite 

observar la respuesta en función de los parámetros introducidos, 

eligiendo cual es la más satisfactoria para el sistema con el que se 

trabaja. 

3.2.2 Discretización de controladores PID 

Los métodos anteriormente descritos están pensados para controladores 

continuos, dado que la mayoría de los procesos industriales son de 

naturaleza continua. Sin embargo, en la actualidad la mayoría de los 

controladores son de tipo discreto, por lo que si se diseñan con los 
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métodos anteriores, será necesario discretizarlos para poder implantarlos 

en los sistemas reales. 

La ecuación 3.12 describe la respuesta de un controlador continuo, en 

cambio, en un controlador discreto la respuesta no tendrá la misma 

forma, habrá que sustituir el termino derivativo por una diferencia de 

primer orden, y el termino integral por una aproximación rectangular 

hacia delante. 

 ሺ ሻ     [ ሺ ሻ      ∑  ሺ ሻ        
   ( ሺ ሻ   ሺ   ሻ൯]                    ሺ    ሻ 

 

Fig 3.12 – Aproximación rectangular hacia adelante. 

Lo que muestra la figura 3.12 es como se realiza una aproximación 

rectangular hacia delante, se puede apreciar que se comete un ligero 

error. 

Después de realizar unas operaciones para eliminar el sumatorio y 

transformar la ecuación 3.22 podemos obtener la función de transferencia 

del regulador discreto, que tiene la siguiente forma: 

 ሺ ሻ   ሺ ሻ ሺ ሻ                                                               ሺ    ሻ 
Donde los parámetros q0, q1 y q2 son los siguientes: 

      (     )                                                             ሺ    ሻ 
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       (           )                                                    ሺ    ሻ                                                                             ሺ    ሻ 
También se puede sustituir la integral mediante una aproximación 

trapezoidal, de forma más exacta, obteniendo un resultado muy similar, 

cuanto mayor sea el orden de la aproximación mayor será la precisión y 

la dificultad. 

 

Fig 3.13 – Aproximación Trapezoidal. 

En la figura 3.13 se muestra una aproximación trapezoidal, que 

comparada con la rectangular, se puede ver que es mas exacta. 

De tal forma la expresión de u(k) sería: 

 ሺ ሻ     [ ሺ ሻ      ሺ ሺ ሻ   ሺ ሻ  ∑  ሺ ሻሻ        
   ( ሺ ሻ   ሺ   ሻ൯]            ሺ    ሻ 

Y con la misma función de transferencia de la ecuación 3.23, tendríamos 

unos parámetros q0 y q1 ligeramente distintos, sin embargo q2 seguirá 

siendo el mismo que en la ecuación 3.26 [5]. 

      (           )                                                    ሺ    ሻ        (             )                                              ሺ    ሻ 
 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 52 
 

3.3 CONTROL POR REALIMENTACIÓN DE ESTADOS 

3.3.1 Espacio de estados 

Le teoría moderna está basada en el conocimiento del comportamiento 

interno de los sistemas, esto se puede  reflejar en variables que influyen 

en su dinámica. Estas variables constituyen el concepto de “estados del 

sistema”. El conocimiento de la evolución de las variables del sistema 

permite realizar un control más potente y su utilización en el control de 

sistemas más complejos. 

Se define estado de un sistema como la mínima cantidad de información 

necesaria en un instante para que, conociendo la entrada a partir de ese 

instante se pueda determinar la salida en cualquier instante posterior. 

Para controlar un sistema por este método será necesario que el sistema 

esté en forma de espacio de estados, para poder obtener una señal de 

estados que realimentar. Para ello habrá que conocer las cuatro matrices 

de las que consta todo espacio de estados. 

En la figura 3.14 se muestra la representación de un sistema en espacio 

de estados, donde los parámetros A, B, C y D son matrices. 

 

Fig 3.14 – Representación en espacio de estados. 

Las matrices A, B, C y D dependen del tiempo en la forma más general, 

aunque en la mayoría de los casos se pueden simplificar a matrices 

constantes si el sistema no varía con el tiempo. En un vehículo 

convencional por ejemplo, la masa del vehículo puede ir cambiando 

(Consumo de gasolina, aumento de pasajeros, desgaste de neumáticos), 
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y por lo tanto las ecuaciones que definen su funcionamiento debiera 

cambiar, por lo tanto las ecuaciones de estado tienen la siguiente forma:  ̇ሺ ሻ   ሺ ሻ   ሺ ሻ   ሺ ሻ   ሺ ሻ                                                ሺ    ሻ  ሺ ሻ   ሺ ሻ   ሺ ሻ   ሺ ሻ   ሺ ሻ                                                ሺ    ሻ 
Además la señal de salida se puede definir solo con los estados, por tanto 

la matriz “D” suele ser nula y eliminarse de las ecuaciones.  

Simplificando las ecuaciones de estado para sistemas invariantes:  ̇ሺ ሻ     ሺ ሻ     ሺ ሻ                                                   ሺ    ሻ  ሺ ሻ     ሺ ሻ                                                             ሺ    ሻ 
Las matrices que constituyen el espacio de estados son las siguientes: 

-A (n x n): Matriz de evolución. 

-B (n x m): Matriz de aplicación. 

-C (q x n): Matriz de observación. 

-D (q x m): Matriz de transmisión directa. 

Siendo “n” el orden del sistema, “m” el número de entradas y “q” el 

número de salidas, además “x” es el vector de estados, “u” la señal de 

entrada, y “y” la señal de salida. 

Estas ecuaciones son muy similares tanto si el sistema es continuo como 

si es discreto, existen las mismas matrices y de la misma forma, aunque 

evidentemente con distintos valores, quedando las ecuaciones de la 

siguiente manera para un sistema invariante:  ሺ   ሻ     ሺ ሻ     ሺ ሻ                                                ሺ    ሻ  ሺ ሻ     ሺ ሻ                                                                ሺ    ሻ 
Los estados dependen de la forma de las matrices, un sistema puede 

estar representado de infinitas formas, con diferentes estados cada una. 

Algunas formas son más habituales debido a la simpleza o a la utilidad, 

las más utilizadas son las llamadas de variables de fase, variables físicas 

o de variables canónicas o de Jordán. 
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Se puede pasar de unas variables a otras utilizando las matrices de 

transformación, que serán distintas dependiendo de qué variables se 

utilicen. Esta matriz de transformación se denomina “T”, y es de tamaño 

n x n. Al realizar la transformación las matrices A, B, C y D cambian de la 

siguiente manera, siendo  ̃  ̃  ̃    ̃ las matrices nuevas.  ̃                                                                                ሺ    ሻ  ̃                                                                                 ሺ    ሻ  ̃                                                                                  ሺ    ሻ  ̃                                                                                  ሺ    ሻ 
3.3.2 Controlabilidad y Observabilidad 

No todos los sistemas son controlables de esta forma, por lo que antes de 

diseñar el control, habrá que comprobar si este sistema es controlable, 

mediante la matriz de controlabilidad. 

Básicamente un sistema es controlable si se puede alcanzar un 

determinado estado aplicando una entrada determinada en un tiempo 

finito. 

Existen varias formas de definir la controlabilidad, una de ellas es la 

siguiente: 

“Se dice que el estado x(t) es controlable en t = t0 si existe una entrada 

continua por intervalos u (t) que moverá el estado a cualquier estado final 

x(tf) en un tiempo finito [tf–t0≥0]”. 

En un sistema lineal que tiene como ecuación de estado la ecuación 3.30, 

es controlable en [t0,t1] si y solo si la matriz W(t1,t0) es no singular. 

 ሺ     ሻ  ∫  ሺ    ሻ   ሺ ሻ    ሺ ሻ    ሺ    ሻ                              ሺ    ሻ     

Sin embargo hay una forma más simple de ver si un sistema es 

controlable siempre y cuando el sistema se invariante tal y como el de la 

ecuación 3.32. Para ello se utiliza la llamada matriz de controlabilidad. 
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La matriz de controlabilidad se forma de la siguiente forma:   ሺ |   |    | |      ሻ                                          ሺ    ሻ 
Para que este sistema completamente controlable, es condición necesaria 

y suficiente que la matriz de controlabilidad M de n x nr tenga rango n y 

por lo tanto su determinante sea distinto de 0. 

Si un sistema no es controlable significa que existen determinados 

estados que no se van a poder alcanzar, sin embargo seguirán existiendo 

estados que si se podrán alcanzar. Así que se puede hablar de un 

subespacio controlable donde se encuentran los estados alcanzables en 

un sistema no controlable. 

Se puede hablar también de la controlabilidad de la salida, que se define 

como: 

“Se dice que un punto del espacio de salida de un sistema, y1, es 

controlable en [t0, t1] si existe una entrada “u” definida en el intervalo 

[t0,t1], tal que para todo punto de origen en t0 consiga que la salida valga 

y1 en t1”. 

En este caso también se puede definir una matriz de controlabilidad para 

la salida:    ሺ   |     |      |  |        ሻ                                 ሺ    ሻ 
La salida y(t) es controlable si y solo si la matriz QC es de rango q (La 

matriz C es re tamaño q x n). 

Dualmente a la controlabilidad se define la observabilidad, se necesita que 

un sistema sea observable si se quiere hacer un observador para el 

control por realimentación de estado. 

La observabilidad es la posibilidad de conocer el valor de un estado de un 

sistema a partir del conocimiento de la evolución de la entrada y de la 

salida que genera, una vez conocido el estado en un instante inicial, se 

puede conocer el estado en cualquier otro instante posterior utilizando la 

solución de la ecuación de estado. 
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Se define la observabilidad como: 

“Se dice que un punto x0 del espacio de estado es observable en [t0, t1], 

si siendo este el estado inicial en el instante t0, x0 = x(t0), el conocimiento 

de la entrada u(t) en el intervalo [t0,t1] y de la salida y(t) en el mismo 

intervalo permite determinar que el estado inicial del sistema en el 

instante t0 es x0”. 

Para un sistema general se puede decir que un sistema es observable 

siempre y cuando la matriz V(t1,t0) es no singular. 

 ሺ     ሻ  ∫   ሺ    ሻ    ሺ ሻ   ሺ ሻ   ሺ    ሻ                                        ሺ    ሻ 
Además, como con la controlabilidad, existe también una matriz de 

observabilidad en sistemas invariantes, que se necesita que sea de rango 

n, para que el sistema sea observable. 

  ( 
             ) 

                                                                ሺ    ሻ 
En un sistema invariante como el definido por las ecuaciones 3.32 y 3.33, 

el conjunto de puntos del espacio de estado tales que tomados como 

estado inicial ante entrada nula, la salida del sistema es 

permanentemente nula y denominados no-observables, forman un 

subespacio vectorial que se denomina subespacio no-observable. 

Se puede separar el subsistema no-observable del sistema total, para ello 

se utilizara una matriz de cambio de base “T”, que multiplicada por las 

matrices que definen el sistema, se obtendrán otras nuevas matrices que 

definirán el subsistema [7]. 

3.3.3 Realimentación de estados sin observador 

El control por realimentación de estados consiste en utilizar el vector de 

estados x(t) en cada momento para multiplicar cada estados por una 
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constante y realizar una realimentación negativa a la entrada de 

referencia. 

Para ello será necesario poder acceder al valor de todos los estados, en 

caso contrario habría que utilizar un observador de orden parcial o de 

orden completo, como se explicará posteriormente. 

En la figura 3.15 se puede ver como se dispone el sistema total cuando se 

utiliza el control por realimentación de estados, con la realimentación 

negativa tal y como se dijo anteriormente. 

 

Fig 3.15 –Diagrama realimentación de estados. 

La ganancia “K” es la ganancia de realimentación de estados, y es un 

vector fila con “n” columnas, siendo “n” el número de estados del 

sistema. 

Esta ganancia “K” se calcula de forma que el sistema realimentado tenga 

los polos deseados de lazo cerrado, para ello se utiliza la fórmula de 

Ackermann que se explicara posteriormente. 

El sistema de ecuaciones del sistema cambia al implementar esta 

realimentación, la señal de entrada aplicada a la planta ya no es la 

misma:  ሺ ሻ   ሺ ሻ     ሺ ሻ                                                        ሺ    ሻ 
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Donde r(t) es la señal de referencia que se utiliza ahora, esta señal de 

referencia será el valor deseado por el usuario para el valor final de la 

salida. 

La ecuación de la derivada de los estados quedaría por lo tanto de la 

siguiente manera:  ̇ሺ ሻ     ሺ ሻ     ሺ ሻ       ሺ ሻ  ሺ     ሻ   ሺ ሻ     ሺ ሻ              ሺ    ሻ 
Como se puede observar la realimentación de estados es como si hubiera 

cambiado la matriz A, por una matriz nueva que llamaremos Ar, esta 

matriz no tiene por qué estar implementada en el espacio de estados.                                                                          ሺ    ሻ 
Un problema que surge al utilizar este método de control es que la 

ganancia del sistema en lazo cerrado no es la deseada normalmente, ya 

que al introducir la realimentación toma un valor arbitrario. A este 

problema se le pueden aplicar dos soluciones. 

La primera de ellas consiste en sacrificar el posicionamiento de uno de los 

polos, que queda libre, para poder fijar el término independiente del 

polinomio característico. Este proceso será de prueba y error, ya que al 

fijar la ganancia y el resto de polos, el polo libre se puede posicionar en 

un punto no deseado. 

La segunda solución y más utilizada, usa una ganancia “K0” colocada en la 

entrada para multiplicar a la señal de referencia, la función de 

transferencia del sistema cambiara y se podrá calcular el valor de esta 

ganancia para conseguir el valor final deseado. 

Posteriormente se explicará cómo calcular el valor correcto de esta 

ganancia. 
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3.3.4 Realimentación de estados con observador 

No en todos los sistemas puede usarse la realimentación de estados tal y 

como se ha explicado, dado que como se ha podido observar es necesario 

obtener las señales de todos los estados, esto a veces no es posible o es 

muy complicado, dado que pueden ser variables físicas que se necesita 

instrumental especial para medirlas. Para controlar estos sistemas es 

necesario utilizar un observador con el cual sí que se pueda conseguir una 

señal aproximada de todos los estados. 

El observador puede ser de orden completo, el cual tiene como salidas un 

vector con todos los estados del sistema, o un observador de orden 

reducido, el cual solo tiene como salida los estados que no pueden ser 

medidos en el sistema físico.  

Este observador es un sistema en el espacio de estados con las mismas 

matrices que el sistema a controlar, pero en este caso será un sistema 

electrónico, del cual obtenemos la salida y los estados, aplicando la 

misma señal de entrada que a la planta. 

Dado un sistema lineal, invariante y observable como el de las ecuaciones 

3.32 y 3.33, se dice que el siguiente sistema (ecuaciones 3.48 y 3.49) es 

un observador siempre y cuando se cumplan las dos condiciones 

expuestas a continuación. 

 ̂̇ሺ ሻ     ̂ሺ ሻ     ሺ ሻ     ሺ ሻ                                             ሺ    ሻ  ̂     ̂ሺ ሻ                                                                     ሺ    ሻ 
 Si los estados de ambos sistemas (real y observador) coinciden en 

un instante t0,  ̂ሺ  ሻ   ሺ  ሻ, entonces los estados coinciden para 

todo instante posterior  ̂ሺ ሻ   ሺ ሻ para cualquier entrada u(t) 

aplicada sobre el sistema. 

  ̂ሺ ሻ debe tender asintóticamente al estado x(t) para cualquier 

entrada u(t) y para cualesquiera estados iniciales  ̂ሺ  ሻ y x(t0). 
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En la figura 3.16 se puede ver como es el sistema total cuando la 

realimentación de estados se realiza con ayuda de un observador de 

estados. 

 

Fig 3.16– Diagrama de bloques de la realimentación de estados con un 

observador. 

Las ecuaciones del sistema realimentado son las siguientes:  ሺ ሻ     ̂ሺ ሻ                                                                     ሺ    ሻ  ሺ ሻ   ሺ ሻ   ሺ ሻ                                                                 ሺ    ሻ  ̇ሺ ሻ     ሺ ሻ       ̂ሺ ሻ     ሺ ሻ                                                ሺ    ሻ  ̂̇ሺ ሻ  ሺ     ሻ   ̂ሺ ሻ     ሺ ሻ     ሺ ሻ                                          ሺ    ሻ 

En un sistema de control por realimentación de estados con observador, 

hay que utilizar una matriz más, representada como “L” y situada dentro 

del observador, multiplica a la diferencia entre la salida real y la salida del 

observador y se suma a la derivada de los estados, tal y como se puede 

ver en la ecuación 3.53. 

Escritas las ecuaciones en forma matricial, se tiene que: 

( ̇ሺ ሻ ̂̇ሺ ሻ)  ቀ                 ቁ  ( ሺ ሻ ̂ሺ ሻ)  ቀ  ቁ   ሺ ሻ                             ሺ    ሻ 
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El caso de un observador de orden reducido es más complejo, pero dará 

mejores resultados dado que habrá estados que no hará falta estimar, 

siendo su valor el valor real. No sería lógico que pudiendo utilizar estos 

estados conocidos no se utilizaran. 

Para realizar un observador de este tipo se separan los estados medibles 

de los no medibles, a los primeros los llamaremos xa y a los segundos xb. 

Las ecuaciones de estados en forma matricial resultarían entonces de la 

siguiente forma: 

( ̇   ̇ )  (                 )  (     )  (     )                                         ሺ    ሻ 
  ሺ   ሻ  (     )                                                         ሺ    ሻ 

En el caso típico de que solo hubiera un estado medible, y este fuera 

además igual a la salida, podríamos hacer lo siguiente: 

Dinámica de los estados no medidos:  ̇                                                                      ሺ    ሻ 
Donde los dos últimos sumandos se corresponden con entradas conocidas 

por nosotros. 

Dinámica de los estados medidos:  ̇   ̇                                                                  ሺ    ሻ 
Se puede hacer una comparación con un sistema invariante lineal como el 

de las ecuaciones 3.32 y 3.33. 

El estimador de orden reducido entonces nos daría el valor de los estados 

no medibles, mediante la siguiente ecuación:  ̂̇  ሺ         ሻ   ̂  ሺ         ሻ       ̇  ሺ       ሻ               ሺ    ሻ 
La ganancia “L”  necesaria se obtendrá de la misma forma que para un 

observador de orden completo, tal y como se explicará posteriormente. 
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3.3.5 Realimentación de estados con un PI 

El objetivo de añadir un PI al sistema es aumentar la robustez de este, 

esto se hace aumentando la planta agregando un nuevo estado xi que 

integra el error de seguimiento. 

Para ello se necesita realimentar la salida además de los estados, y 

comparar la salida con la señal de referencia, la señal que resulta de esta 

comparación será la señal que se integrará. Una vez la señal pasa por el 

PI se obtiene el nuevo estado xi, que será la señal que se compare con la 

realimentación de los demás estados. Por lo tanto este nuevo estado sería 

equiparable a la señal de referencia de un sistema de realimentación de 

estado que no utilizara este método. 

La figura 3.17 muestra como es el sistema cuando se utiliza un PI 

complementando la realimentación de estados. 

 

Fig 3.17 – Diagrama de realimentación de estados con PI. 

Si el sistema sin el PI era controlable y G(s) no tiene ceros en s=0, 

entonces los autovalores de la matriz de evolución aumentada (ecuación 

3.60) pueden asignarse arbitrariamente seleccionando la matriz de 

realimentación (K y parámetros del PI).   (             )                                                 ሺ    ሻ 
En términos de polos y ceros, si la planta tuviera un cero en s=0, su 

conexión en cascada con el integrador de xi produciría una cancelación 

polo-cero inestable y haría que la planta aumentada no sea controlable. 
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El sistema rechazará perturbaciones constantes y seguirá referencias 

constantes, ambas de valor no necesariamente conocido, a un frente a 

incertidumbres de modelado de la planta, siempre que el lazo cerrado 

permanezca estable. 

3.3.6 Cálculo de las ganancias 

Como se dijo anteriormente la ganancia de realimentación de estados 

debe calcularse mediante la fórmula de Ackermann, válida para sistemas 

de una única entrada. La fórmula de Ackermann únicamente utiliza las 

matrices A y B, y los polos de lazo cerrado deseados.   ሺ    ሻ  ሺ         ሻ     ሺ ሻ                        ሺ    ሻ 
Donde  ሺ ሻ es el polinomio característico del sistema realimentado, 

evaluado en la matriz A. 

Además la fórmula de Ackermann también se puede utilizar para obtener 

la matriz “L” del observador, para ello habrá que sustituir la matriz B por 

la matriz C, y además trasponer la matriz A y la B, y el resultado final, de 

modo que la matriz “L” será un vector de “n” filas, la ecuación resultante 

será:    ሺ    ሻ  ሺ              ሻ        ሺ  ሻ                      ሺ    ሻ 
Donde     ሺ  ሻ es el polinomio característico del observador, evaluado 

esta vez en A traspuesta. 

Por último, para el sistema realimentado habrá que utilizar una ganancia 

de compensación “K0” para ajustar la ganancia estática, y que el valor 

final en régimen permanente sea el mismo que el sistema sin 

realimentación, para ello se calcula G (z) mediante la fórmula:  

 ሺ ሻ    (    ൯  ሺ    ሻ                                               ሺ    ሻ 
Con ella y utilizando el teorema de valor final se iguala el valor final a 1, y 

se despeja para obtener la ganancia “K0”. 
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                  ሺ ሻ       ሺ ሻ                                                     ሺ    ሻ 
Esta ganancia estará situada de tal forma que la señal de referencia 

quede multiplicada por ella, es decir, se colocara en la entrada del 

sistema. 

  



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 65 
 

4 ANALISIS DE CONTROLADORES MEDIANTE 
SIMULACIÓN 
Una vez realizado el modelo del vehículo tal y como se detalló en el 

apartado “2 MODELADO DE LA DINAMICA LONGITUDINAL DEL VEHÍCULO 

ELÉCTRICO”, se usará para realizar pruebas con él, mediante la 

herramienta de Matlab “Simulink”, para ello se crearán una serie de 

diagramas de bloques para las diferentes pruebas, para comprobar el 

correcto funcionamiento del modelo, y para diseñar las diferentes formas 

de control que se podrían implementar posteriormente en el vehículo. 

4.1  VERIFICACIÓN DEL MODELO 

Para esta comprobación, se someterá el modelo a varios valores para la 

señal de entrada (Aceleración/Freno) para comprobar que la señal de 

salida (Velocidad) es más o menos la que se espera, para ello la señal de 

entrada tiene que ser variada, teniendo momentos en las que el vehículo 

aumentara de velocidad y momentos en los que el vehículo frenará.  

Los datos que se obtienen al realizar la simulación serán los siguientes: 

 Velocidad del cuerpo del vehículo, es la velocidad real a la que se 

mueve el coche. 

 Velocidad de las ruedas, obtenida al multiplicar la velocidad angular 

del movimiento de las ruedas por el radio de estas. 

 Distancia Recorrida, resultado de integrar la velocidad del cuerpo. 

La diferencia entre las dos velocidades medidas, se debe al deslizamiento 

descrito anteriormente, las ruedas pueden derrapar al tener un par 

grande, y entonces se moverán con más velocidad que el vehículo. 

El diagrama de bloques realizado para esta simulación se muestra en la 

siguiente figura, siendo el bloque “Vehículo” el realizado en el apartado de 

modelado. 
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Fig 4.1– Bloques de Simulink para la comprobación del sistema. 

En la figura 4.1 se muestra la disposición de los bloques, incluido el 

modelo del vehículo realizado anteriormente, que se va a utilizar para 

comprobar el funcionamiento correcto de este. 

La señal de entrada que se aplicara será la siguiente, como se puede 

apreciar alterna periodos de frenado con periodos de aceleración, para 

que se compruebe completamente el correcto funcionamiento del modelo. 

Se puede ver que es una secuencia periódica, de periodo 30 segundos, 

que en ese caso se repetirá en 2 ocasiones, ya que las simulaciones 

tendrán un tiempo de 60 segundos. Los frenados no son muy fuertes para 

que el vehículo no funcione a velocidades muy bajas, debido a que el 

modelo tiene problemas al simular con velocidades cercanas a 0. 

En la figura 4.2 se enseña la gráfica de la señal de entrada que se 

aplicara. 
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Fig 4.2– Señal de entrada aplicada. 

En la figura 4.3 se muestra las gráficas de las señales de salida, en la 

gráfica superior están superpuestas la velocidad del vehículo y la 

velocidad de las ruedas, y en la segunda se representa la distancia 

recorrida por el vehículo en función del tiempo.  

 

Fig 4.3 – Resultados obtenidos en la comprobación. 
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Se puede apreciar que existe una ligera diferencia entre la velocidad de 

las ruedas y la velocidad del vehículo, hay picos cuando se produce el 

deslizamiento entre neumáticos y asfalto, estos picos se acentúan cuando 

el vehículo está acelerando bruscamente, y en vehículos más potentes se 

notarían mucho más. En un coche real esto sería un derrape donde la 

rueda gira a más velocidad debido al deslizamiento. 

Los resultados obtenidos son satisfactorios y se corresponden con lo 

esperado, el vehículo responde de forma rápida a la señal de entrada, 

como era de esperar debido a que los motores eléctricos tienen mayor 

velocidad de actuación que los motores de combustión típicos en la 

automoción. 

4.2 INDENTIFICACIÓN DEL MODELO DINÁMICO LINEAL 

Con los resultados obtenidos es posible conseguir una identificación del 

modelo del vehículo, para obtener una función de transferencia que 

modele el funcionamiento del vehículo, pudiendo pasarlo a espacio de 

estados y utilizarla para el diseño de un PID o un control por 

realimentación de estados. 

La identificación que se va a realizar va a obtener un sistema de segundo 

orden lineal, tal y como se explicó en el apartado anterior, que no se 

corresponde con el modelo más real del vehículo, que no es lineal, por 

tanto se conseguirá un modelo aproximado, que funcionará con la 

suficiente precisión para el objetivo de estas simulaciones. 

La función de transferencia de un modelo de segundo orden será del tipo: 

  ሺ ሻ                                                                ሺ      ሻ 
Mediante la identificación  en matlab los coeficientes obtenidos son: 

b1 = 0.3616; a1 = 1.551; a2 = -0.5577; 

Resultando la función de transferencia del modelo: 

  ሺ ሻ                                                                   ሺ      ሻ 
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Para el control por realimentación de estados que probaremos 

posteriormente se va a necesitar que el sistema esté representado en el 

espacio de estados, para ello a partir de la función de transferencia 

creamos el espacio de estado en variables de fase.  

Utilizando los mismos coeficientes que se obtuvieron para la función de 

transferencia, una vez sustituidos los valores, las matrices de estados 

serán:   [               ]                                                ሺ      ሻ 
  [  ]                                                            ሺ      ሻ   [       ]                                                   ሺ      ሻ   [ ]                                                             ሺ      ሻ 

Ambas formas representan el mismo sistema, y tienen un 

comportamiento idéntico, por lo tanto tienen los mismos polos de lazo 

abierto, que son los siguientes: 

z1 = 0.9857; z2 = 0.5657; 

Y el lugar de las raíces del sistema se puede ver en la figura 4.4, realizado 

con la función de matlab “rlocus”. 
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Fig 4.4– Lugar de las raíces del sistema. 

La ganancia en lazo cerrado a partir de la cual el sistema es inestable es 

K=8.61, en este caso no se alcanzará tal ganancia así que el sistema será 

estable, que es, lógicamente, indispensable. 

4.3 CONTROL  PID 

Esta solución para el control de la señal de entrada (acelerador/freno) es 

la más básica que se probara, consiste en colocar un PID antes de la 

entrada del sistema, este PID recibe una señal de error obtenida de la 

resta de una señal de referencia y la velocidad de salida del sistema. 

La señal de referencia que aplicaremos será la velocidad deseada, es 

decir, la velocidad a la que se desea que se ponga el vehículo. 

Para la simulación, la señal de referencia aplicada consistirá en varios 

escalones de distinta amplitud, siempre en el rango de valores de 

velocidades que el vehículo puede circular. Estos escalones se suavizaran 

gracias a un bloque función de transferencia que se colocara a 
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continuación del bloque que da la señal de entrada, esta función de 

transferencia suavizara la señal sin modificar el valor final. 

La señal de error es por tanto una resta entre dos velocidades, por lo cual 

está en variables de velocidad (km/h), cuanto más cercana sea la 

velocidad del vehículo a la deseada, menor será la señal de error. 

 

Fig 4.5– Bloques de Simulink para el diseño del PID. 

La figura 4.5 muestra el sistema de bloques utilizados en Simulink para 

simular el sistema cuando se utiliza PIDs, se puede apreciar el bloque 

función de transferencia a continuación de la señal de entrada. 

Se han colocado dos PID para las pruebas, aunque son exactamente el 

mismo y por lo tanto tienen el mismo funcionamiento, primero se diseña 

el PID en el lazo con el modelo identificado, para después copiarle y 

añadirle en el lazo del modelo “real”. El bloque de la función de 

transferencia contiene la función obtenida en la identificación anterior. 

El diseño del PID se ha realizado con una herramienta de matlab que 

ofrece un diseño gráfico con la respuesta a una entrada escalón, para ello 

linealiza la planta. 

Con dicha herramienta se debe buscar un PID que no tenga ningún 

sobreimpulso y que tenga un buen tiempo de subida para la función que 
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cumple, este tiempo se ha estimado de unos 5 segundos. Estos requisitos 

son lo que cualquier usuario del vehículo querría para un vehículo urbano, 

es decir, que la velocidad no oscile, y que no tenga grandes acelerones. 

En este caso se ha diseñado utilizando el dominio temporal, aunque 

también se podría haber usado el dominio de la frecuencia, donde habría 

que haber especificado el ancho de banda y el margen de fase. 

Para el sistema que tenemos es imposible conseguir las especificaciones 

deseadas con este método, habrá que elegir entre un PID rápido o un PID 

sin sobreimpulso, o uno con unas características entre ambos, pero 

ninguno será del todo satisfactorio.  

4.3.1 PID rápido 

Primero haremos las pruebas con un PID que cumpla la condicion del 

tiempo de subida: 

 

Fig 4.6 – Diseño gráfico de un PID rápido. 
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En la figura 4.6  se muestra la interfaz de matlab para el diseño de 

reguladores gráficamente, se puede apreciar el sobreimpulso que se 

generará. 

El PID obtenido tiene la siguiente forma y parámetros: 

 

Fig 4.7– Parámetros del PID rápido. 

La figura 4.7 contiene los parámetros del PID diseñado, así como la 

fórmula del PID. 

En la figura 4.8 muestra la gráfica con los valores de: 

 Velocidad según la función de transferencia. 

 Velocidad según el modelo matemático del coche. 

 Velocidad de referencia. 
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Fig 4.8– Resultados obtenidos con el PID rápido. 

La señal azul es la señal de entrada, la amarilla la velocidad del modelo 

matemático, y la morada la velocidad del modelo de la función de 

transferencia. 

Los resultados obtenidos no son satisfactorios, la velocidad del vehículo 

sobrepasa en momentos a la de referencia, debido a que tiene 

sobreimpulso. El tiempo que tarda en alcanzarla es aceptable (es más 

lento que los 5 segundos deseados, pero aun así es válido). 

Además se ve una diferencia apreciable en el funcionamiento del PID para 

el modelo real y para el modelo identificado. 

También es recomendable comprobar cómo será la señal de entrada 

(aceleración/freno) que se enviará a la controladora, y esta pasará 

despues al motor. 
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Fig 4.9– Señal de entrada con el PID rápido. 

En la figura 4.9 se puede ver como sería la señal de entrada que se 

crearía. 

Se puede apreciar que la señal no tiene cambios demasiado bruscos y la 

forma que tiene podría ser válida para el modelo final. 

Una forma de obtener un valor para ver como de buenos son los 

resultados es calcular el error cuadrático medio, para ello se eleva al 

cuadrado una señal de error, que será el resultado de la resta del valor de 

la velocidad de referencia y el valor de velocidad real, después se integra 

y se divide entre el tiempo de simulación, obteniendo así un valor que 

determinará el error que se produce con el sistema de control. 

Evidentemente, cuanto menor sea el error, mejor será nuestro sistema. 

Los bloques utilizados para el cálculo del error cuadrático medio se 

pueden ver en la figura 4.10. 
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Fig 4.10 – Bloques para el cálculo del error cuadrático. 

El error cuadrático que se obtiene con la simulación de PID rápido es de 

52.02, que se comparara con los obtenidos en las siguientes 

simulaciones. 

4.3.2 PID sin sobreimpulso 

En este caso diseñaremos un PID que no tenga sobreimpulso, sacrificando 

así la velocidad. 

En la figura 4.11 se puede ver la respuesta a un escalón en la interfaz de 

diseño de Matlab, donde se aprecia que la respuesta no tiene 

sobreimpulso, tal y como se desea. 

 

Fig 4.11 – Diseño gráfico de un PID sin sobreimpulso. 
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Se puede ver que en principio es demasiado lento para el objetivo que se 

busca. 

Los parámetros de este PID son: 

 

Fig 4.12 – Parámetros del PID sin sobreimpulso. 

La figura 4.12 muestra los parámetros que tiene este nuevo PID, y la 

fórmula que lo define. 

En la figura 4.13 se puede ver cuál sería las respuestas en el caso de 

utilizar este PID, igual que en la figura 4.8, la señal azul corresponde a la 

señal de referencia, la amarilla a la velocidad del modelo matemático, y la 

morada corresponde a la velocidad del modelo de la función de 

transferencia. 
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Fig 4.13 – Respuesta del sistema usando un PID sin sobreimpulso. 

Evidentemente este PID no cumple con lo deseado, es demasiado lento 

para implementarlo en un vehículo, ya que tardaría unos 15 segundos en 

alcanzar la velocidad deseada.  

El error cuadrático obtenido con este PID es de 72,05, que se 

ampliamente superior al del PID rápido. 

Así que esta opción queda descartada, ya que un PID rápido como el 

probado anteriormente, aun con sobreimpulso, funciona mucho mejor que 

este. 

4.3.3 PID con ligero sobreimpulso. 

Este PID se diseñara buscando un caso medio entre los dos anteriores, se 

sacrificara un poco de velocidad a cambio de reducir un poco de 

sobreimpulso, y se comparará con los anteriores. 
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Fig 4.14 – Diseño gráfico del PID. 

La figura 4.14 muestra la interfaz de diseño del nuevo PID, donde se 

puede apreciar las condiciones que se querían, tales como una mayor 

velocidad que el anterior, y un menor sobreimpulso. 

 

Fig 4.15 – Parámetros del PID. 

La figura 4.15 muestra los parámetros del PID, aunque se puede apreciar 

que pese a que el diseño que en principio era de un PID, se ha convertido 

en un PI, ya que la parte derivativa es nula. 
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Fig 4.16 – Resultados de la simulación con un PI. 

Los resultados obtenidos por el PI se muestran en la figura 4.16, se utiliza 

el mismo código de colores que en los anteriores casos. 

Tal y como se hizo con el primer PID se comprobará la forma de la señal 

de acelerador/freno que se aplicaría al motor, esta señal se puede ver en 

la figura 4.17. 
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Fig 4.17 – Señal de entrada al motor. 

Esta señal es muy similar a la obtenida con el PID rápido, y como se dijo 

es satisfactoria debido a su suavidad y ausencia de cambios bruscos. 

Por último se calcula el error cuadrático producido en la simulación, que 

en este caso es de 41,83, que es inferior al que resulto con el PID rápido, 

por lo tanto este último PI tiene unos resultados mejores que los 

obtenidos con otros PID. 

4.4 CONTROL POR  REALIMENTACIÓN DE ESTADOS 

4.4.1 Realimentación de estados típica 

El primer paso será comprobar la controlabilidad de nuestro modelo, 

realizando las comprobaciones necesarias se verifica que la matriz de 

controlabilidad es de rango 2, por lo tanto es completamente controlable 

y se podrá aplicar la realimentación de estados. 

También habrá que calcular las ganancias “K” y “L”, haciendo uso de la 

fórmula de Ackermann, para ello se necesita colocar los polos deseados. 

Para la ganancia de realimentación de estado se ha elegido un polo doble 
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en z = 0.9, y para la ganancia “L” del observador el polo será también 

doble pero en este caso en z = 0.5, lógicamente todos los polos están 

centro del circulo unidad para asegurar la estabilidad. Además, para el 

correcto funcionamiento del sistema se usan unos polos más rápidos para 

“K”.  

Por último se calcula la ganancia “K0” que hace que la señal de referencia 

esté dimensionada para que la realimentación de estados sea correcta, 

para el cálculo de estas ganancias se han aplicado las técnicas descritas 

en el apartado anterior “3 TÉCNICAS DE CONTROL”. 

Las ganancias obtenidas mediante matlab son:    [             ] 
   [            ]           

El modelo resultante en Simulink se puede ver en la figura 4.18. 

 

Fig 4.18-Bloques de Simulink para la realimentación de estados. 
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La ganancia de compensación es la situada en la entrada llamada “Gain3”, 

la ganancia de realimentación de estados es “Gain2”, y la matriz “L” está 

dentro del bloque “Observador. 

En la figura 4.19 se muestra el sistema de bloques para el observador, 

donde se puede ver la matriz “L” como la ganancia “Gain2”, el resto de 

las ganancias son las matrices que definen el sistema (A, B y C). 

 

Fig 4.19– Observador de estados. 

Como entrada del sistema llega una señal de referencia en unidades de 

velocidad, que será la velocidad deseada, en el caso de la simulación se 

ha puesto una señal con valores de velocidad a los que nuestro coche 

puede funcionar, además se ha puesto a propósito un descenso muy 

pronunciado de la velocidad para comprobar la capacidad de frenado. 

En la figura 4.20 se aprecia la señal de salida (velocidad) de tanto el 

observador como del modelo matemático del sistema, y la velocidad de 

referencia aplicada. 
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Fig 4.20– Resultados obtenidos con realimentación de estados. 

Se puede apreciar que el control es realmente bueno, con un tiempo de 

establecimiento menor de 5 segundos, y sin ningún sobre impulso, 

además el valor final es el deseado. 

La señal de entrada al motor se muestra en la figura 4.21. 
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Fig 4.21– Señal de entrada con realimentación de estados. 

En este caso la señal de entrada al motor generada también suave como 

con el PID. Además, se puede apreciar que la señal está saturada en 

ciertos puntos, aunque esto no supone un problema. 

A continuación, tal y como se hizo en el apartado del PID, se introducirá 

un bloque función de transferencia para suavizar la señal de referencia 

usada. 

Los resultados con esta configuración se muestran en la figura 4.22, en 

los cuales se utilizan los mismos colores que en anteriores ocasiones. 
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Fig 4.22– Resultados obtenidos con la referencia suavizada. 

 

Fig 4.23– Señal de entrada con la referencia suavizada. 

La figura 4.23 muestra la señal de entrada generada por el sistema de 

control. 
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Como se puede apreciar los resultados son los deseados, se ha añadido 

suavidad a la señal de entrada al motor, además en este caso solo se ha 

producido saturación en un punto, por lo que el funcionamiento es más 

adecuado. 

El valor obtenido del error cuadrático, tal y como se hizo en el apartado 

del PID, para la realimentación de estados típica, con la entrada 

suavizada es de 36,04. 

4.4.2 Realimentación de estados con un PI 

Otra forma más compleja para el control consiste en añadir un Integrador 

o un PI (en este caso se ha elegido un PI), para ello se crea una señal de 

error que será la diferencia entre la señal de entrada de la velocidad de 

referencia, y la señal de salida de la velocidad real, esta señal de error se 

lleva al PI que nos dará una señal que sería nuestra entrada en el sistema 

de realimentación de estados normal, en este caso la constante Ko 

utilizada en el caso anterior se puede eliminar e introducir en el PI. 

El sistema de bloques utilizado en Simulink se puede ver en la figura 

4.24. 

 

Fig 4.24 – Bloques de Simulink con realimentación con PI. 
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La señal de entrada es la misma que en el caso anterior, con escalones 

con amplitudes positivas y menores de 45 (Km/h), y también incluye una 

deceleración para tener un tiempo de frenada. 

El PI en este caso se ha regulado viendo los resultados de las 

simulaciones y cambiando los parámetros para ir convergiendo a 

resultados más satisfactorios. 

Tanto los parámetros del PI como la fórmula que lo define se pueden ver 

en la figura 4.25. 

 

Fig 4.25– Diseño del PI. 

Con este control los resultados obtenidos son mostrados en la figura 4.26, 

al igual que en apartados anteriores se muestra las velocidad del 

observador y del modelo del vehículo, y la velocidad de referencia de 

entrada. 
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Fig 4.26 – Resultados con realimentación con PI. 

Se puede apreciar que en la frenada la velocidad no parece estabilizarse 

en el valor deseado, lo cual es insatisfactorio, en las aceleraciones sin 

embargo el control es bueno. 

Los resultados son peores que con el control por realimentación de 

estados típico, el error cuadrático cometido es de 74,26, que es 

considerablemente superior a los conseguidos anteriormente. 

Como en anteriores apartados se comprobará la señal de entrada 

entregada al motor, esta señal se muestra en la figura 4.27. 
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Fig 4.27– Señal de entrada con realimentación con PI. 

Esta señal no es lo suficientemente suave para el objetivo que tienen, y 

además está demasiado saturada, por lo tanto el control no es óptimo. 

Como en el caso anterior se puede introducir un bloque función de 

transferencia para evitar los escalones muy pronunciados y mejorar las 

señales, los resultados obtenidos son los mostrados en la figura 4.28. 

 

Fig 4.28– Resultados con la referencia suavizada 
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Fig 4.29 – Señal de entrada con referencia suavizada. 

En la figura 4.29 se puede ver la señal de entrada generada cuando la 

señal de referencia ha sido suavizada. 

Se puede apreciar que los resultados se corresponden con lo esperado, 

incluso se elimina parcialmente el error que se producía en el frenado. 

La saturación de la entrada desaparece casi por completo y además la 

forma de la señal es más suave. 

Al igual que en el apartado anterior se calculara el error cuadrático, para 

obtener un valor objetivo de como de bueno es esta forma de control. En 

este caso el valor del error cuadrático medio es de 43,23. 

4.5 CONCLUSIONES 

Los resultados obtenidos con estas simulaciones son buenos, ya que se 

consigue que la velocidad llegue a un valor que es el deseado en un 

tiempo aceptable, que no es ni demasiado corto (lo que supondría 

grandes acelerones o frenadas) ni demasiado largo. 

De las opciones que se han comprobado mediante simulaciones las más 

satisfactorias son las de realimentación de estados, sobretodo la 
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realimentación de estados sin el PI que será la opción elegida para 

implementarse, una realimentación de estados con una ganancia para 

igualar el valor final con el deseado. 

Además el error cuadrático medio es ligeramente menor en la 

realimentación de estados típica, por lo tanto el control es mejor de esta 

forma. 

Esta opción elegida tiene muy buenos resultados en la simulación, no 

presenta sobreimpulsos, el tiempo de establecimiento es bueno, y la 

forma de la señal de entrada generada es suave. 
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5 MECANISMO DE FRENADO 

5.1 INTRODUCCIÓN A LOS SISTEMAS DE FRENADO 

El sistema de frenos de un vehículo tiene el objetivo de conseguir una 

rápida deceleración en el movimiento de este, para conseguirlo se realiza 

una fuerza que actúa en contra del movimiento, normalmente esta fuerza 

se efectúa generando un fuerte fricción en las ruedas y transformando la 

energía cinética que disponía el vehículo, en calor disipado en el 

ambiente. 

La mayor parte de los frenos por fricción se basan en el rozamiento entre 

dos superficies, una que forma parte del sistema de frenado, y otra que 

superficie que forma parte del eje o de las ruedas. También existen otros 

sistemas de frenado especiales, basados en la fricción aerodinámica, 

como pueden ser la utilización de un paracaídas, en aviones o coches que 

alcanzan grandes velocidades. 

 

Fig 5.1 – Avión con sistema de frenado con paracaídas. 
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En la figura 5.1 se puede ver un avión con un sistema de frenado por 

fricción un tanto especial, dado que utiliza la fricción de un paracaídas con 

el aire. 

En la conducción también es típico utilizar el llamado freno motor, 

variando la marcha es posible que el motor sea un mecanismo de 

frenado, aunque no tan eficaz como los de fricción. 

En vehículos eléctricos también es posible realizar un frenado con los 

llamados frenos electromagnéticos, que varían la excitación del  motor 

haciendo que este disminuya la velocidad. 

Otros tipos de frenos utilizados sobretodo en vehículos eléctricos son los 

regenerativos, que consiguen transformar la energía cinética en energía 

eléctrica, evitando así las pérdidas en formas de calor que tienen 

habitualmente los mecanismos de frenos. Esta energía eléctrica además 

se puede utilizar para otros sistemas del vehículo, lo cual resulta muy útil 

[13]. 

En la figura 5.2 se puede ver como sería el diseño de unos frenos 

regenerativos que aprovechan la energía de la frenada para crear energía 

eléctrica. 

 

Fig 5.2 – Dibujo de unos frenos regenerativos. 
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Un coche normal dispone de dos sistemas de frenos, el freno de servicio 

que se activa con el pedal central, y el freno de mano o freno de 

estacionamiento que habitualmente está colocado entre los dos asientos 

delanteros del coche. El freno de servicio utiliza un sistema de 

accionamiento hidráulico y tiene efecto sobre todos los frenos del coche, 

aunque con el reparto de frenada habitual los frenos delanteros tienen 

mayor potencia de frenado que los traseros. El freno de mano sin 

embargo utiliza un sistema de accionamiento mecánico por medio de unos 

cables, y solo tiene efecto en las ruedas traseras. 

Los sistemas de frenado son una parte muy importante de la seguridad de 

un vehículo, por ello la gran mayoría de los vehículos disponen de uno, y 

los que no tienen son vehículos especiales para pruebas o 

experimentación. 

5.2 TIPOS DE FRENOS 

Los dos mecanismos de frenos más utilizados en vehículos son los frenos 

de disco y los frenos de tambor, de los cuales se hablará a continuación, 

aunque también existen otros tales como los frenos de cinta, menos 

utilizados. 

5.2.1 Frenos de Disco 

Para utilizar este mecanismo de frenado, las ruedas tienen que disponer 

de un disco que gira solidariamente con ellas, cuando el freno es 

accionado, unas pastillas que están fijas (no giran) se cierran sobre el 

disco provocando una fricción. La superficie de las pastillas tiene un alto 

coeficiente de rozamiento para que su efecto sea mayor. 

Este rozamiento provoca la trasformación de la energía cinética en calor 

repartido en el disco y en las pastillas, que será disipado poco a poco en 

el ambiente debido al efecto de la convección con el aire. 
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Los frenos de disco tienen 4 elementos principales, el disco, las pastillas y 

las mordazas (o pinzas), y los pistones o cilindros. 

En la figura 5.3 se pueden ver separados los diferentes elementos que 

conforman unos frenos de disco, los pistones estarían situados en el 

interior de las pinzas. 

 

Fig 5.3 – Elementos principales de un freno de disco. 

El disco es el elemento con forma circular que gira solidariamente a la 

rueda, normalmente están realizados de acero, y pueden tener agujeros 

para aumentar la superficie en contacto con el aire y por tanto mejorar la 

disipación de calor. 

La función principal de las mordazas o pinzas es soportar las pastillas de 

freno, la correcta posición de las mordazas es muy importante, debido a 

que si están mal colocadas podrían ejercer rozamiento sobre el disco 

cuando no se desea, provocando un frenado constante y una considerable 

pérdida de energía continuamente. 

Las mordazas pueden ser de dos tipos, fijas o flotantes, en el caso de las 

fijas solo se mueven las pastillas para contactar con el disco, y en las 
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flotantes tanto la mordaza como las pastillas se mueven para conseguir 

ese contacto. 

Los pistones o cilindros se encuentran colocados en las mordazas y son 

los encargados de que las mordazas presionen las pastillas de frenos 

contra el disco, para ello son impulsados por el líquido de frenos del 

sistema hidráulico. Es importante que los pistones estén bien sellados 

para que no se pierda líquido de frenos. 

Las pastillas de freno tienen un alto coeficiente de fricción para que el 

frenado sea bueno, debido al uso estas pastillas se desgastan y es 

necesario cambiarlas cada cierto tiempo. Según sea el material por el cual 

estén compuestas tienen diferentes características, como la duración, 

disipación de calor, o la potencia de frenado. 

Existen 3 tipos de pastillas de freno según el material con el cual estén 

fabricadas, cerámicas (que destacan por su buen funcionamiento a altas 

temperaturas), orgánicas (tienen una alta calidad y un alto coeficiente de 

rozamiento), y metálicas (la duración de estas pastillas es mayor pero 

desprenden más calor que las otras). 

Los frenos de disco son los más utilizados en vehículos de calle, debido a 

su rápido funcionamiento y buena disipación del calor. 

En la figura 5.4 se puede ver una fotografía de una rueda de un vehículo 

deportivo con frenos de disco. 
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Fig 5.4 – Fotografía de unos frenos de disco. 

5.2.2 Frenos de Tambor 

Estos frenos consisten en un tambor que está conectado a la rueda y gira 

solidariamente con ella, y un mecanismo interior al tambor, con unas 

zapatas que al accionarse el freno se mueven y contactan con el tambor, 

provocando así la fricción que frena al vehículo. 

En la figura 5.5 se puede ver un esquema donde se indican como están 

dispuestos el tambor y las zapatas. 

 

Fig 5.5 – Esquema de unos frenos de tambor. 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 99 
 

El mayor problema de los frenos de tambor es que se generan altas 

temperaturas y tienen problemas de disipación de calor, por lo tanto al 

ser metálicos pueden deformarse y provocar un mal funcionamiento de 

los frenos. 

Los frenos de tambor tienen la ventaja de estar más protegidos contra el 

agua, barro u otros elementos, por lo tanto para algunas condiciones de 

funcionamiento pueden ser mejores. 

Habitualmente los frenos de tambor son utilizados en las ruedas traseras 

para ahorrar costes (son más baratos que los frenos de disco). Mientras 

que en las ruedas delanteras se utilizan frenos de disco por su mejor 

funcionamiento. 

 

Fig 5.6 – Fotografía del interior de un freno de tambor. 

En la figura 5.6 se puede ver una fotografía del interior de un freno de 

tambor, donde se pueden apreciar las zapatas (en dorado) y los muelles 

de los que dispone el mecanismo. 
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5.3 SISTEMA HIDRÁULICO 

El freno de servicio dispone de un sistema hidráulico de accionamiento 

para hacer conseguir que el vehículo frene cuando el conductor pulsa el 

pedal de freno. Este sistema consiste en un circuito de mangueras o tubos 

entre el pedal de freno y los frenos, a este circuito se le considera el 

circuido principal de frenos. 

El sistema es básicamente un amplificador de la fuerza que el conductor 

aplica sobre el pedal, transmitiéndola a los frenos para que ejerzan una 

fuerza en contra del movimiento de las ruedas. Su funcionamiento se 

basa principalmente en la transmisión de la presión en el interior de los 

conductos. 

En la figura 5.7 se puede ver un dibujo de cómo funciona básicamente el 

sistema hidráulico, y como actúa en unos frenos de disco y en unos frenos 

de tambor. 

 

Fig 5.7 – Esquema sencillo de un sistema hidráulico de frenos. 

Un sistema hidráulico dispone de varios elementos importantes, el 

primero de ellos es el pedal de freno, que es el elemento que está 

expuesto al conductor para que este le pulse cuando quiera frenar. 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 101 
 

El cilindro maestro, cilindro principal o bomba, es un cilindro colocado al 

comienzo del sistema hidráulico y que está conectado al pedal de freno, 

de forma que cuando el conductor pisa el pedal, un pistón se mueve en el 

interior del cilindro maestro impulsando el líquido de frenos que se mueve 

en dirección a los frenos. Dependiendo de la sección interior del cilindro la 

fuerza transmitida será mayor o menor. 

Además cerca del cilindro maestro se debe colocar un pequeño depósito 

que contiene líquido de frenos, para que en caso de pequeñas perdidas de 

líquido en el sistema, la potencia de frenada no se vea afectada y el 

sistema funcione adecuadamente. 

Otro elemento principal son las mangueras o tubos que trasmiten el 

líquido de frenos hasta los frenos situados en las ruedas, son una parte 

indispensable y dependiendo de su sección transmitirán diferentes 

fuerzas. 

Los últimos elementos son los propios frenos de los que ya se ha hablado 

anteriormente. 

Todos los vehículos están obligados además a disponer de unas luces en 

la parte posterior que se iluminen cuando se accionen los frenos, por lo 

tanto el sistema de frenos tiene que estar conectado a esta lámpara 

testigo. 

Los vehículos actuales llevan además dispositivos electrónicos que 

controlan el funcionamiento de todo para una mayor seguridad, como el 

sistema ABS, que evita el bloqueo de las ruedas. 
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Fig 5.8 – Sistema de frenos completo de un coche. 

En la figura 5.8 se puede ver un sistema de frenos más complejo y como 

está distribuido en un coche.  

5.4 FRENO DE ESTACIONAMIENTO 

El freno de estacionamiento o freno de mano forma parte del llamado 

circuito auxiliar de frenos, y que a diferencia del circuito principal no 

utiliza un sistema hidráulico, sino que habitualmente se acciona 

mecánicamente por medio de un cable. 

En la mayoría de los coches, al accionar la palanca del freno de mano el 

cable activa únicamente los frenos traseros, que inmovilizan el vehículo 

para que durante el estacionamiento el coche no se desplace. 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 103 
 

 

Fig 5.9 – Sistema de un freno de estacionamiento. 

En la figura 5.9 se muestra como es el circuito auxiliar de frenos, con los 

cables que van desde la palanca central, hasta los frenos de las ruedas 

traseras, ya sean de tambor o de disco. 
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6 HARDWARE 

6.1 CONTROLADOR CURTIS PMC 1268 

Este componente instalado previamente en el coche es el encargado de 

que la señal de entrada de acelerador que llega al motor eléctrico sea 

adecuada, para que no tenga grandes cambios bruscos u otros 

problemas. Además esta controladora crea unas señales para tanto la 

armadura del motor eléctrico, como para la inductancia de magnetización 

que excita al motor. 

 

Fig 6.1 – Controladora Curtis PMC. 

La figura 6.1 muestra una fotografía de la controladora de la que dispone 

el vehículo experimental. 

Tal y como se puede apreciar en la figura 6.1, la controladora tiene 3 

entradas de baja corriente, una de 24-pin que se utiliza para la entrada 

de las señales de control, una de 6-pin, la cual está conectada con un 

sensor “Hall” de velocidad, para conocer la velocidad a la que gira el 

motor, y otra de 4-pin que se usa para cambiar los parámetros con los 

que hace el control. Estas conexiones en el centro de la parte superior de 

la controladora. 
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En la figura 6.2 podemos ver cómo están hechas las conexiones en 

nuestro vehículo. 

 

Fig 6.2 – Fotografía de la controladora en el vehículo. 

También dispone de 5 conexiones de alta corriente, las cuales son las de 

la batería, las de la armadura del motor (batería y armadura comparten la 

conexión de nivel alto de tensión), y las de la excitación del motor.  

Existen varias formas para hacer llegar a la controladora la señal de 

aceleración, de las cuales se tendrá que escoger una, básicamente se 

podrá elegir entre crear niveles de tensión entre 0 y 5 Voltios, o crear una 

impedancia de entrada entre 0 y 5 kΩ. En nuestro caso se ha elegido la 

primera opción, ya que con la tarjeta de adquisición de datos (de la cual 

se hablará posteriormente) tenemos la opción de obtener una señal 

analógica que tenga ese rango de tensiones. 
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La señal de salida de la controladora hacia la armadura del motor tendrá 

un rango de tensión entre 0 y 48 Voltios, dado que el motor del que se 

dispone tendrá un valor máximo de tensión de 48 Voltios. 

 

Fig 6.3– Típica configuración del cableado. 

La figura 6.3 muestra un esquema con las conexiones que se deben 

realizar para el correcto funcionamiento de la controladora. 

Se pueden modificar hasta 46 parámetros distintos para los posibles 

funcionamientos deseados, los parámetros pueden estar relacionados con 

la aceleración, el frenado, las corrientes que atraviesan el motor, la 

velocidad, etc… 

Uno de los más importantes es el tiempo de aceleración del 0% al 100%, 

que será entre 0.1 y 5 segundos. Este es la forma de bloquear los 

grandes cambios en la señal de entrada, creando una señal en forma de 

rampa ascendente desde el valor inferior hasta el valor máximo. 
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Otro parámetro similar es el de la deceleración, que establece el tiempo 

mínimo en el que la tensión en el motor puede bajar del 100% al 0%, 

algo que no se debe confundir con el tiempo de frenado. 

La velocidad máxima (en funcionamiento normal o marcha atrás) también 

es establecida como un parámetro, y además, para que la controladora 

tenga una referencia valida de la velocidad, habrá que introducirle un 

parámetro para que convierta las RPM que obtiene del sensor, a las 

unidades de velocidad deseadas, en este caso km/h. 

Además se dispone de 2 modos de funcionamiento, los cuales tendrán 

distintos valores para los parámetros más importantes, lo cual hace que 

podamos funcionar con diferentes parámetros sin necesidad de estar 

cambiándolos constantemente, en caso de que cambien las condiciones 

de funcionamiento. 

Existe también un tercer modo para algunos parámetros que sería un 

modo reservado para la marcha atrás. 

Para modificar los parámetros hará falta una consola o programador, en 

este caso el 1311 que es el asociado a este modelo de controlador, y 

como se ha comentado anteriormente irá conectado a la conexión de 4-

pin del controlador, en los puertos J3 según la figura 6.3. 

En la figura 6.4 se puede ver una imagen del programador, con los 

botones de los que dispone para seleccionar los parámetros y cambiar sus 

valores. 
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Fig 6.4 – Programador 1311. 

En lo que respecta al sensor de velocidad, la controladora espera una 

señal de pulsos que normalmente tiene 4 pulsos por cada revolución del 

motor, esto significa que el motor debe de tener 8 polos. También es 

posible cambiar esta configuración, para poder utilizar un motor o sensor 

diferente, programando la controladora. 
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Fig 6.5 – Dimensiones de la controladora. 

En la figura 6.5 se muestra una imagen con todas las dimensiones de la 

controladora instalada en el coche. 

6.2 MOTOR ELÉCTRICO 

El motor del que dispone el vehículo es un motor de corriente continua de 

4,3 kW, con una tensión máxima de funcionamiento de 48 Voltios. Este 

motor es del tipo brushless (sin escobillas) y tiene una excitación de tipo 

Shunt. Además la potencia del motor esta aplicada al eje delantero, por lo 

tanto el vehículo será de tracción delantera. 

En la figura 6.6 se puede ver una fotografía del motor del vehículo, con 

una etiqueta con los datos. 
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Fig 6.6 – Fotografía del motor eléctrico del vehículo. 

El motor eléctrico es un dispositivo que transforma la energía eléctrica en 

energía mecánica por medio de la acción de los campos magnéticos 

generados en sus bobinas. Son máquinas eléctricas rotatorias compuestas 

por un estator y un rotor. 

Algunos motores además pueden funcionar de manera inversa y 

transformar la energía mecánica en energía eléctrica, se dice que 

funcionan como generadores o en modo generador, esto es muy útil en 

vehículos para poder recargar las baterías utilizando la energía cinética o 

potencial que se gana en el movimiento del vehículo, esta característica 

se utiliza especialmente en vehículos híbridos. 

Se dividen en dos grandes tipos: motores de corriente continua y motores 

de corriente alterna. Los motores de corriente alterna se utilizan 

normalmente para aplicaciones de mayor potencia, y se dividen en 

motores síncronos y motores asíncronos. 
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 Motor asíncrono o motor de inducción: Este motor utiliza un campo 

magnético rotatorio en el estator que gira alrededor del eje del 

motor, el rotor es sensible al magnetismo provocado en el estator y 

se mueve siguiendo el campo magnético, pero a una velocidad 

ligeramente menor que el campo, de ahí que se llamen motores 

asíncronos. 

 Motor síncrono: En este caso el motor funciona a la velocidad de 

sincronismo, la velocidad del campo rotario del estator. Esta 

velocidad depende de la frecuencia de la corriente y del número de 

polos que tenga el motor.  

Los tipos de motores de corriente continua que utilizan un devanado 

inductor para crear el campo magnético se clasifican según como se 

dispone la excitación del bobinado, pueden ser en serie, en paralelo 

(Shunt), o compuesto (Compound). Según qué conexión se use el 

funcionamiento del motor tiene unas características u otras. 

 Motor serie: Como es una conexión en serie la armadura del motor 

y el devanado inductor tienen la misma corriente pasando a través 

de ellos. En un motor en serie el flujo por polo depende de la 

corriente en la armadura y, por consiguiente, de la carga. Los 

motores en serie son utilizados para aplicaciones que requieran un 

alto par de arranque, ya que funcionan con un gran par a 

velocidades bajas. En vehículos es de gran uso porque por el motor 

se desacelera cuando el vehículo sube una cuesta, pero funciona a 

gran velocidad cuando el terreno es plano. 

 
Fig 6.7– Esquema de conexión de un motor eléctrico en serie. 

 La figura 6.7 muestra como es la conexión de un motor serie. 
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 Motor en paralelo o Shunt: En este caso la corriente por la 

armadura y la corriente por el devanado inductor son 

independientes, la carga no afecta a la excitación. Para mejorar el 

funcionamiento cuando la carga cambia habría que implementar un 

reóstato en serie con el devanado inductor para poder controlar la 

corriente que pasa por la excitación. En general el par de arranque 

es inferior al de un motor en serie, y la velocidad apenas varía con 

la variación de carga. Por ello el motor shunt se suele utilizar en 

aplicaciones donde la velocidad es relativamente constante o se 

necesita un rango amplio de velocidades. 

 

Fig 6.8 – Esquema de conexión de un motor Shunt. 

La figura 6.8 muestra un motor Shunt conectado correctamente. 

 Motor compuesto o Compound: Este motor tiene tanto un campo 

en serie como un campo en paralelo, la fuerza magnetomotriz de 

ambos campos se suma. Cuando la carga aumenta, la corriente por 

el campo en serie aumente, pero no la corriente del campo 

paralelo, y la fuerza magnetomotriz es mayor con carga que sin 

carga. 

Esto provee una característica de velocidad que no es tan “dura” o 

plana como la del motor Shunt, ni tan “suave” como la de un motor 

serie. Los motores de corriente continua Compound son algunas 

veces utilizados donde se requiera una respuesta estable de par 

constante para un rango de velocidades amplio. 

También puede invertirse el devanado en serie para crear un 

campo compuesto diferencial, que disminuye la fuerza cuando 

aumenta la carga, pero esta forma tiene pocas aplicaciones. 
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Fig 6.9 – Esquema de conexión de un motor Compound. 

En la figura 6.9 se puede ver como es la conexión de un 

motor Compound. 

Además de estos tres tipos de conexión también existen motores 

llamados de excitación independiente en los que la corriente por el 

bobinado y por la armadura del motor son independientes. 

Para motores más pequeños también pueden utilizarse imanes 

permanentes para crear el campo magnético que excite a motor, pero la 

potencia de estos imanes es pequeña, por lo tanto la potencia de estos 

tipos de motores es inferior a los que utilizan inducción electromagnética 

[9]. 

6.3 POTENCIOMETRO DEL PEDAL DEL ACELERADOR 

El pedal del acelerador que se encuentra en el vehículo, está conectado a 

un potenciómetro, que según el pedal este más o menos pulsado 

generará una señal eléctrica. Esta señal es la que va directamente a la 

controladora. 

Evidentemente el vehículo ya dispone de este elemento dado que viene 

con el instalado. 
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Fig 6.10 – Fotografía del potenciómetro. 

En la figura 6.10 se puede ver una fotografía del potenciómetro instalado 

en el vehículo, que está directamente conectado al pedal del acelerador. 

6.4 SENSOR DE EFECTO HALL 

El sensor que se utilizara será un “Allegro” tipo “UGN3132”, se basa en el 

llamado efecto Hall, y funciona detectando variaciones del campo 

magnético cercano a él, cada variación significa que un polo del motor 

eléctrico ha pasado y entonces el sensor lo traduce en un evento en la 

señal de pulsos, es decir, cada dos polos significaran un pulso, y 

dependiendo del número de polos del motor, habrá más o menos pulsos 

por cada revolución. 
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Fig 6.11 – Sensor efecto Hall. 

En la figura 6.11 se muestra como está realizado de forma básica un 

sensor de efecto Hall. 

Este sensor dispone de 3 conexiones, una para la entrada de tensión para 

que el dispositivo pueda funcionar (El suministro de tensión para que el 

dispositivo funcione tiene que ser de entre 4.5 y 24 Voltios), una señal de 

tierra para referenciar, y la señal de salida de pulsos que se utilizara para 

medir la velocidad. 

 

Fig 6.12– Esquema funcional del sensor. 

En la figura 6.12 se muestra el esquema funcional del sensor que se 

utilizará. 
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6.5 TARJETA DE ADQUISICION DE DATOS 

La tarjeta de adquisición de datos (DAQ) que se utilizara será una “NI 

USB-6009” de National Instruments, esta tarjeta dispone de 32 

conexiones las cuales se dividen la mitad en señales digitales y la otra 

mitad en señales analógicas, también se reparten las conexiones entre 

terminales de entrada y salida, además, se conecta a una computadora 

mediante una conexión USB típica, gracias al cable USB que viene incluido 

con la tarjeta. 

 

Fig 6.12– Tarjeta de adquisición de datos NI USB-6009. 

En la figura 6.12 se puede ver una fotografía de la tarjeta de adquisición 

de datos NI USB-6009, donde los puertos están situados a derecha e 

izquierda, unos son los puertos analógicos, y otros los digitales. 

El cometido de esta DAQ es ser el paso intermedio entre la computadora 

y el coche, transformando las señales digitales de la computadora a 

señales analógicas necesarias para el vehículo (tensión de entrada entre 0 

y 5 Voltios para la controladora por ejemplo, o la señal para la bomba 

hidráulica de los frenos.), y transmisión de datos realimentados como la 

velocidad del motor para así comprobar el correcto funcionamiento del 

vehículo. 

En la figura 6.14 se pueden ver todas las conexiones de las que dispone 

la tarjeta, y a continuación se describirán todas sus funciones. 
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Fig 6.14– Conexiones de la NI USB-6009. 

Respecto la parte analógica, la tarjeta dispone de hasta 8 canales de 

entrada, los cuales pueden ser utilizados como entradas referenciadas a 

tierra, o 4 canales para medir las diferencias entre 2 entradas. Dispone 

además de 2 canales de salida referenciados a una tierra común entre 

ellos. La resolución de esta tarjeta es de 13 bits para las entradas 

simples, y 14 bits para las entradas diferenciales. 

Y respecto la parte digital dispone de 12 canales configurables para servir 

tanto de entrada como de salida, y un canal que se puede utilizar como 

disparador digital o como contador de 32 bits. 

Este contador se utilizara como contador de pulsos para medir la 

velocidad del motor con el sensor de efecto Hall. 

6.6 SISTEMA DE SELECCIÓN MANUAL-AUTOMÁTICO 

Por seguridad no se debe eliminar la posibilidad del control manual del 

vehículo como si de un vehículo normal se tratara, para ello se tiene que 

diseñar un sistema para que ambos mecanismos puedan funcionar 

aunque no de forma simultánea. 

Para ello se ha decidido utilizar un conmutador simple de 3 polos, de 

accionamiento manual, que se colocara en el salpicadero del coche de 

forma que sea de fácil acceso para los ocupantes del vehículo. 
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Fig 6.15 – Ejemplo de un conmutador simple de 3 polos. 

En la figura 6.15 se muestra una fotografía de un conmutador de 3 polos 

que se puede encontrar en cualquier tienda de electrónica. 

De esta forma, en caso de un mal funcionamiento del sistema en un 

momento dado, se podrá desactivar el acelerador automático  para evitar 

una colisión o cualquier otro problema, aumentando de esta forma la 

seguridad del vehículo. 

Se utilizara el polo común como salida de la señal que ira directamente a 

la controladora Curtis, y los otros dos polos serán los del potenciómetro 

del pedal del acelerador para la conducción manual, y la señal generada 

por el programa y que viene de la tarjeta de adquisición. 

En la figura 6.15 se puede ver un esquema simple de como estarán 

conectados la tarjeta de adquisición de datos, el potenciómetro del que 

dispone el pedal del acelerador en el coche, y la controladora que recibe 

una de las dos señales. 
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Fig 6.16 – Esquema de conexiones del selector Manual-Automático. 

Otra opción que se podría haber llevado a cabo pero se descartó por 

cuestiones de seguridad, sería la utilización de un conmutador controlado 

por tensión, o un relé, que mantendría la señal que proviene de la tarjeta 

como la señal que llega a la controladora, a menos que se pise el pedal 

del acelerador, en este caso la señal que actuaría sería la del 

potenciómetro del pedal. 

Esta opción conlleva que el conductor tenga menos control en caso de 

emergencia, dependiendo más del sistema. Además la dificultad de la 

implementación es mayor y por lo tanto existen más posibilidades de 

fallo, por estas razones se escogió llevar a cabo la primera idea. 

6.7 SISTEMA DE FRENOS 

Nuestro vehículo dispone de un sistema de frenos habitual como del que 

se habló en el apartado “5 MECANISMO DE FRENADO”, para este proyecto 

será necesario modificarlo para que el sistema de control diseñado tenga 

efecto sobre el sistema de frenos también. 

Para traducir la señal eléctrica que nos dará el sistema de control en una 

presión en el circuito de frenos, se utilizara una bomba electrónica, la cual 

se elegirá en función de la potencia necesaria. 

Lo más complejo de será conseguir hacer funcionar el circuito hidráulico 

con ambas formas de accionamiento (bomba electrónica y pedal de 
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freno), ya que como se ha comentado será necesario por seguridad 

mantener la acción manual de frenado. 

Para hacer eso se ha decidido colocar la bomba electrónica en paralelo a 

la bomba del sistema original de frenos, y unir ambas mediante una 

válvula especial en forma de “T” que hace que puedan funcionar ambas 

formas de accionamiento a la vez. 

Esta válvula dispondrá de una membrana o una bola que se moverá para 

dejar el paso libre a uno de los dos conductos de “entrada”, a cuál de los 

dos conductos deje paso dependerá de la relación de presiones que estén 

ejerciendo en ese momento, de forma que tenga prioridad el 

accionamiento mediante el pedal de freno. 

 
Fig 6.17 – Esquema del nuevo sistema de frenos. 

En la figura 6.17 se muestra como sería la configuración del circuito de 

frenos una vez realizada la modificación, donde a partir de la válvula 

instalada, el circuito seria el mismo que antes. 
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6.7.1 Bomba electrónica 

Respecto a la bomba electrónica que será elegida para nuestro sistema 

deberá tener unas condiciones de presión máxima similares a las de la 

bomba mecánica que acciona el pedal de freno. 

De un experimento anterior se conoce que la bomba mecánica ejerce 

sobre el circuito una presión máxima de 50 kg/cm2, que equivalen a unos 

50 bares de presión. 

Por lo tanto la bomba a instalar deberá ejercer una presión máxima 

similar a los 50 bares que tiene la bomba mecánica, para evitar 

problemas se elegirá una presión máxima superior. 

Se han buscado electrobombas de poco tamaño para que puedan ser 

instaladas en el vehículo, la mejor opción se ha encontrado en el catálogo 

de HAWE HYDRAULIK. La serie NPC es una central hidráulica compacta  

ideada para ser fácilmente transportable, funciona con corriente continua 

y es para trabajos de corta duración. 

Como este tipo de bombas pueden alcanzar unos 700 bares de presión, 

no se necesitara la de mayor potencia, y de hecho la presión máxima que 

podrá ejercer la bomba elegida será mayor de la necesaria, por lo tanto 

nunca se trabajara a la máxima potencia. 

 



Sistema de control longitudinal para vehículo eléctrico urbano 
 

Daniel López Montes Página 122 
 

 

Fig 6.18 – Central hidráulica compacta NPC de Hawe Hydraulik. 

En la figura 6.18 se puede ver una fotografía de la electrobomba que se 

utilizará. 

Esta bomba dispone de varias opciones y tamaños, como la aplicación que 

se le dará no necesita de su máxima potencia, se elegirá un modelo más 

pequeño que se acerque a nuestras necesidades. 

 

Fig 6.19 – Tabla de características de la serie NPC. 

En la figura 6.19 se muestra las posibilidades de modelos que se tienen, 

la NPC 11 y la NPC 12 con sus diferentes tamaños, como todas tienen 
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mayor presión máxima que la necesaria se escogerá la mayor, es decir la 

NPC 11 /1,05. 

El modelo NPC 11 tiene una potencia nominal aproximada de 0,3 kW, 

mientras que el NPC 12 tiene el doble. 

Se puede elegir una bomba con una válvula regulable de presión, para 

que nunca sobrepase los 70 bares. Además se tiene más opciones como 

la tensión de alimentación o si necesita válvula retorno o no. 

El modelo elegido será el NPC 11 /1,05 - 2/190 – R – 24, que tiene 

una tensión de alimentación de 24V. 

 

Fig 6.20 – Curvas de corriente y de caudal. 

En la figura 6.20 se muestran en un mismo gráfico las curvas de corriente 

y de caudal.  

En la figura 6.21 se muestra el esquema hidráulico de le electrobomba 

utilizada. 
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Fig 6.22 – Esquema hidráulico de la central hidráulica compacta NPC. 

En la figura 6.22 se pueden ver los planos de la electrobomba con todas 

las dimensiones. 

 

Fig 6.22 – Dimensiones de la central hidráulica compacta NPC 
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6.7.2 Válvula direccional 

La válvula que necesitaremos será una válvula 3/2 (de 3 vías y 2 

posiciones), las vías serán la de salida que va a los frenos, y las 2 de 

entrada, una para la bomba electrónica, y otra para el accionamiento 

manual del pedal de freno. 

Las dos posiciones serán la posición para el control electrónico o para el 

control manual, y se seleccionaran dependiendo de si el pedal de freno 

está siendo pulsado o no, por tanto el accionamiento será hidráulico. 

La válvula elegida también será de HAWE HYDRAULIK, y será de la serie 

BVG, que tiene modelos de 2 vías o de 3 vías. El modelo elegido será el 

BVG 3 Z – H. 

 

Fig 6.22 – Válvula BVG de 2/2. 

En la figura 6.22 se puede ver una imagen de una válvula de la serie BVG 

del catálogo de HAWE HYDRAULIK, mientras que en la figura 6.23 se 

muestra el esquema hidráulico de una válvula de 3 vías y 2 posiciones 

como la utilizada. 
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Fig 6.23 – Esquema hidráulico de una válvula 3/2. 

En nuestro caso la vía C que es la común será conectada al circuito 

hidráulico que va hacia los frenos, mientras que las vías A y B serán 

conectadas indistintamente a las bombas, una a la electrobomba, y la 

otra a la bomba del sistema hidráulico original. 

 

Fig 6.24 – Dimensiones de la válvula BVG Z con accionamiento eléctrico. 

En la figura 6.24 se muestran los planos de la válvula de 3 vías de 

accionamiento eléctrico. Mientras que en la figura 6.25 se muestra el 

detalle de cómo sería el accionamiento hidráulico. 
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Fig 6.25 – Accionamiento hidráulico de la válvula. 
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7 CÁLCULOS 

7.1 IDENTIFICACIÓN DEL MODELO DEL VEHÍCULO 

Para realizar la identificación habrá que construir 2 matrices, que 

formaran parte de un sistema de ecuaciones que se resolverá para 

obtener la matriz de coeficientes, tal y como se explicó en el apartado 

“3.1 Identificación de sistemas”. 

La primera matriz, que llamamos “Y” se construirá utilizando los valores 

obtenidos de la velocidad en los distintos momentos de la toma de datos: 

  ൮       ) 

Y la segunda matriz “Z”, incluirá además datos de la señal de 

acelerador/freno que denominaremos “AcBr”. 

  ൮                                     ) 

El sistema a resolver será: 

൮       )  ൮                                     )ቌ ሺ ሻ ሺ ሻ ሺ ሻቍ 

Obteniendo así el vector X con los coeficientes de la función de 

transferencia del sistema identificado.  

Para resolver el sistema se ha utilizado matlab, habiendo construido ya 

las matrices “Y” y “Z” se utiliza el comando “X=Z\Y” que resuelve el 

sistema y nos da los valores de X. 

  (                    ) 
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7.2 VELOCIDAD MEDIDA POR EL SENSOR DE EFECTO 

HALL 

Tal y como se dijo en la sección de Hardware, el sensor de efecto hall 

mide las variaciones magnéticas del motor para calcular su velocidad, su 

señal de salida consistirá en una señal con pulsos cuya frecuencia 

dependerá de la velocidad a la que vaya el motor. Se deben hacer 

algunos cálculos para pasar de la señal de pulsos a un valor de la 

velocidad. 

El motor eléctrico es de 4 polos, es decir, que cada vuelta completa del 

motor, significara una señal pulsante con 2 valores altos y 2 bajos, con 

una amplitud igual si el motor funciona a velocidad constante, y una 

amplitud muy similar si el motor está acelerando o desacelerando. 

 

Fig 7.1 – Pulsos producidos por una vuelta del motor. 

En la figura 7.1 se puede ver cómo sería una señal de pulsos que podría 

darnos el sensor. 

Por lo tanto una revolución del motor significa 2 periodos de la señal de 

pulsos. 

La velocidad angular de las ruedas será entonces: 
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Debido a que el vehículo eléctrico no es muy potente vamos a suponer 

que el deslizamiento entre los neumáticos y el asfalto es nulo, y por lo 

tanto la velocidad de las ruedas es la misma que la velocidad del vehículo. 

Por lo tanto, si pasamos de velocidad angular a velocidad lineal tenemos 

que:       

Siendo “R” el radio de las ruedas delanteras, que es de 20 cm. 

Sustituyendo la primera ecuación en la segunda se obtiene: 

       

Con esta ecuación podemos pasar directamente del periodo de los pulsos 

obtenido con el sensor Hall, a la velocidad del vehículo, únicamente 

necesitando el valor del radio de las ruedas delanteras. 

Por ejemplo para una velocidad de 30 km/h, se tiene que:                    

                               
De la misma forma para unas velocidades de 5km/h o de 50km/h:     ⁄               ⁄           
Por lo tanto para el rango de velocidades del coche, el periodo de los 

pulsos del sensor estará comprendido entre 0.1 segundos para 

velocidades bajas, y 0.007 segundos para velocidades altas, 

aproximadamente. 
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ANEXO 1 

CODIGO MATLAB PARA LAS SIMULACIONES 

Utilizando el editor de ficheros de matlab, creamos un fichero “.m” en el 

cual introducimos todos los comandos necesarios para realizar todas las 

simulaciones que hicimos. En este apartado se copiara dichos comandos y 

se explicaran las funcionalidades de cada comando. 

En verde estás los comentarios aclaratorios, y en negro los comandos que 

se ejecutarán con el fichero. 

clear; close all; clc; % Comandos para reiniciar datos 

  

% Parámetros necesarios para el modelo 

m=500; % Masa 

g=9.81; % Gravedad 

R=0.2; % Radio de las ruedas 

J=0.5; % Momento de inercia de las ruedas 

Cf=0.1; % Coeficiente de fricción 

ro=1.23; % Densidad del aire 

Av=1.5; % Área expuesta al viento 

Cd=0.29; % Coeficiente aerodinámico 

Cr=0.01; %Coeficiente de rodadura 

lr=1; % Distancia eje trasero – centro 

lf=1; % Distancia eje delantero – centro 

H=0.5; % Altura del centro de gravedad 

L=lf+lr; % Distancia entre ejes 

B=10; % Coeficiente B de Pacejka 

C=1.9; % Coeficiente C de Pacejka 

D=1; % Coeficiente D de Pacejka 

E=0.97; % Coeficiente E de Pacejka 

th=0; % Pendiente de la carretera 

Vw=0; % Velocidad del Viento 

Pf=m*g*(lr*cos(th)+H*sin(th))/L; % Peso inicial rueda delantera 

Pr=m*g*(lf*cos(th)-H*sin(th))/L; % Peso inicial rueda trasera 
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alpha=0.01; %Aceleración angular 

Kbf=10; %Coeficiente freno delantero 

Kbr=5; %Coeficiente freno trasero 

N=1; %Relación De W entrada-salida 

Re=10; %Resistencia Armadura Motor 

L=1; %Inductancia Armadura Motor 

Kt=40; %Constante Par Electromagnético 

Kb=0.3; % Constante Fuerza Contra Electromotriz 

  

 

%Entradas 

vin=0.2; %Valor inicial de la velocidad (No puede ser 0 porque el modelo no funciona 
 bien si no hay velocidad) 

V0=48; % Ganancia para la tensión necesaria en el motor 

 

%Simulación 

ts=1e-3; % Periodo de muestreo del modelo. 

ts2=0.1; % Periodo de muestreo de los sistemas que se implementaran 

tfin=60; % Tiempo de simulación 

tol=1e-3; % Tolerancia de la simulación 

sim('Modelo'); 

t=v(:,1);wf=v(:,3);v=v(:,2); s=s(:,2); AcBr=AcBr(:,2); % Se crean matrices en matlab 
para guardar los datos 

figure(1) 

subplot(2,1,1); plot(t,v,t,wf); % Grafica con la velocidad del vehículo y de las ruedas 

subplot(2,1,2); plot(t,s); % Grafica con las distancia recorrida 

  

%Identificación del Modelo 

%Se crea la función de transferencia y el espacio de estados tal y como se explicó en el 
apartado “Técnicas de control” 

Y=v(3:end);Z=[v(2:end-1) v(1:end-2) AcBr(2:end-1)]; 

X=Z\Y; 

Gm=tf([X(3) 0],[1 -X(1) -X(2)],ts2) 

A2=[0 1;X(2) X(1)];B2=[0;1];C2=[0 X(3)];D2=[0]; 

Gss=ss(A2,B2,C2,D2) 
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[Num,Den]=tfdata(Gm,'v'); % Se calculan el numerador y el denominador de la función 
de transferencia 

pole(Gm) % Se calculan los polos del sistema 

 

% A continuación hay otra forma de realizar la identificación con comandos de matlab 
que se podría utilizar 

% data=iddata(v,AcBr,ts2); 

% Gss=ssest(data,2,'Ts',ts2,'form','canonical') 

% A2=Gss.a;B2=Gss.b;C2=Gss.c; 

% gmodel = ss(A2, B2, C2, Gss.d, ts2) 

% u = AcBr; 

% lsim(gmodel,u,t); hold on; 

% plot(t,v,'r'); 

 

%Simulacion del PID 

sim('modeloPID'); 

t=vmodel(:,1);v1=vmodel(:,2);v2=vmodel(:,3); % Se guardan los datos en matrices 

figure(2) 

plot(t,v1,t,v2) %Se dibuja la velocidad resultante del modelo “real” y del modelo de 
estados 

  

%Simulacion con Realimentacion de estados 

Mc=ctrb(A2,B2);RangoMc=rank(Mc) % Cálculo de la controlabilidad 

Mo=obsv(A2,C2);RangoMo=rank(Mo) % Cálculo de la observabilidad 

z1=[0.9 0.9]; z2=[0.5 0.5]; % Polos para el sistema y para el observador 

Ka=acker(A2,B2,z1) % Cálculo de la matriz K por Ackermann 

 

%Cálculo de la ganancia para igualar el valor final, tal y como se explicó en el apartado 
 “Técnicas de control”: 

syms z K1 

A3=A2-B2*Ka;B3=B2*K1; 

G=C2*inv(z*eye(2)-A3)*B3; 

K0=double(limit(K1/G,z,1)) 

La=acker(A2',C2',z2)' % Cálculo de la matriz L por Ackermann 

sim('ModeloEstados'); 
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Los parámetros que no se encuentren establecidos en el anterior código 

estarán en los ficheros de Simulink, como por ejemplo los valores del PID 

o el PI para la realimentación de estados. 
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ANEXO 2 
HOJAS DE CARACTERISTICAS 

  



These Hall-effect switches are designed for magnetic actuation using
a bipolar magnetic field, i.e., a north-south alternating field.  They
combine extreme magnetic sensitivity with excellent stability over
varying temperature and supply voltage.  The high sensitivity permits
their use with multi-pole ring magnets over relatively large distances.

Each device includes a voltage regulator, quadratic Hall voltage

generator, temperature stability circuit, signal amplifier, Schmitt trigger,
and open-collector output on a single silicon chip.  The on-board regula-
tor permits operation with supply voltages of 4.5 to 24 V.  The switch
output can sink up to 25 mA.  With suitable output pull up, they can be
used directly with bipolar or MOS logic circuits.

The three package styles available provide a magnetically optimized

package for most applications.  Suffix ‘LT’ is a miniature SOT-89/TO-
243AA transistor package for surface-mount applications; suffixes ‘U’,
and ‘UA’ feature wire leads for through-hole mounting.  Prefix ‘UGN’
devices are rated for continuous operation over the temperature range of
-20°C to +85°C, prefix ‘UGS’ devices over an extended range of -40°C
to +125°C, and prefix ‘UGL’ devices over the range of -40°C to +150°C.

ULTRA-SENSITIVE BIPOLAR

HALL-EFFECT SWITCHES

FEATURES

■ 4.5 V to 24 V Operation

■ Reverse Battery Protection

■ Superior Temperature Stability

■ Superior Supply Voltage Stability

■ Activate with Multi-Pole Ring Magnets

■ Solid-State Reliability

■ Small Size

■ Constant Output Amplitude

■ Resistant to Physical Stress

D
a
ta
 S
h
e
e
t

2
7
6
3
1
.2
B

ABSOLUTE MAXIMUM RATINGS

Supply Voltage, VCC . . . . . . . . . . . . .  25 V

Reverse Battery Voltage, VRCC . . . .  -35 V

Magnetic Flux Density, B . . . .  Unlimited

Output OFF Voltage, VOUT . . . . . . . .  25 V

Continuous Output Current, IOUT .  25 mA

Operating Temperature Range, TA

Prefix UGL . . . . . . .  -40°C to +150°C

Prefix UGN . . . . . . . .  -20°C to +85°C

Prefix UGS . . . . . . .  -40°C to +125°C

Storage Temperature Range,

TS . . . . . . . . . . . . . . .  -65°C to +150°C
Always order by complete part number

including prefix and suffix, e.g.,  UGN3132LT  .

Pinning is shown viewed from branded side.

3132 AND

3133

Dwg. PH-003A

1

S
U

P
P

L
Y

V
CC

G
R

O
U

N
D

32

O
U

T
P

U
T

X



3132 AND 3133

BIPOLAR

HALL-EFFECT SWITCHES

115 Northeast Cutoff, Box 15036

Worcester, Massachusetts 01615-0036  (508) 853-5000

FUNCTIONAL BLOCK DIAGRAM

VCC

X

REG.

Dwg. FH-005-2

GROUND

OUTPUT3

2

1

Limits

Characteristic Symbol Test Conditions Min. Typ. Max. Units

Supply Voltage VCC Operating 4.5 — 24 V

Output Saturation Voltage VOUT(SAT) IOUT = 20 mA, B ≥ BOP — 145 400 mV

Output Leakage Current IOFF VOUT = 24 V, B ≤ BRP — <1.0 10 µA

Supply Current ICC VCC = 24 V, B ≤ BRP — 4.3 9.0 mA

Output Rise Time tr VCC = 12 V, RL = 820 Ω, CL = 20 pF — 0.04 2.0 µs

Output Fall Time tf VCC = 12 V, RL = 820 Ω, CL = 20 pF — 0.18 2.0 µs

Limits

Characteristic Symbol Device Type* Min. Typ. Max. Units

Operate Point BOP 3132 — 32 95 G

3133 — 32 75 G

Release Point BRP 3132 -95 -20 — G

3133 -75 -20 — G

Hysteresis Bhys Both 30 52 — G

NOTE: As used here, negative flux densities are defined as less than zero (algebraic convention.)

Typical values are at TA = +25°C and VCC = 12 V.

       * Complete part number includes a prefix denoting operating temperature range (UGL, UGN, or UGS)

and a suffix denoting package type (LT, U, or UA).

ELECTRICAL CHARACTERISTICS at TA = +25°C

MAGNETIC CHARACTERISTICS over operating temperature and voltage range.

Copyright © 1996,1999, Allegro MicroSystems, Inc.
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TYPICAL CHARACTERISTICS
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SUFFIX “U” SUFFIX “UA”

0.043"
1.09 mm

1 32

Dwg. MH-008-2C

0.030"
0.76 mm
NOM

ACTIVE AREA DEPTH

0.089"
2.26 mm

A

1 32

Dwg. MH-002-2B

0.016"
0.41 mm
NOM

BRANDED
SURFACE

ACTIVE AREA DEPTH

0.070"
1.78 mm

A

0.091"
2.31 mm

1 32

Dwg. MH-011-10

0.019"
0.48 mm
NOM

BRANDED
SURFACE

ACTIVE AREA DEPTH

0.082"
2.07 mm

0.055"
1.39 mmA

SENSOR  LOCATIONS
(±0.005” [0.13mm] die placement)

SUFFIX “LT”

Allegro
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Dimensions in Millimeters
(controlling dimensions)

Dwg. MA-009-3A in

1 2 3

0.072
0.064

0.167
0.155

0.059
BSC

0.0189
0.01420.047

0.035

0.102
0.090

0.063
0.055

0.0173
0.0138

0.090
0.084

0.0221
0.0173

0.118
BSC

0.181
0.173

NOTES: 1. Tolerances on package height and width represent allowable mold offsets.  Dimensions given are

measured at the widest point (parting line).

2. Exact body and lead configuration at vendor’s option within limits shown.

3. Height does not include mold gate flash.

PACKAGE DESIGNATOR ‘LT’
(SOT-89/TO-243AA)

Dimensions in Inches
(for reference only)

Dwg. MA-009-3A mm

1 2 3

4.60
4.40

1.83
1.62

4.25
3.94

1.50
BSC

0.48
0.361.20

0.89

2.60
2.29

1.60
1.40

0.44
0.35

2.29
2.13

0.56
0.44

3.00
BSC
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Dwg. MH-003E mm

1.60
1.50

0.46

0.44
0.35

0.48
0.36

1.27

1 2 3

2.54

45°

SEE NOTE

4.65
4.52

4.60
4.47

15.24
14.23

2.18
MAX

Dwg. MH-003E in

0.063
0.059

0.018

0.0173
0.0138

0.0189
0.0142

0.050

1 2 3

0.100

45°

SEE NOTE

0.183
0.178

0.181
0.176

0.600
0.560

0.086
MAX

PACKAGE DESIGNATOR ‘U’

Dimensions in Inches
(controlling dimensions)

Dimensions in Millimeters
(for reference only)

NOTES: 1. Tolerances on package height and width represent allowable mold offsets.  Dimensions given are measured at the widest

point (parting line).

2. Exact body and lead configuration at vendor’s option within limits shown.

3. Height does not include mold gate flash.

4. Recommended minimum PWB hole diameter to clear transition area is 0.035" (0.89 mm).

5. Where no tolerance is specified, dimension is nominal.

Devices in the ‘U’ package are

NOT RECOMMENDED FOR NEW DESIGN
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Dwg. MH-014E in

0.164
0.159

0.062
0.058

0.0173
0.0138

0.050
BSC

45°

0.640
0.600

0.0189
0.0142

0.085
MAX

45°

0.031
1 2 3

0.122
0.117

SEE NOTE

NOTES: 1. Tolerances on package height and width represent

allowable mold offsets.  Dimensions given are measured at the

widest point (parting line).

2. Exact body and lead configuration at vendor’s option

within limits shown.

3. Height does not include mold gate flash.

4. Recommended minimum PWB hole diameter to clear

transition area is 0.035" (0.89 mm).

5. Where no tolerance is specified, dimension is nominal.

PACKAGE DESIGNATOR ‘UA’

Dimensions in Inches
(controlling dimensions)

Dimensions in Millimeters
(for reference only)

Dwg. MH-014E mm

4.17
4.04

1.57
1.47

0.44
0.35

1.27
BSC

45°

16.26
15.24

0.48
0.36

2.16
MAX

45°

0.79
1 2 3

3.10
2.97

SEE NOTE

The products described herein are manufactured under one or

more of the following U.S. patents: 5,045,920; 5,264,783; 5,442,283;

5,389,889; 5,581,179; 5,517,112; 5,619,137; 5,621,319; 5,650,719;

5,686,894; 5,694,038; 5,729,130; 5,917,320; and other patents

pending.

Allegro MicroSystems, Inc. reserves the right to make, from time to

time, such departures from the detail specifications as may be

required to permit improvements in the performance, reliability, or

manufacturability of its products.  Before placing an order, the user is

cautioned to verify that the information being relied upon is current.

Allegro products are not authorized for use as critical components

in life-support appliances, devices, or systems without express written

approval.

The information included herein is believed to be accurate and

reliable.  However, Allegro MicroSystems, Inc. assumes no responsi-

bility for its use; nor for any infringements of patents or other rights of

third parties that may result from its use.
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HALL-EFFECT SENSORS SELECTION GUIDE

Partial Part Avail. Oper. Characteristics at TA = +25°C
Number Temp. BOP(max) BRP(min) Bhys(typ) Features Notes

HALL-EFFECT UNIPOLAR SWITCHES in order of BOP and Bhys

3240 E/L +50 +5.0 10 chopper stabilized 1
3210 E ±70 ±5.0 7.7 micropower, chopper stabilized
3361 E +120 +50 5.0* 2-wire, chopper stabilized
3362 E +120 +50 5.0* 2-wire, chopper stabilized
3161 E +160 +30 20 2-wire
3141 E/L +160 +10 55
3235 S +175 +25 15* output 1 2

-25 -175 15* output 2 2
5140 E +200 +50 55 300 mA output 1, 3
3142 E/L +230 +75 55
3143 E/L +340 +165 55
3144 E/L +350 +50 55
3122 E/L +400 +140 105
3123 E/L +440 +180 105
3121 E/L +450 +125 105
3150 J +40 to +850 – 20 programmable, chopper stabilized 1

HALL-EFFECT LATCHES & BIPOLAR SWITCHES
†
 in order of BOP and Bhys

3260 E/L +30 -30 20 bipolar, chopper stabilized
3280 E/L +40 -40 45 chopper stabilized
3134 E/L +50 -50 27 bipolar switch
3133 K/L/S +75 -75 52 bipolar switch
3281 E/L +90 -90 100 chopper stabilized
3132 K/L/S +95 -95 52 bipolar switch
3187 E/L +150 -150 100*
3177 S +150 -150 200
3625 S +150 -150 200 900 mA outputs 1, 3, 5
3626 S +150 -150 200 400 mA outputs 1, 3, 5
3195 E/L +160 -160 220 1, 4
3197 L +160 -160 230 1
3175 S +170 -170 200
3188 E/L +180 -180 200*
3283 E/L +180 -180 300 chopper stabilized
3189 E/L +230 -230 100*
3275 S +250 -250 100* 5
3185 E/L +270 -270 340*

Operating Temperature Ranges:
S = -20°C to +85°C, E = -40°C to +85°C, J = -40°C to +115°C, K = -40°C to +125°C, L = -40°C to +150°C

Notes 1. Protected.
2. Output 1 switches on south pole, output 2 switches on north pole for 2-phase, bifilar-wound, unipolar-driven brushless dc
motor control.
3. Power driver output.
4. Active pull down.
5. Complementary outputs for 2-phase bifilar-wound, unipolar-driven brushless dc motor control.

* Minimum.
† Latches will not switch on removal of magnetic field; bipolar switches may switch on removal of field but require field reversal
for reliable operation over operating temperature range.



USER GUIDE AND SPECIFICATIONS

NI USB-6008/6009
Bus-Powered Multifunction DAQ USB Device

This user guide describes how to use the National Instruments USB-6008 and National Instruments 

USB-6009 data acquisition (DAQ) devices and lists specifications.

The NI USB-6008/6009 provides connection to eight single-ended analog input (AI) channels, two 

analog output (AO) channels, 12 digital input/output (DIO) channels, and a 32-bit counter with a 

full-speed USB interface. Table 1 compares the devices.

Table 1.  NI USB-6008 and NI USB-6009 Comparison

Feature NI USB-6008 NI USB-6009

AI resolution 12 bits differential,

11 bits single-ended

14 bits differential,

13 bits single-ended

Maximum AI sample rate, 

single channel*
10 kS/s 48 kS/s

Maximum AI sample rate, 

multiple channels (aggregate)*

10 kS/s 48 kS/s

DIO configuration Open collector† Each channel individually 

programmable as open collector 

or active drive†

* System-dependent.

† This document uses NI-DAQmx naming conventions. Open-drain is called open collector and push-pull is called 

active drive.

ni.com/manuals

DeutschFrançais
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Figure 1 shows key functional components of the NI USB-6008/6009.

Figure 1.  NI USB-6008/6009 Block Diagram
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Safety Guidelines

Operate the NI USB-6008/6009 device only as described in this user guide.

Caution Do not operate the NI USB-6008/6009 in a manner not specified in this document. Misuse 

of the device can result in a hazard. You can compromise the safety protection built into the device if 

the device is damaged in any way. If the device is damaged, contact National Instruments for repair.

Caution Do not substitute parts or modify the device except as described in this document. Use the 

device only with the chassis, modules, accessories, and cables specified in the installation 

instructions. You must have all covers and filler panels installed during operation of the device.

Caution Do not operate the device in an explosive atmosphere or where there may be flammable 

gases or fumes. If you must operate the device in such an environment, it must be in a suitably rated 

enclosure.

Electromagnetic Compatibility Guidelines

This product was tested and complies with the regulatory requirements and limits for electromagnetic 

compatibility (EMC) as stated in the product specifications. These requirements and limits are designed 

to provide reasonable protection against harmful interference when the product is operated in its 

intended operational electromagnetic environment.

This product is intended for use in industrial locations. There is no guarantee that harmful interference 

will not occur in a particular installation, when the product is connected to a test object, or if the product 

is used in residential areas. To minimize the potential for the product to cause interference to radio and 
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television reception or to experience unacceptable performance degradation, install and use this product 

in strict accordance with the instructions in the product documentation.

Furthermore, any changes or modifications to the product not expressly approved by National 

Instruments could void your authority to operate it under your local regulatory rules.

Caution To ensure the specified EMC performance, operate this product only with shielded cables 

and accessories.

Caution This product may become more sensitive to electromagnetic disturbances in the operational 

environment when test leads are attached or when connected to a test object.

Caution Emissions that exceed the regulatory requirements may occur when this product is 

connected to a test object.

Caution Changes or modifications not expressly approved by National Instruments could void the 

user’s authority to operate the hardware under the local regulatory rules.

Unpacking

The NI USB-6008/6009 device ships in an antistatic package to prevent electrostatic discharge (ESD). 

ESD can damage several components on the device.

Caution Never touch the exposed pins of connectors.

To avoid ESD damage in handling the device, take the following precautions:

• Ground yourself with a grounding strap or by touching a grounded object.

• Touch the antistatic package to a metal part of your computer chassis before removing the device 

from the package.

Remove the device from the package and inspect it for loose components or any other signs of damage. 

Notify NI if the device appears damaged in any way. Do not install a damaged device in your computer 

or chassis.

Store the device in the antistatic package when the device is not in use.

Setting Up the NI USB-6008/6009

Complete the following steps to get started with the NI USB-6008/6009.

Note For information about non-Windows operating system support, refer to the Getting Started 

with NI-DAQmx Base for Linux and Mac OS X Users document available from ni.com/manuals.

1. Install the application software (if applicable), as described in the installation instructions that 

accompany your software.

2. Install NI-DAQmx1.

Note The NI-DAQmx software is included on the disk shipped with your kit and is available for 

download at ni.com/support. The documentation for NI-DAQmx is available after installation 

from Start»All Programs»National Instruments»NI-DAQ. Other NI documentation is available 

from ni.com/manuals.

1   NI USB-6008/6009 devices are supported by NI-DAQmx 7.5 and later.
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3. Install the 16-position screw terminal connector plugs by inserting them into the connector jacks 

as shown in Figure 2.

Figure 2.  Signal Label Application Diagram

4. Affix the provided signal labels to the screw terminal connector plugs. You can choose labels with 

pin numbers, signal names, or blank labels, as shown in Figure 3. Choose one of the labels, align 

the correct label with the terminals printed on the top panel of your device and apply the label, as 

shown in Figure 2. 

Figure 3.  NI USB-6008/6009 Signal Labels

Note After you label the screw terminal connector plugs, you must only insert them into the 

matching connector jack, as indicated by the overlay label on the device.

5. Plug one end of the USB cable into the NI USB-6008/6009 and the other end into an available 

USB port on the computer.

1 Overlay Label with Pin Orientation Guides

2 Screw Terminal Connector Plug
3 Signal Label
4 USB Cable

1 User-Defined Custom Label
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3 Digital I/O Label

4 Analog Input Differential Signal Name Label
5 Analog Input Single-Ended Signal Name Label
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6. Double-click the Measurement & Automation icon, shown at left, on the desktop to open 

Measurement & Automation Explorer (MAX).

7. Expand My System»Devices and Interfaces and verify that the NI USB-6008/6009 is listed. If 

your device does not appear, press <F5> to refresh the view in MAX. If your device is still not 

recognized, refer to ni.com/support/daqmx for troubleshooting information.

8. Self-test your device in MAX by right-clicking NI USB-600x and selecting Self-Test. Self-test 

performs a brief test to determine successful device installation. When the self-test finishes, a 

message indicates successful verification or if an error occurred. If an error occurs, refer to 

ni.com/support/daqmx.

Caution To ensure the specified EMC performance, operate this product only with shielded cables 

and accessories.

9. Connect the wires (16 to 28 AWG) of a shielded, multiconductor cable to the screw terminals by 

stripping 6.35 mm (0.25 in.) of insulation, inserting the wires into the screw terminals, and securely 

tightening the screws with the flathead screwdriver to a torque of 0.22–0.25 N · m (2.0–2.2 lb · in.). 

Refer to Figure 6 for the NI USB-6008/6009 pinout.

If using a shielded cable, connect the cable shield to a nearby GND terminal.

Note For information about sensors, go to ni.com/sensors. For information about IEEE 1451.4 

TEDS smart sensors, go to ni.com/teds.

10. Run a Test Panel in MAX by right-clicking NI USB-600x and selecting Test Panels.

Click Start to test the device functions, or Help for operating instructions. Click Close to exit the 

test panel.

Using the NI USB-6008/6009 in an Application

You can use the DAQ Assistant through many NI application software programs to configure virtual and 

measurement channels. Table 2 lists DAQ Assistant tutorial locations for NI applications.

Refer to the Where to Go from Here section for information about programming examples for 

NI-DAQmx and NI-DAQmx Base.

Table 2.  DAQ Assistant Tutorial Locations

NI Application Tutorial Location

LabVIEW Go to Help»LabVIEW Help. Next, go to Getting Started with LabVIEW»

Getting Started with DAQ»Taking an NI-DAQmx Measurement in 

LabVIEW.

LabWindows™/CVI™ Go to Help»Contents. Next, go to Using LabWindows/CVI»Data Acquisition»

Taking an NI-DAQmx Measurement in LabWindows/CVI.

Measurement Studio Go to NI Measurement Studio Help»Getting Started with the Measurement 

Studio Class Libraries»Measurement Studio Walkthroughs»Walkthrough: 

Creating a Measurement Studio NI-DAQmx Application.

LabVIEW SignalExpress Go to Help»Taking an NI-DAQmx Measurement in SignalExpress.
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Features

The NI USB-6008/6009 features a USB connector, USB cable strain relief, two screw terminal 

connector plugs for I/O, and an LED indicator, as shown in Figure 4.

Figure 4.  NI USB-6008/6009 Top and Back Views

USB Connector and USB Cable Strain Relief
The NI USB-6008/6009 features a USB connector for full-speed USB interface. You can provide strain 

relief for the USB cable by threading a zip tie through the USB cable strain relief ring and tightening 

around a looped USB cable, as shown in Figure 5.

Figure 5.  NI USB-6008/6009 Strain Relief
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LED Indicator
The NI USB-6008/6009 device has a green LED indicator that indicates device status, as listed in 

Table 3. When the device is connected to a USB port, the LED blinks steadily to indicate that the device 

is initialized and is receiving power from the connection.

Screw Terminal Connector Plugs
The NI USB-6008/6009 ships with one detachable screw terminal connector plug for analog signals and 

one detachable screw terminal connector plug for digital signals. These screw terminal connectors 

provide 16 connections that use 16–28 AWG wire. Refer to step 4 of the Setting Up the 

NI USB-6008/6009 section for information about selecting labels for the screw terminal connector 

plugs. Refer to the Pinout and Signal Descriptions section for the device pinout and signal descriptions.

You can order additional connectors and labels for your device. Refer to the Cables and Accessories 

section for ordering information.

Firmware
The firmware on the NI USB-6008/6009 refreshes whenever the device is connected to a computer with 

NI-DAQmx. NI-DAQmx automatically uploads the compatible firmware version to the device. The 

firmware version may be upgraded when new versions of NI-DAQmx release.

Table 3.  LED State/Device Status

LED State Device Status

Not lit Device not connected or in suspend

On, not blinking Device connected but not initialized, or the computer is in standby mode. 

In order for the device to be recognized, the device must be connected to a computer that 

has NI-DAQmx installed on it.

Single-blink Operating normally
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Cables and Accessories

Table 4 contains information about cables and accessories available for the NI USB-6008/6009. For a 

complete list of accessories and ordering information, refer to the pricing section of the NI USB-6008 

or NI USB-6009 product page at ni.com.

Pinout and Signal Descriptions

Figure 6 shows the pinout of the NI USB-6008/6009. Analog input signal names are listed as 

single-ended analog input name, AI x, and then differential analog input name, (AI x+/–). Refer to 

Table 5 for a detailed description of each signal.

Figure 6.  NI USB-6008/6009 Pinout

Table 4.  NI USB-6008/6009 Cables and Accessories

Accessory Part Number Description

USB-6008/6009 Accessory Kit 779371-01 Four additional screw-terminal connectors, 

connector labels, and a screwdriver

USB-6000 Series Prototyping Accessory 779511-01 Unshielded breadboarding accessory for 

custom-defined signal conditioning and prototyping. 

You can use up to two accessories per device.

Hi-Speed USB Cable 184125-01

184125-02

1 m and 2 m lengths

Caution: For compliance with Electromagnetic Compatibility (EMC) requirements, this product must be operated with 

shielded cables and accessories. If unshielded cables or accessories are used, the EMC specifications are no longer 

guaranteed unless all unshielded cables and/or accessories are installed in a shielded enclosure with properly designed and 

shielded input/output ports.
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Table 5.  Signal Descriptions

Signal Name Reference Direction Description

GND — — Ground—The reference point for the single-ended analog input 

measurements, analog output voltages, digital signals, +5 VDC supply, 

and +2.5 VDC at the I/O connector, and the bias current return point for 

differential mode measurements.

AI <0..7> Varies Input Analog Input Channels 0 to 7—For single-ended measurements, each 

signal is an analog input voltage channel. For differential measurements, 

AI 0 and AI 4 are the positive and negative inputs of differential analog 

input channel 0. The following signal pairs also form differential input 

channels: AI<1, 5>, AI<2, 6>, and AI<3, 7>. Refer to the Analog Input 

section for more information.

AO <0, 1> GND Output Analog Output Channels 0 and 1—Supplies the voltage output of 

AO channel 0 or AO channel 1. Refer to the Analog Output section for 

more information.

P0.<0..7> GND Input or Output Port 0 Digital I/O Channels 0 to 7—You can individually configure 

each signal as an input or output. Refer to the Digital I/O section for 

more information.

P1.<0..3> GND Input or Output Port 1 Digital I/O Channels 0 to 3—You can individually configure 

each signal as an input or output. Refer to the Digital I/O section for more 

information.

PFI 0 GND Input PFI 0—This pin is configurable as either a digital trigger or an event 

counter input. Refer to the PFI 0 section for more information.

+2.5 V GND Output +2.5 V External Reference—Provides a reference for wrap-back 

testing. Refer to the +2.5 V External Reference section for more 

information.

+5 V GND Output +5 V Power Source—Provides +5 V power up to 200 mA. Refer to the 

+5 V Power Source section for more information.
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Analog Input

The NI USB-6008/6009 has eight analog input channels that you can use for four differential analog 

input measurements or eight single-ended analog input measurements.

Figure 7 shows the analog input circuitry of the NI USB-6008/6009.

Figure 7.  NI USB-6008/6009 Analog Input Circuitry

The main blocks featured in the NI USB-6008/6009 analog input circuitry are as follows:

• MUX—The NI USB-6008/6009 has one analog-to-digital converter (ADC). The multiplexer 

(MUX) routes one AI channel at a time to the PGA.

• PGA—The progammable-gain amplifier provides input gains of 1, 2, 4, 5, 8, 10, 16, or 20 when 

configured for differential measurements and gain of 1 when configured for single-ended 

measurements. The PGA gain is automatically calculated based on the voltage range selected in the 

measurement application.

• ADC—The analog-to-digital converter (ADC) digitizes the AI signal by converting the analog 

voltage into digital code.

• AI FIFO—The NI USB-6008/6009 can perform both single and multiple analog-to-digital 

conversions of a fixed or infinite number of samples. A first-in-first-out (FIFO) buffer holds data 

during AI acquisitions to ensure that no data is lost.

Analog Input Modes and Signal Sources
You can configure the AI channels on the NI USB-6008/6009 to take differential or referenced 

single-ended (RSE) measurements. Table 6 summarizes the recommended analog input mode(s) for 

floating signal sources and ground-referenced signal sources. Refer to Table 5 for more information 

about I/O connections for single-ended or differential measurements.

AI

+2.5 VREF

39.2 kΩ

127 kΩ

30.9 kΩ PGA

Input Range

Selection

AI FIFOADCMUX
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Floating Signal Sources

A floating signal source is not connected to the building ground system, but has an isolated 

ground-reference point. Some examples of floating signal sources are outputs of transformers, 

thermocouples, battery-powered devices, optical isolators, and isolation amplifiers. An instrument or 

device that has an isolated output is a floating signal source.

Refer to the NI Developer Zone document, Field Wiring and Noise Considerations for Analog Signals, 

for more information. To access this document, go to ni.com/info and enter the Info Code rdfwn3.

When to Use Differential Connections with Floating Signal Sources

Use DIFF input connections for any channel that meets any of the following conditions:

• Your application requires input ranges other than ±10 V.

• The input signal is low level and requires greater accuracy.

• The leads connecting the signal to the device are greater than 3 m (10 ft).

• The input signal requires a separate ground-reference point or return signal.

Table 6.  Analog Input Configurations

Analog Input Mode

Floating Signal Sources 

(Not Connected to Building Ground) Ground-Referenced Signal Sources

Examples:

• Ungrounded thermocouples

• Signal conditioning with isolated 

outputs

• Battery devices

Example:

• Plug-in instruments with 

non-isolated outputs

Differential (DIFF)

Referenced 

Single-Ended (RSE)

+

–

+

–

AI+ 

AI– 

GND

Signal Source NI USB-6008/6009

+

–

+

–

AI+ 

AI– 

GND

Signal Source NI USB-6008/6009

+

–

+

–

AI 

GND

Signal Source NI USB-6008/6009

Ground-loop potential (VA – VB) are added

to measured signal.

NOT RECOMMENDED

+

–

+

–

AI 

GND
VB

VA

Signal Source NI USB-6008/6009
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• The signal leads travel through noisy environments.

• Two analog input channels, AI+ and AI–, are available for the signal.

DIFF signal connections reduce noise pickup and increase common-mode noise rejection. DIFF signal 

connections also allow input signals to float within the working voltage of the device.

Refer to the Taking Differential Measurements section for more information about differential 

connections.

When to Use Referenced Single-Ended (RSE) Connections with Floating Signal Sources

Only use RSE input connections if the input signal meets all of the following conditions:

• The input signal can share a common reference point, GND, with other signals that use RSE.

• Your application permits the use of the ±10 V input range.

• The leads connecting the signal to the device are less than 3 m (10 ft).

DIFF input connections are recommended for greater signal integrity for any input signal that does not 

meet the preceding conditions.

In the single-ended modes, more electrostatic and magnetic noise couples into the signal connections 

than in DIFF configurations. The coupling is the result of differences in the signal path. Magnetic 

coupling is proportional to the area between the two signal conductors. Electrical coupling is a function 

of how much the electric field differs between the two conductors.

With this type of connection, the PGA rejects both the common-mode noise in the signal and the ground 

potential difference between the signal source and the device ground.

Refer to the Taking Referenced Single-Ended Measurements section for more information about RSE 

connections.

Ground-Referenced Signal Sources

A ground-referenced signal source is a signal source connected to the building system ground. It is 

already connected to a common ground point with respect to the device, assuming that the computer is 

plugged into the same power system as the source. Non-isolated outputs of instruments and devices that 

plug into the building power system fall into this category.

The difference in ground potential between two instruments connected to the same building power 

system is typically between 1 and 100 mV, but the difference can be much higher if power distribution 

circuits are improperly connected. If a grounded signal source is incorrectly measured, this difference 

can appear as measurement error. Follow the connection instructions for grounded signal sources to 

eliminate this ground potential difference from the measured signal.

Refer to the NI Developer Zone document, Field Wiring and Noise Considerations for Analog Signals, 

for more information. To access this document, go to ni.com/info and enter the Info Code rdfwn3.

When to Use Differential Connections with Ground-Referenced Signal Sources

Use DIFF input connections for any channel that meets any of the following conditions:

• Your application requires input ranges other than ±10 V.

• The input signal is low level and requires greater accuracy.

• The leads connecting the signal to the device are greater than 3 m (10 ft).

• The input signal requires a separate ground-reference point or return signal.

• The signal leads travel through noisy environments.

• Two analog input channels, AI+ and AI–, are available for the signal.
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DIFF signal connections reduce noise pickup and increase common-mode noise rejection. DIFF signal 

connections also allow input signals to float within the working voltage of the device.

Refer to the Taking Differential Measurements section for more information about differential 

connections.

When to Use Referenced Single-Ended (RSE) Connections with Ground-Referenced Signal Sources

Do not use RSE connections with ground-referenced signal sources. Use differential connections 

instead.

As shown in the bottom-rightmost cell of Table 6, there can be a potential difference between GND and 

the ground of the sensor. In RSE mode, this ground loop causes measurement errors.

Taking Differential Measurements

For differential signals, connect the positive lead of the signal to the AI+ terminal, and the negative lead 

to the AI– terminal.

Figure 8.  Connecting a Differential Voltage Signal

The differential input mode can measure ±20 V signals in the ±20 V range. However, the maximum 

voltage on any one pin is ±10 V with respect to GND. For example, if AI 1 is +10 V and AI 5 is –10 V, 

then the measurement returned from the device is +20 V.

Figure 9.  Example of a Differential 20 V Measurement
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Connecting a signal greater than ±10 V on either pin results in a clipped output.

Figure 10.  Exceeding ±10 V on AI Returns Clipped Output

Taking Referenced Single-Ended Measurements

To connect referenced single-ended (RSE) voltage signals to the NI USB-6008/6009, connect the 

positive voltage signal to an AI terminal, and the ground signal to a GND terminal, as shown in 

Figure 11.

Figure 11.  Connecting a Referenced Single-Ended Voltage Signal

When no signals are connected to the analog input terminal, the internal resistor divider may cause the 

terminal to float to approximately 1.4 V when the analog input terminal is configured as RSE. This 

behavior is normal and does not affect the measurement when a signal is connected.

Digital Trigger
You can configure PFI 0 as a digital trigger input for analog input tasks. Refer to the Using PFI 0 as a 

Digital Trigger section for more information.
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Analog Output

The NI USB-6008/6009 has two independent analog output channels that can generate outputs from 0 

to 5 V. All updates of analog output channels are software-timed. GND is the ground-reference signal 

for the analog output channels.

Figure 12 shows the circuitry of one analog output channel on the NI USB-6008/6009. 

Figure 12.  Circuitry of One Analog Output Channel

The main block featured in the NI USB-6008/6009 analog output circuitry is the digital-to-analog 

converter (DAC), which converts digital codes to analog voltages. There is one DAC for each analog 

output line.

Connecting Analog Output Loads
To connect loads to the NI USB-6008/6009, connect the positive lead of the load to the AO terminal, 

and connect the ground of the load to a GND terminal, as shown in Figure 13.

Figure 13.  Connecting a Load

Minimizing Glitches on the Output Signal
When you use a DAC to generate a waveform, you may observe glitches in the output signal. These 

glitches are normal; when a DAC switches from one voltage to another, it produces glitches due to 

released charges. The largest glitches occur when the most significant bit of the DAC code changes. You 

can build a lowpass deglitching filter to remove some of these glitches, depending on the frequency and 

nature of the output signal. For more information about minimizing glitches. refer to the 

KnowledgeBase document, Reducing Glitches on the Analog Output of MIO DAQ Devices. To access 

this document, go to ni.com/info and enter the Info Code exszek.
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Digital I/O

The NI USB-6008/6009 has 12 digital lines on two ports, Port 0 has eight lines, P0.<0..7>, and Port 1 

has four lines, P1.<0..3>. GND is the ground-reference signal for the digital I/O ports. You can 

individually program all lines as inputs or outputs.

Figure 14 shows P0.<0..7> connected to example signals configured as digital inputs and digital outputs. 

You can configure P1.<0..3> similarly.

Figure 14.  Example of Connecting a Load

Caution Exceeding the maximum input voltage ratings or maximum output ratings, which are listed 

in the Specifications section, can damage the device and the computer. National Instruments is not 

liable for any damage resulting from such signal connections.

1 P0.0 configured as an open collector digital output driving an LED
2 P0.2 configured as an active drive digital output driving an LED
3 P0.4 configured as a digital input receiving a TTL signal from a gated invertor
4 P0.7 configured as a digital input receiving a 0 V or 5 V signal from a switch
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Source/Sink Information
The default configuration of the NI USB-6008/6009 digital I/O ports is open collector, allowing 5 V 

operation, with an onboard 4.7 kΩ pull-up resistor. An external user-provided pull-up resistor can be 

added to increase the source current drive up to a 8.5 mA limit per line as shown in Figure 15.1

Figure 15.  Example of Connecting an External User-Provided Resistor

The NI USB-6009 ports can also be configured as active drive using the NI-DAQmx API, allowing 3.3 V 

operation with a source/sink current limit of ±8.5 mA. For more information about how to set the DIO 

configuration, refer to the KnowledgeBase document, Configuring NI Devices to be Open-Drain (Open 

Collector) or Push-Pull (Active Drive). To access this document, go to ni.com/info and enter the 

Info Code ex52sp.

Complete the following steps to determine the value of the user-provided pull-up resistor:

1. Place an ammeter in series with the load.

2. Place a variable resistor between the digital output line and the +5 V supply.

3. Set P0.0 to high.

4. Adjust the variable resistor until the ammeter current reads as the intended current. The intended 

current must be less than 8.5 mA.

5. Remove the ammeter and variable resistor from your circuit.

6. Measure the resistance of the variable resistor. The measured resistance is the ideal value of the 

pull-up resistor.

7. Select a static resistor value for your pull-up resistor that is greater than or equal to the ideal 

resistance.

8. Reconnect the load circuit and the pull-up resistor.

1   This document uses NI-DAQmx naming conventions. Open-drain is called open collector and push-pull is called active drive.

GND

P0.0

+5 V

RpRe

Rl

NI USB-6008/6009

Load

A

+5 V

Port Pad

4.7 kΩ Onboard Resistor

External

Pull-Up

Resistor
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I/O Protection
To protect the NI USB-6008/6009 against overvoltage, undervoltage, and overcurrent conditions, as 

well as ESD events, you should avoid these fault conditions by using the following guidelines:

• If you configure a DIO line as an output, do not connect it to any external signal source, ground 

signal, or power supply.

• If you configure a DIO line as an output, understand the current requirements of the load connected 

to these signals. Do not exceed the specified current output limits of the DAQ device.

National Instruments has several signal conditioning solutions for digital applications requiring 

high current drive.

• If you configure a DIO line as an input, do not drive the line with voltages outside of its normal 

operating range. The DIO lines have a smaller operating range than the AI signals.

• Treat the DAQ device as you would treat any static-sensitive device. Always properly ground 

yourself and the equipment when handling the DAQ device or connecting to it.

Power-On States
At system startup and reset, the hardware sets all DIO lines to high-impedance inputs. The DAQ device 

does not drive the signal high or low. Each line has a weak pull-up resistor connected to it.

Static DIO
Each of the NI USB-6008/6009 DIO lines can be used as a static DI or DO line. You can use static DIO 

lines to monitor or control digital signals. All samples of static DI lines and updates of DO lines are 

software-timed.

PFI 0

PFI 0 is configurable as either a digital trigger input or an event counter input.

Using PFI 0 as a Digital Trigger
When an analog input task is defined, you can configure PFI 0 as a digital trigger input. When the digital 

trigger is enabled, the AI task waits for a rising or falling edge on PFI 0 before starting the acquisition. 

To use AI Start Trigger (ai/StartTrigger) with a digital source, specify PFI 0 as the source and select a 

rising or falling edge.

Using PFI 0 as an Event Counter
You can configure PFI 0 as a source for counting digital edges. In this mode, falling-edge events are 

counted using a 32-bit counter. For more information about event timing requirements, refer to the 

Specifications section.
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External Reference and Power Source

The NI USB-6008/6009 creates an external reference and supplies a power source. All voltages are 

relative to ground (GND).

+2.5 V External Reference
The NI USB-6008/6009 creates a high-purity reference voltage supply for the ADC using a multi-state 

regulator, amplifier, and filter circuit. You can use the resulting +2.5 V reference voltage as a signal for 

self-test.

+5 V Power Source
The NI USB-6008/6009 supplies a 5 V, 200 mA output. You can use this source to power external 

components.

Note When the device is in USB suspend, the output is disabled.

Specifications

The following specifications are typical at 25 °C, unless otherwise noted.

Analog Input
Analog inputs

Differential .....................................................4

Single-ended ..................................................8, software-selectable

Input resolution

NI USB-6008

Differential .............................................12 bits

Single-ended ..........................................11 bits

NI USB-6009

Differential .............................................14 bits

Single-ended ..........................................13 bits

Max sample rate (aggregate)1

NI USB-6008 .................................................10 kS/s

NI USB-6009 .................................................48 kS/s

Converter type........................................................Successive approximation

AI FIFO..................................................................512 bytes

Timing resolution...................................................41.67 ns (24 MHz timebase)

Timing accuracy.....................................................100 ppm of actual sample rate

Input range

Differential .....................................................±20 V2, ±10 V, ±5 V, ±4 V, ±2.5 V, ±2 V, 

±1.25 V, ±1 V

Single-ended ..................................................±10 V

1   System-dependent.

2   ±20 V means that |AI+ – (AI–)| ≤ 20 V. However, AI+ and AI– must both be within ±10 V of GND. Refer to the Taking 

Differential Measurements section for more information.
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Working voltage.....................................................±10 V

Input impedance.....................................................144 kΩ

Overvoltage protection...........................................±35 V

Trigger source ........................................................Software or external digital trigger

System noise1

Differential

±20 V range ...........................................5 mVrms

±1 V range .............................................0.5 mVrms

Single-ended

±10 V range ...........................................5 mVrms

Absolute accuracy at full scale, differential2

Absolute accuracy at full scale, single-ended

Analog Output
Analog outputs .......................................................2

Output resolution ...................................................12 bits

Maximum update rate ............................................150 Hz, software-timed

Output range ..........................................................0 to +5 V

Output impedance ..................................................50 Ω

Output current drive ...............................................5 mA

Power-on state........................................................0 V

1   System noise measured at maximum sample rate.

2   Input voltages may not exceed the working voltage range.

Range (V) Typical at 25 °C (mV) Maximum over Temperature (mV)

±20 14.7 138

±10 7.73 84.8

±5 4.28 58.4

±4 3.59 53.1

±2.5 2.56 45.1

±2 2.21 42.5

±1.25 1.70 38.9

±1 1.53 37.5

Range (V) Typical at 25 °C (mV) Maximum over Temperature (mV)

±10 14.7 138
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Slew rate.................................................................1 V/µs

Short circuit current ...............................................50 mA

Absolute accuracy (no load)

Typical............................................................7 mV

Maximum at full scale ...................................36.4 mV

Digital I/O
Digital I/O lines

P0.<0..7>........................................................8 lines

P1.<0..3>........................................................4 lines

Direction control ....................................................Each channel individually programmable as input 

or output

Output driver type1

NI USB-6008 .................................................Open collector

NI USB-6009 .................................................Each channel individually programmable as 

open collector or active drive

Compatibility .........................................................TTL, LVTTL, CMOS

Absolute maximum voltage range .........................–0.5 to 5.8 V with respect to GND

Pull-up resistor .......................................................4.7 kΩ to 5 V

Power-on state........................................................Input

Digital logic levels

External Voltage
+5 V output (200 mA maximum)

Minimum .......................................................+4.85 V

Typical............................................................+5 V

+2.5 V output (1 mA maximum) ...........................+2.5 V

+2.5 V accuracy .....................................................0.25% maximum

Reference temperature drift ...................................50 ppm/°C maximum

1   This document uses NI-DAQmx naming conventions. Open-drain is called open collector and push-pull is called active drive.

Level Min Max

Input low voltage

Input high voltage

Input leakage current

–0.3 V

2.0 V

—

0.8 V

5.8 V

50 µA

Output low voltage (I = 8.5 mA)

Output high voltage

Active drive, I = –8.5 mA

Open collector, I = –0.6 mA, nominal

Open collector, I = –8.5 mA, with external pull-up resistor

—

2.0 V

2.0 V

2.0 V

0.8 V

3.5 V

5.0 V

—



© National Instruments Corporation 23 NI USB-6008/6009 User Guide and Specifications

Event Counter
Number of counters ...............................................1

Resolution ..............................................................32 bits

Counter measurements...........................................Edge counting (falling-edge)

Counter direction ...................................................Count up

Pull-up resistor .......................................................4.7 kΩ to 5 V

Maximum input frequency.....................................5 MHz

Minimum high pulse width....................................100 ns

Minimum low pulse width .....................................100 ns

Input high voltage ..................................................2.0 V

Input low voltage ...................................................0.8 V

Bus Interface
USB specification ..................................................USB 2.0 full-speed

USB bus speed .......................................................12 Mb/s

Power Requirements
USB

4.10 to 5.25 VDC

Typical....................................................80 mA

Maximum...............................................500 mA

USB suspend

Typical....................................................300 µA

Maximum...............................................500 µA

Physical Characteristics
Dimensions ............................................................Refer to Figure 16.

Without connectors ........................................63.5 mm × 85.1 mm × 23.2 mm 

(2.50 in. × 3.35 in. × 0.91 in.)

With connectors .............................................81.8 mm × 85.1 mm × 23.2 mm 

(3.22 in. × 3.35 in. × 0.91 in.)
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Figure 16.  NI USB-6008/6009 Dimensions

Weight

Without connectors ........................................54 g (1.9 oz)

With connectors .............................................84 g (3 oz)

I/O connectors........................................................USB series B receptacle, 

(2) 16 position screw terminal plugs

Screw-terminal wiring ...................................16 to 28 AWG 

Torque for screw terminals ............................0.22–0.25 N · m (2.0–2.2 lb · in.)

If you need to clean the module, wipe it with a dry towel.

Safety Voltages
Connect only voltages that are within these limits.

Channel-to-GND....................................................±30 V max, Measurement Category I

Measurement Category I is for measurements performed on circuits not directly connected to the 

electrical distribution system referred to as MAINS voltage. MAINS is a hazardous live electrical supply 

system that powers equipment. This category is for measurements of voltages from specially protected 

secondary circuits. Such voltage measurements include signal levels, special equipment, limited-energy 

parts of equipment, circuits powered by regulated low-voltage sources, and electronics.

Caution Do not use this module for connection to signals or for measurements within Measurement 

Categories II, III, or IV.

 

81.81 mm

(3.221 in.)

76.09 mm

(2.996 in.)

63.50 mm

(2.500 in.)

72.65 mm

(2.860 in.)

85.09 mm

(3.350 in.)

23.19 mm

(0.913 in.)

 NATIONAL 

INSTRUMENTS
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Environmental
Temperature (IEC 60068-2-1 and IEC 60068-2-2)

Operating .......................................................0 to 55 °C 

Storage ...........................................................–40 to 85 °C

Humidity (IEC 60068-2-56)

Operating .......................................................5 to 95% RH, noncondensing

Storage ...........................................................5 to 90% RH, noncondensing 

Pollution Degree (IEC 60664) ...............................2

Maximum altitude..................................................2,000 m

Indoor use only.

Safety
This product meets the requirements of the following standards of safety for electrical equipment for 

measurement, control, and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1, CSA 61010-1 

Note For UL and other safety certifications, refer to the product label or the Online Product 

Certification section.

Electromagnetic Compatibility
This product meets the requirements of the following EMC standards for electrical equipment for 

measurement, control, and laboratory use:

• EN 61326-1 (IEC 61326-1): Class A emissions; Basic immunity

• EN 55011 (CISPR 11): Group 1, Class A emissions

• AS/NZS CISPR 11: Group 1, Class A emissions

• FCC 47 CFR Part 15B: Class A emissions

• ICES-001: Class A emissions

Note In the United States (per FCC 47 CFR), Class A equipment is intended for use in commercial, 

light-industrial, and heavy-industrial locations. In Europe, Canada, Australia and New Zealand (per 

CISPR 11) Class A equipment is intended for use only in heavy-industrial locations.

Note Group 1 equipment (per CISPR 11) is any industrial, scientific, or medical equipment that 

does not intentionally generates radio frequency energy for the treatment of material or 

inspection/analysis purposes.

Note For EMC declarations and certifications, and additional information, refer to the 

Environmental Management section.

CE Compliance
This product meets the essential requirements of applicable European Directives as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)
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Online Product Certification
To obtain product certifications and the Declaration of Conformity (DoC) for this product, visit 

ni.com/certification, search by model number or product line, and click the appropriate link in 

the Certification column.

Environmental Management
NI is committed to designing and manufacturing products in an environmentally responsible manner. NI 

recognizes that eliminating certain hazardous substances from our products is beneficial to the 

environment and to NI customers.

For additional environmental information, refer to the NI and the Environment Web page at 

ni.com/environment. This page contains the environmental regulations and directives with which 

NI complies, as well as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)

EU Customers The symbol indicates that the waste products should be disposed of separately from 

municipal household waste according to Directive 2002/96/EC of the European Parliament and the 

Council on waste electrical and electronic equipment (WEEE). At the end of the product life cycle, 

all products must be sent to a WEEE collection and recycling center. Proper disposal of WEEE 

reduces the environmental impact and risk to human health due to potentially hazardous substances 

that are generally used in such equipment. Your cooperation in the correct disposal of the products 

will contribute to the effective usage of natural resources. For information about the available 

collection and recycling scheme in a particular country, refer to ni.com/citizenship/weee.

RoHS

National Instruments  (RoHS)
National Instruments RoHS ni.com/environment/rohs_china

(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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Where to Go from Here

This section lists where you can find example programs for the NI USB-6008/6009 and relevant 

documentation.

Example Programs
NI-DAQmx and NI-DAQmx software include example programs to help you get started programming 

with the NI USB-6008/6009. Modify example code and save it in an application, or use examples to 

develop a new application, or add example code to an existing application.

NI-DAQmx

To locate NI software examples, go to ni.com/info and enter the Info Code daqmxexp. 

For additional examples, refer to zone.ni.com.

To run examples without the device installed, use an NI-DAQmx simulated device. For more 

information, in Measurement & Automation Explorer (MAX), select Help»Help Topics»NI-DAQmx» 

MAX Help for NI-DAQmx and search for simulated devices.

NI-DAQmx Base

NI-DAQmx Base examples are accessible from Start»All Programs»National Instruments» 

NI-DAQmx Base»Examples.

Related Documentation
Each application software package and driver includes information about writing applications for taking 

measurements and controlling measurement devices. The following references to documents assume 

you have NI-DAQmx 9.3 or later, and where applicable, version 8.5 or later of the NI application 

software.

NI-DAQmx

The NI USB-6008/6009 Quick Start packaged with the NI USB-6008/6009 describes how to install 

NI-DAQmx software, install the device, and confirm that your device is operating properly.

The NI-DAQ Readme lists which devices, ADEs, and NI application software are supported by this 

version of NI-DAQ. Select Start»All Programs»National Instruments»NI-DAQ»NI-DAQ Readme.

The NI-DAQmx Help contains API overviews, general information about measurement concepts, key 

NI-DAQmx concepts, and common applications that are applicable to all programming environments. 

Select Start»All Programs»National Instruments»NI-DAQ»NI-DAQmx Help.

NI-DAQmx Base (Linux/Mac OS X/LabVIEW PDA 8.x)

The NI-DAQmx Base Getting Started Guide describes how to install your NI-DAQmx Base software, 

your NI-DAQmx Base-supported DAQ device, and how to confirm that your device is operating 

properly. In Windows, select Start»All Programs»National Instruments»NI-DAQmx Base» 

Documentation»NI-DAQmx Base Getting Started Guide.

The Getting Started with NI-DAQmx Base for Linux and Mac OS X Users document describes how to 

install your NI-DAQmx Base software, your NI-DAQmx Base-supported DAQ device, and how to 

confirm that your device is operating properly on your Linux or Mac machine.

The NI-DAQmx Base Readme lists which devices are supported by a version of NI-DAQmx Base. In 

Windows, select Start»All Programs»National Instruments»NI-DAQmx Base»DAQmx Base 

Readme.
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The NI-DAQmx Base VI Reference Help contains VI reference and general information about 

measurement concepts. In LabVIEW, select Help»NI-DAQmx Base VI Reference Help.

The NI-DAQmx Base C Function Reference Help contains C reference and general information about 

measurement concepts. In Windows, select Start»All Programs»National Instruments»NI-DAQmx 

Base»Documentation»C Function Reference Help.

Note All NI-DAQmx Base documentation for Linux is installed at /usr/local/natinst/ 

nidaqmxbase/documentation.

Note All NI-DAQmx Base documentation for Mac OS X is installed at /Applications/ 

National Instruments/NI-DAQmx Base/documentation.

LabVIEW

If you are a new user, use the Getting Started with LabVIEW manual to familiarize yourself with the 

LabVIEW graphical programming environment and the basic LabVIEW features you use to build data 

acquisition and instrument control applications. Open the Getting Started with LabVIEW manual by 

selecting Start»All Programs»National Instruments»LabVIEW»LabVIEW Manuals or by 

navigating to the labview\manuals directory and opening LV_Getting_Started.pdf.

Use the LabVIEW Help, available by selecting Help»LabVIEW Help in LabVIEW, to access 

information about LabVIEW programming concepts, step-by-step instructions for using LabVIEW, and 

reference information about LabVIEW VIs, functions, palettes, menus, and tools. Refer to the following 

locations on the Contents tab of the LabVIEW Help for information about NI-DAQmx:

• Getting Started with LabVIEW»Getting Started with DAQ—Includes overview information 

and a tutorial to learn how to take an NI-DAQmx measurement in LabVIEW using the DAQ 

Assistant.

• VI and Function Reference»Measurement I/O VIs and Functions» DAQmx - Data 

Acquisition VIs and Functions—Describes the LabVIEW NI-DAQmx VIs and functions.

• Property and Method Reference»NI-DAQmx Properties contains the property reference.

• Taking Measurements—Contains the conceptual and how-to information you need to acquire and 

analyze measurement data in LabVIEW, including common measurements, measurement 

fundamentals, NI-DAQmx key concepts, and device considerations.

LabWindows/CVI

The Data Acquisition book of the LabWindows/CVI Help contains Taking an NI-DAQmx Measurement 

in LabWindows/CVI, which includes step-by-step instructions about creating a measurement task using 

the DAQ Assistant. In LabWindows™/CVI™, select Help»Contents, then select Using 

LabWindows/CVI»Data Acquisition. This book also contains information about accessing detailed 

information through the NI-DAQmx Help.

The NI-DAQmx Library book of the LabWindows/CVI Help contains API overviews and function 

reference for NI-DAQmx. Select Library Reference»NI-DAQmx Library in the LabWindows/CVI 

Help.
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Measurement Studio

If you program your NI-DAQmx-supported device in Measurement Studio using Visual C# or Visual 

Basic .NET, you can interactively create channels and tasks by launching the DAQ Assistant from MAX 

or from within Visual Studio. You can use Measurement Studio to generate the configuration code based 

on your task or channel. Refer to the DAQ Assistant Help for additional information about generating 

code. 

The NI Measurement Studio Help is fully integrated with the Microsoft Visual Studio help. To view this 

help file in Visual Studio, select Measurement Studio»NI Measurement Studio Help. For 

information related to developing with NI-DAQmx, refer to the following topics within the 

NI Measurement Studio Help:

• For step-by-step instructions on how to create an NI-DAQmx application using the Measurement 

Studio Application Wizard and the DAQ Assistant, refer to Walkthrough: Creating a Measurement 

Studio NI-DAQmx Application.

• For help with NI-DAQmx methods and properties, refer to NationalInstruments.DAQmx 

Namespace and NationalInstruments.DAQmx.ComponentModel Namespace.

• For conceptual help with NI-DAQmx, refer to Using the Measurement Studio NI-DAQmx .NET 

Library and Developing with Measurement Studio NI-DAQmx.

• For general help with programming in Measurement Studio, refer to Getting Started with the 

Measurement Studio Class Libraries.

To create an application in Visual Basic .NET or Visual C#, follow these general steps:

1. In Visual Studio, select File»New»Project to launch the New Project dialog box.

2. In the Project types pane, expand the Visual Basic or Visual C# node, depending on which 

language you want to create the project in, and select Measurement Studio.

3. Choose a project type. You add DAQ tasks as a part of this step.

ANSI C without NI Application Software

The NI-DAQmx Help contains API overviews and general information about measurement concepts. 

Select Start»All Programs»National Instruments»NI-DAQ»NI-DAQmx Help.

The NI-DAQmx C Reference Help describes the NI-DAQmx Library functions, which you can use with 

National Instruments data acquisition devices to develop instrumentation, acquisition, and control 

applications. Select Start»All Programs»National Instruments»NI-DAQ» Text-Based Code 

Support»NI-DAQmx C Reference Help.

.NET Languages without NI Application Software

With the Microsoft .NET Framework version 2.0 or later, you can use NI-DAQmx to create applications 

using Visual C# and Visual Basic .NET without Measurement Studio. You need Microsoft Visual Studio 

.NET 2005 or later for the API documentation to be installed.

The installed documentation contains the NI-DAQmx API overview, measurement tasks and concepts, 

and function reference. This help is fully integrated into the Visual Studio documentation. To view the 

NI-DAQmx .NET documentation, go to Start»All Programs»National Instruments»NI-DAQ» 

Text-Based Code Support. For function reference, refer to the NationalInstruments.DAQmx 

Namespace and NationalInstruments.DAQmx.ComponentModel Namespace topics. For conceptual 

help, refer to the Using the Measurement Studio NI-DAQmx .NET Library and Developing with 

Measurement Studio NI-DAQmx sections.

To get to the same help topics from within Visual Studio 2005 or 2008, go to Help»Contents and select 

Measurement Studio from the Filtered By drop-down list. To get to the same help topics from within 
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Visual Studio 2010, go to Help»View Help and select NI Measurement Studio Help from the Related 

Links section.

Training Courses

If you need more help getting started developing an application with NI products, NI offers training 

courses. To enroll in a course or obtain a detailed course outline, refer to ni.com/training.

Technical Support on the Web

For additional support, refer to ni.com/support or zone.ni.com.

Note You can download these documents at ni.com/manuals.

DAQ specifications and some DAQ manuals are available as PDFs. You must have Adobe Acrobat 

Reader with Search and Accessibility 5.0.5 or later installed to view the PDFs. Refer to the Adobe 

Systems Incorporated Web site at www.adobe.com to download Acrobat Reader. Refer to the National 

Instruments Product Manuals Library at ni.com/manuals for updated documentation resources.

Where to Go for Support

The National Instruments Web site is your complete resource for technical support. At 

ni.com/support you have access to everything from troubleshooting and application development 

self-help resources to email and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the European 

Communities using the manufacturer’s declaration of conformity. This system affords the user 

protection for electromagnetic compatibility (EMC) and product safety. You can obtain the DoC for 

your product by visiting ni.com/certification. If your product supports calibration, you can 

obtain the calibration certificate for your product at ni.com/calibration.

National Instruments corporate headquarters is located at 11500 North Mopac Expressway, Austin, 

Texas, 78759-3504. National Instruments also has offices located around the world to help address your 

support needs. For telephone support in the United States, create your service request at 

ni.com/support and follow the calling instructions or dial 512 795 8248. For telephone support 

outside the United States, visit the Worldwide Offices section of ni.com/niglobal to access the 

branch office Web sites, which provide up-to-date contact information, support phone numbers, email 

addresses, and current events.
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Caudal Qmáx =  aprox. 2,29 l/min

Presión de trabajo pmáx =  750 bar

Tensión de alimentación =  24 V  ó 12 V DC

Bomba básica

Bloques adicionales

Montaje directo del bloque de válvulas

o  Modelo BWN 1, BWH 1  D 7470 B/1  

o  Modelo VB01  D 7302

o  Modelo BVH  D 7788 BV

Modelo básico 

y tamaño

NPC 11

NPC 12

Potencia nominal

aprox. (kW)

 0,3

 0,6

Código de caudal   0,2 0,31 0,44 0,61 0,87 1,05

Desplazamiento Vg (cm3/rev) 0,09 0,14 0,20 0,28 0,36 0,46

Caudal de marcha en vacío Q0 (l/min) 0,27 0,42 0,59 0,83 1,07 1,36

Presión de trabajo pmáx  (bar) 750 640 450 320 250 190

1. Descripción general

Las centrales hidráulicas compactas del tipo NPC han sido especialmente  

concebidas para las aplicaciones en las que es necesaria una gran movilidad  

(p. ej., en obras, etc.), la alimentación energética se produce a través de una  

fuente de alimentación de corriente continua y las operaciones son de corta  

duración (p. ej., remachar, encrespado, estampar y trabajos similares).

2. Versiones disponibles, datos principales

Ejemplo de pedido: NPC 11 /0,31 - 1/320 - R - 24 - BWH 1 - NN - 33 - G 24 

NPC 12 /0,4 - 2/750 - R - 12 - BWH 1 - 1  1)

Esquema hidráulico

Tensión del motor 

(para ver los datos de rendimiento tabla del 

apartado 3.2)

12 V DC

24 V DC

Válvula limitadora de presión 

con ajuste de presión

1/... fija

2/... regulable

NPC 11

NPC 12

Código de caudal   0,4 0,65 0,94 1,28 1,71 2,14

Desplazamiento Vg (cm3/rev) 0,15 0,24 0,34 0,46 0,6 0,76

Caudal de marcha en vacío Q0 (l/min) 0,45 0,71 1,02 1,39 1,81 2,29

Presión de trabajo pmáx  (bar) 750 660 470 350 270 210

1) con placa tipo BWH 1 - 1 a 750 bar

Válvula de 

retorno en P

-  sin

R con

Modelo 

básico



D 7940 Página 2

3.2 Datos eléctricos

 NPC 11  NPC 12

Tensión nominal UN 24 V 12 V 24 V 12 V  

Potencia nominal PN 0,1 / 0,3 kW 0,1 / 0,25 kW 0,6 kW 0,6 kW

Corriente nomial IN 5,6 / 22 A DC 10,5 / 35 A DC 35 A DC 70 A DC

Núm. de revoluciones nominal nN 3000 / 2000 min-1

Tipo de protección IP 44

Tipo de material aislante F

Conexión eléctrica Conector orientable 2 St. 6,3x0,8

Tiempos de carga permitidos 1 pmáx ED Ò 10%

 0,5 pmáx ED Ò 20%

 0,3 pmáx ED Ò 30%

sección transversal recomendada 2x 4 mm2  (Ò 35 A)

 2x 6 mm2  (> 35 A)

Consumo de corrientereal y curva  

característica de caudal

Denominación Bomba de pistones radiales (bomba de caudal fijo) para funcionamiento de corta duración 

con motor de corriente continua

Sentido de giro indistinta

Racordaje de unión según unidades de montaje

Posición de montaje en posición vertical

Fijación 4xM8

Fluido hidráulico Aceite hidráulico según DIN 51 524 Tl.1 hasta 3; ISO VG 10 hasta 68 según DIN 51 519

Margen de viscosidad: mín. aprox. 4; máx. aprox. 800 mm2/s

Servicio óptimo: aprox. 10 ..0,500 mm2/s

 También apropiado para medios de presión biodegradables del tipo HEES (éster sintético) 

a temperaturas de servicio de hasta aprox. +70ºC

Temperaturas Ambiente: aprox. -40...+60°C

Aceite: -25...+80°C, prestar atención al margen de viscosidad

 Admite una temperatura de arranque de hasta  -40°C (prestar atención a las viscosidades) 

cuando la temperatura final constante en el servicio subsiguiente es, como mínimo,  

superior en 20K.

 Fluidos hidráulicos biodegradables: Observar los datos del fabricante. No superior a +70°C 

si se tiene en cuenta la compatibilidad del sellado.

Llenado de aceite 1,0 litro de volumen total; 0,5 litros de volumen útil

Masa (peso) kg NPC 11 NPC 12

(sin llenado de aceite)  6  8

3. Otros parámetros
3.1 Parámetros generales e hidráulicos

I A (2
4
 V

 D
C

)

Q
N
/Q

0

(l
/m

in
)

p · Vg
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4. Dimensiones generales 

 Todas las medidas se indican en mm. Se reserva el derecho a introducir modificaciones.

 Ejemplo con válvula de banco tipo BWN 1 o BWH 1

Válvula limitadora de presión

Conexión eléctrica

 H

NPC 11 297

NPC 12 357

Ejemplo con válvula de banco tipo BVH



Válvulas de asiento de 2/2 y 3/2 vías de los tipos BVG y BVP
para cualquier dirección del aceite, estancas y exentas de aceite de drenaje 

Todas las conexiones pueden ser sometidas a presión

D 7400
Válvulas de asiento BVG y BVP

Septiembre 2012-01

HAWE HYDRAULIK SE

STREITFELDSTR. 25 • 81673 MÜNCHEN

2.2

© 1987 by HAWE Hydraulik

Presión de trabajo pmáx  = 320 bar

Caudal Qmáx  = 50 l/min

Otras válvulas con el mismo función:

o Modelo BVG 11(12 y 2), BVP 11(2) véase anexo en el apartado 5.1, no 

emplear los modelos de final de producción para las planificaciones nuevas

o Modelo BVG , BVP 1 D 7765 (Qmáx = 20 l/min, pmáx = 400 bar)

o Modelo NBVP 16 D 7765 N (Qmáx = 20 l/min, pmáx = 400 bar)

o Modelo BVE  D 7921 (Qmáx = 70 l/min, pmáx = 400 bar)

o Modelo VP D 7915 (Qmáx = 15 l/min, pmáx = 400 bar)

Versión para 

conexión en línea

Ejemplo: Modelo BVG 3 S-G 24

Versión para montaje sobre placa

Ejemplo: Modelo BVP 3 R-G 12

1. Descripción general
Las electroválvulas estancas de 2/2 y 3/2 vías aquí descritas con accionamiento eléctrico, hidráulico o neumático han sido  

diseñadas como válvulas de asiento cónico. Todas las conexiones pueden ser sometidas a la misma presión gracias a la  

compensación interna de la presión.

Mediante la recuperación por muelle, la posición cero o neutral se adopta automáticamente en estado no accionado. Los  

elementos utilizados para la construcción de esta válvula son de acero, las piezas interiores más importantes para el funcionamiento 

están templadas y trabajan sumergidas en aceite sin necesidad de mantenimiento; el cono y el asiento están rectificados.
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BVP 3 Z - H 1/4 BVP 3 R(S) - H 1/4

BVP 3 Z - P BVP 3 R(S) - P

2. Versiones disponibles, datos principales

Ejemplos 

de pedido:
BVG 3 R/B 2,5 - WG 230

BVP 3 Z - P

Esquemas hidráulicos 

completos

(aplicar los esquemas de  

accionamiento 

análogamente a todos los 

esquemas hidráulicos)

Conexión en línea

BVG 3 R - H     BVG 3 S - P

BVG 3 Z - G...

BVG 3 Z - WG...

Montaje sobre placa

Tabla 1:  Modelo básico y tamaño  1)

Código

BVG 3

BVP 3

Tipo y tamaño de 

conexión

Conexión en línea

G 1/2 ISO 228/1

Montaje sobre placa

Caudal

Qmáx 

(l/min)

50

50

Presión 

pmáx

(bar)

320

320

BVP 3 Z - H BVP 3 R(S) - H

BVP 3 Z - G...

BVP 3 Z - WG...

Tabla 2:  Esquemas hidráulicos

R S  Z

Tabla 3: Chiclé adicional

(en las conexiones A, B y C, véase también apart. 3.1)

Código   Núm. para realizar  Rango de presión  

 # pedido posterior de carga del sistema  

 (mm) BVG 3.. BVP 3.. o del acumulador
   

B 2,5 2,5 7405 014 b 7405 013-2,5 en torno a 300 bar

B 3 3 7405 014 c 7405 013-3,0 en torno a 200 bar

B 3,5 3,5 7405 014 d 7405 013-3,5 en torno a 150 bar

B 4 4 7405 014 e 7405 013-4,0 en torno a 100 bar

2) 0  2) 7405 014 a 7405 013         --

1) Modelos BVG 11(12, 2) y BVP 11(2) véase apart. 5.1, no emplear los modelos de final 
de producción para una planificación nueva

2) sin taladro; para el taladrado por el cliente según las curvas características |p-Q de 
los chiclés, apart. 3.1

3) Bobina de corriente continua (98 V DC, 205 V DC) con puente de rectificación en el  
conector eléctrico

Tabla 4:  Tipo de accionamiento

Datos principales,

véase también apartado 3.2

UN = 12 V DC

UN = 24 V DC

UN = 110 V AC, 50/60 Hz (98 V DC) 3)

UN = 230 V AC, 50/60 Hz (205 V DC) 3)

Conexión de pilotaje 

externo G 1/4.

Sólo para mod. BVP 3!
 

Conexión de pilotaje 

externo G 1/4

con

conector

eléctrico

G 12

G 24

WG 110

WG 230

H

H 1/4

 

P

Código

Conector

eléctrico 

con diodo 

luminis- 

cente

L 12

L 24

---

---

sin

conector

eléctrico

X 12

X 24

X 98

X 205

eléctrico

  

hidráulico 

neumático

Acciona-

miento

Presión de pSt mín = 24 bar

pilotaje: pSt máx = 320 bar

Presión de pSt mín = 4 bar

pilotaje: pSt máx = 15 bar

Esquemas de  eléctrico         hidráulico  neumático

accionamiento  Código H 1/4 Código H
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Electroválvula estanca 

de 2/2 vías de 3/2 vías

3. Otros parámetros
3.1 Parámetros generales e hidráulicos

Posición de montaje indistinta

 negativo (el cambio de una a otra dirección del aceite no concluye hasta la posición final). 

Durante el proceso de conmutación, todos los pasos están unidos entre sí

Presión de trabajo pmáx  =  320 bar

Capacidad estática Conexiones A, B y C aprox. 2 x pmáx (640 bar)

Material de la caja y  Acero nitrurado al gas (válvula básica)

tratamiento de superficie

Masa (peso) aprox. kg

Fluido hidráulico Aceite hidráulico según DIN 51 524, partes 1 - 3; ISO VG 10 hasta 68 según DIN 51 519

Margen de viscosidad: mín. aprox. 4; máx. aprox. 1500 mm2/s

Servicio óptimo: aprox. 10...500 mm2/s

 También apropiado para fluidos hidráulicos biodegradables del tipo HEPG (polialquilen- 

glicol) y HEES (éster sintético) a temperaturas de servicio aprox. de hasta +70ºC.

Temperaturas Ambiente: aprox. -40...+80°C

Aceite: -25...+80°C, prestar atención al margen de viscosidad

 Permitida una temperatura de arranque de hasta -40°C (prestar atención a las viscosidades) 

cuando la temperatura final constante en el servicio subsiguiente es, como mínimo, superior 

en 20K.

 Fluidos hidráulicos biodegradables: Observar los datos del fabricante. No superior a +70°C 

si se tiene en cuenta la compatibilidad del sellado.

 Atención: Observar la limitación referente al tiempo de conexión de los electroimanes en 

pos. 3.2.

Caudal Qmáx según apartado 2 válido para pmáx = 320 bar accionamiento electromagnético en  

circuitos de bomba habituales. En caso de presiones inferiores a 150 bar (accionado por  

bobina) o en todos los demás tipos de accionamiento se puede rebasar hasta el 50% del Qmáx, 

siempre que la pérdida de carga sea admisible. 

Limitación de caudal En conexiones de acumulador o en caso de conexión a circuitos de alta presión con  

grandes caudales de bomba (conductos anulares, sistemas de alimentación centralizados), 

los caudales se deben limitar, en función de la presión del sistema, con chiclés a Qmáx 

según apart. 2.

 El chiclé se tiene que situar siempre en el lado del acumulador. En válvulas ..Z.. se inserta 

en la conexión C. Si se desea en la conexión A o B, este hecho se tiene que indicar en el 

texto escrito. 

Para más detalles, véase la tabla 3, apartado 2.

Solapamiento en electrovál-

vulas estancas de 3/2 vías

completo con

accionamiento

eléctrico

hidráulico

neumático

BVG 3 R

BVG 3 S

2,3

1,9

1,9

BVP 3 Z

2,4

2,0

1,7

BVP 3 R

BVP 3 S

2,3

1,9

1,9

BVG 3 Z

3,3

2,9

2,6

P
é
rd

id
a
 d

e
 c

a
rg

a
 |

p
 (
b

a
r)

P
é
rd

id
a
 d

e
 c

a
rg

a
 |

p
 (
b

a
r)

Caudal Q (l/min) Caudal Q (l/min)

Viscosidad del aceite durante la medición aprox. 60 mm2/s

Chiclés adicionalesVálvula básicaCurvas características |p - Q
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3.2 Accionamientos

Datos eléctricos

         Las bobinas han sido fabricadas y testadas según la  VDE 0580

  Tensión continua               Tensión alterna 

 

  

Código  G 12 G 24 WG 110 WG 230

  L12 L24 --- ---

  X12 X24 --- ---

Corriente nominal UN (V) 12 24 110 230

Potencia nominal PN (W) 33,2 30,0 32,8 33,0

Tensión continua DC Tensión alterna AC, 50 y 60 Hz

Tipo de conmutación  ON u OFF: aprox. 50...60 ms,  

(valor orientativo) en WG... 2-3 veces más largo

Conmutaciones/hora aprox. 2000, aproximadamente con la misma distribución

Tipo de protección IP 65 (IEC 60529)

 (conector correctamente montado)

Tipo de material aislante F

Temperatura de contacto aprox. 98°C, con una temperatura ambiente de 20°C 

Energía de desconexión WA Ò 0,5 Ws

Tratamiento de superficie DIN 50961-Fe/Zn 12 bk cC

(bobina)

Tiempo de conexión relativo en 

funcionamiento (sellado ED del 

100% sellado en la bobina)

hidráulico  neumático

(código H, H 1/4) (código P)

Modelo G... Modelo L.. Modelo WG..

Presión de pilotaje pSt mín 24 bar 4 bar

 pSt máx 320 bar 15 bar

Presión residual permitida en el 

conducto de pilotaje para retorno  < 2 bar --- 

seguro a la posición cero    

Posibilidad de sobrecarga  aprox. 1,5 pSt máx bar aprox. 1,5 pSt máx bar 

estática Z hasta

Volumen de pilotaje (geométrico) 0,6 cm3 3 cm3

Material de la caja y    Acero (cabezal del mando) Aluminio (cabezal del mando)

tratamiento de superficie galvanizado anodizado negro

Vista de la 

bobina

Tiempo de conexión rel. 

%ED-5 min

T
e
m

p
. 
a
m

b
ie

n
te

. 
}

U
 (
°C

)

Conectoreléctrico  

DIN EN 175 301-803 

(conexión y esquemas hidráulicos)

todos los conectores 

otros conectores, véase D 7163
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4. Dimensiones generales
Todas las medidas se indican en mm. Se reserva el derecho a introducir modificaciones.

4.1 Versión para conexión en línea

Representación con accionamiento eléctrico (código G.. ó WG..); los demás tipos de accionamiento, véase a continuación
    

Modelo BVG 3 R(S)            Modelo BVG 3 Z

Conexiones según ISO 228/1:

A, B y C = G 1/2

Conexiones según ISO 228/1:

A y B = G 1/2

Accionamiento hidráulico 

Código H 1/4

Accionamiento neumático

Código P

#8,5 

pasante

Accionamiento de 

emergencia manual
Conectores  

Herramienta auxiliar para accionar  

(no utilizar piezas de cantos vivos).

1) Atención: Esta medida depende de 

la marca y según la norma  

DIN EN 175 301-803 puede 

tener un máximo de 40 mm.

2) La bobina también se puede montar como 

conector eléctrico girado en 4x90°.

accionamiento de emergencia manual

Presionando el perno de latón visible 

en el lado superior con un pasador de  

acero, un destornillador, etc., se puede 

accionar la válvula.

Atención: La presión en la conexión B 

carga el perno de latón en la 

superficie de #5, es decir, 

100 bar aprox. 240 N!

#5,5

Véase al lado 

las medidas 

no especifi-

cadas!

#8,5 

pasante

2)

aprox. 35  1)

a
p

ro
x
. 
3
5
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4.2 Versión para montaje sobre placa

Representación con accionamiento eléctrico (código G.. ó WG..); los demás accionamientos, véase apartado 4.1

Modelo BVP 3 R(S) 

M 6, 7 prof.

Disposición de los orificios en la placa base (vista superior)

Estanqueidad de las conexiones A, B, C: 

con juntas tóricas 13,95x2,62 NBR 90 Sh

Conexión Z: 

con junta tórica 2,54x1,78 NBR 90 Sh

Disponible como juego de juntas DS 7400-3 

al realizar un pedido de repuestos, inclu-

yendo juntas tóricas para el accionamiento  

código H, H 1/4.

Datos no espe-

cificados, véase 

apart. 4.1!

Modelo BVP 3 Z

Accionamiento hidráulico

Código H 

Código H 1/4

1) Conexión de pilotaje Z sólo  

disponible en caso de  

accionamiento hidráulico (código H)!

Datos no espe-

cificados, véase 

apart. 4.1!

Disposición de los orificios en la placa base (vista superior)

1)

M 6, 9 prof.

1)

La conexión de pilota-

je Z se encuentra en el  

elemento de válvula

(véase al lado)

Accionamiento neumático

Código P
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5. Anexo
5.1 Modelo BVG 11(12 y 2) o BVP 11(2)

No utilizar modelos de final de producción para planificaciones nuevas (alternativa, modelos BVG 1 y BVP 1 según D 7765)

Ejemplos de pedodo:       

          

BVG 11 R - G 24

BVP 2 S/B 1,5 - WG 230

Tabla 5:  Modelo básico y tamaño

Código

BVG 11

BVG 12

BVG 2

BVP 11

BVP 2

Tipo y tamaño de 

conexión

G 1/4

G 3/8

G 3/8

Montaje sobre placa

Caudal

Qmáx 

(l/min)

12

20 1)

20

12

20

Presión 

pmáx

(bar)

320

320

1) con accionamiento eléctrico:

20 l/min hasta 200 bar

12 l/min hasta 320 bar y Ò 80% ED

véase también apartado 3.1 „Caudal“

2) sin taladro; para taladrar por el cliente

 Curvas características |p-Q de los chiclés,  

apartado 3.1

3) sólo en el modelo BVP 11(2), no disponible para 

modelo BVG.. (insuficiente tamaño de bloque y 

efecto de refrigeración resultante)

Conexión en 

línea  

ISO 228/1

Tabla 7:  Tipos de accionamiento

Accionamiento Código, observación

eléctrico G 12, L 12, X 12 véase tabla 4, 

 G 24, L 24, X 24 apartado 2

 WG 100, X 98

 WG 230, X 205

 G 24 EX  3)

 modelo antideflagrante

 UN = 24 V DC; pmáx = 220 bar !

manual A para modelo BVG 11(12) !

 Material de carcasa y tratamiento  

 de superficie = acero (carcasa de  

 palanca nitrurada al gas)

 Par de accionamiento

 = aprox. 70 Nm a 320 bar

Tabla 6: Chiclé adicional (en las conexiones 

 A, B y C, véase también apartado 3.1)

Código

B 0,6

B 0,8

B 1,1

B 1,3

B 1,5

2)

B 0,4

B 0,5

B 0,6

B 0,7

B 0,8

B 0,9

B 1,0

B 1,1

B 1,3

B 1,5

B 2,0

B 2,5

B 4,0

2)

B 0,6

B 0,8

B 1,1

B 1,3

B 1,5

B 2,0

B 2,5

2)

#

(mm)

0,6

0,8

1,1

1,3

1,5

0

0,4

0,5

0,6

0,7

0,8

0,9

1,0

1,1

1,3

1,5

2,0

2,5

4,0

0

0,6

0,8

1,1

1,3

1,5

2,0

2,5

0

para realizar pedido

posterior

7406 012 b

7406 012 c

7406 012 d 

7406 012 f

7406 012 h

7406 012 a

7400 003 k

7400 003 l

7400 003 d

7400 003 m

7400 003 e

7400 003 n

7400 003 o

7400 003 g

7400 003 h

7400 003 c

7400 003 f

7400 003 i

7400 003 b

7400 003 a

7921 012-0,6

7921 012-0,8

7921 012-1,1

7921 012-1,3

7921 012-1,5

7921 012-2,0

7921 012-2,5

7921 012

Modelo 

básico

BVG 11

BVG 2

BVP 11

BVP 2

Esquemas hidráulicos (véase tabla 2, apart. 2)

Atención:  Esquema hidráulico Z no disponible 

 para modelo BVG -12 !
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Otros parámetros

Datos generales y eléctricos, véase apartado 3.1 ó 3.2

Masa (peso) aprox. kg 
acompleto con 

accionamiento

eléctrico

manual

BVG 11 R(S)

BVG 12 R(S)

1,0

0,6

BVP 11 Z

1,0

---

BVP 11 R(S)

0,9

---

BVG 11 Z

1,6

---

acompleto con  

accionamiento

eléctrico

BVG 2 R(S)

1,3

BVP 2 Z

1,4

BVP 2 R(S)

1,1

BVG 2 Z

1,7

Curvas características 

|p - Q

P
é
rd

id
a
 d

e
 c

a
rg

a
 |

p
 (
b

a
r)

P
é
rd

id
a
 d

e
 c

a
rg

a
 |

p
 (
b

a
r)

Caudal Q (l/min) Caudal Q (l/min)

Viscosidad del aceite durante la medición aprox. 60 mm2/s

Chiclés adicionalesVálvula básica
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Dimensiones generales

Todas las medidas se indican en mm. Se reserva el derecho a introducir modificaciones.

Versión para conexión en línea

Representación con accionamiento eléctrico (código G.. ó WG..); accionamiento manual, véanse a continuación

Modelo BVG 11 R(S) Modelo BVG 12 R(S)

Conexiones según ISO 228/1:

A, B y C = G 1/4 (BVG -11 R, S y Z)

 = G 3/8 (BVG -12 R y S)

#6,5  

pasante

Accionamiento de 

emergencia manual Conectores 

Conexiones según 

ISO 228/1:  

A, B y C = G 3/8

1) Atención: Esta medida depende de la marca y según la norma DIN EN 175 301-803 

puede tener un máximo de 40 mm.

2) La bobina también se puede montar como conector eléctrico girado en 4x90°.

Herramienta auxiliar para accionar  

(no utilizar piezas de cantos vivos).

Accionamiento de emergencia manual 

(válido para modelo BVG ..11(12 y 2))

Presionando el perno de latón visible 

en el lado superior con un pasador de  

acero, un destornillador, etc., se puede  

accionar la válvula.

Atención: La presión en la conexión B 

carga el perno de latón en la 

superficie de #5, es decir, 

100 bar aprox. 195 N!

#5

Modelo BVG 11 Z

Modelo BVG 2 Z

Accionamiento manual código A  

(válido para modelo BVG ..11(12))

#6,5 pasante

2)

#6,5 

pasante

Accionamiento de 

emergencia manual

Conectores 

Modelo BVG 2 R(S)

1)

2)

aprox. 35  1)

a
p

ro
x
. 
3
5

a
p

ro
x
. 
3
5

aprox. 35
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Versión para montaje sobre placa

Representación con accionamiento eléctrico (código G.. ó WG..); accionamiento manual, véase modelo BVG..

Modelo BVP 11 R(S) Modelo BVP 11 Z

Disposición de los orificios en la placa inferior (vista superior)

Disposición de los orificios en la 

placa base (vista superior)

Estanqueidad de las conexiones A, B y C con 

juntas tóricas 7,65x1,78 NBR 90 Sh.

Disponible como juego de juntas  

DS 7400-1 al realizar un pedido de repuestos.

Estanqueidad de las conexiones A, B y C con juntas tóricas 7,65x1,78 NBR 90 Sh.

Disponible como juego de juntas  

DS 7400-1 al realizar un pedido de repuestos.

Estanqueidad de las conexiones A, B y C con juntas tóricas 7,65x1,78 NBR 90 Sh.

Disponible como juego de juntas  

DS 7400-1 al realizar un pedido de repuestos.

Datos no especificados, 

véase modelo BVG.. !

M6, 6 prof.

M5, 6 prof.

Modelo BVP 2 R(S)

Datos no especificados, 

véase modelo BVG.. !

Modelo BVP 2 Z

Datos no especificados, 

véase modelo BVG.. !

Disposición de los orificios en la 

placa inferior (vista superior)

Disposición de los orificios en la 

placa base (vista superior)

M 5, 6,5 prof.

M 5, 6,5 prof.
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5.3 Esquemas seccionales (de serie, según apartado 2)

Para simplificar el principio de funcionamiento se representan aquí los esquemas seccionales en estado conectado.

Válido para todos los accionamientos según tabla 4.

Modelo BVG 3 R.. Modelo BVG 3 S.. Modelo BVG 3 Z..

5.2 Electroválvula estanca de 2/2 vías con válvula antirretorno en derivación

La válvula BVG-2R se puede suministrar en una versión modificada 

con válvula antirretorno para evitar la posición de bloqueo BdA.

Ejemplo de pedido: BVG R 2 R - ... Esquema hidráulico

Denom. del 

apartado 5.1

R = Válvula an-

tirretorno en 

derivación

Caudal Q (l/min)

Curvas características |p - Q

P
é
rd

id
a
 d

e
 c

a
rg

a
 |

p
 (
b

a
r)

Presión de 

apertura de la 

válvula antirretor-

no aprox. 0,8 bar

P
os

ic
ió

n 
0

Posi
ci

ón 
a

Nota: Esquema de medidas y medidas 

(peso) idénticos al modelo BVG 2 R 

según apartado 5.1
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